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Documentation Updates

The title page of this document contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. 
As a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. 
Many also require a support contract.  To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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Welcome to This Guide

Welcome to the HP ALM Performance Center Installation Guide. This guide 
describes how to install HP ALM Performance Center components. To install 
HP ALM Performance Center, you must first install HP ALM, as described in 
the HP Application Lifecycle Management Installation Guide.

How This Guide is Organized

The HP ALM Performance Center Installation Guide describes the system 
prerequisites and installation process for HP ALM Performance Center.

It contains the following parts:

 Part I Getting Started

Provides an overview of the installation flow, the system components, and 
the data flow. In addition provides installation prerequisites and 
considerations for the Performance Center components, and outlines 
required services.

 Part II Installation and Configuration

Describes how to install HP ALM Performance Center components and 
provides initial and optional configuration instructions.

 Part III Upgrade and Migration

Describes how to upgrade from earlier versions of Performance Center to 
HP ALM Performance Center 11.00, including data and project migration.
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 Part IV Working with Firewalls

Describes how to set up the ALM Performance Center components to 
communicate with other ALM Performance Center components that are 
located over a firewall.

 Part V Troubleshooting

Troubleshoots issues that may arise related to the installation of the 
Performance Center components.
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Documentation Library Guides

The Documentation Library consists of the following guides and references, 
available online, in PDF format, or both. PDFs can be read and printed using 
Adobe Reader, which can be downloaded from the Adobe Web site 
(http://www.adobe.com).

Application Lifecycle Management Guides

Reference Description

Using this 
Documentation 
Library 

Explains how to use the Documentation Library and how 
it is organized.

What’s New? Describes the newest features in the latest version of 
ALM. 

To access, select Help > What's New.

Product Feature 
Movies

Short movies that demonstrate the main product 
features.

To access, select Help > Product Feature Movies.

Readme Provides last-minute news and information about ALM.

Guide Description

HP ALM User Guide Explains how to use ALM to organize and execute all 
phases of the application life cycle management process. 
It describes how to specify releases, define requirements, 
plan tests, run tests, and track defects.

HP ALM 
Administrator Guide

Explains how to create and maintain projects using Site 
Administration, and how to customize projects using 
Project Customization.

HP ALM Tutorial A self-paced guide teaching you how to use ALM to 
manage the application life cycle management process.

http://www.adobe.com
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ALM Performance Center Guides

HP ALM Installation 
Guide

Describes the installation and configuration processes for 
setting up ALM Platform.

HP Business Process 
Testing User Guide

Explains how to use Business Process Testing to create 
business process tests.

Guide Description

HP ALM Performance 
Center Quick Start

A self-paced guide giving the Performance Center user a 
high level overview of creating and running performance 
tests.

HP ALM Performance 
Center Guide

Explains to the Performance Center user how to create, 
schedule, run, and monitor performance tests. Explains 
to the Performance Center administrator how to use Lab 
Management for overall lab resource management, lab 
settings management, and system configuration.

HP ALM Performance 
Center Installation 
Guide

Describes the installation processes for setting up 
Performance Center Servers, Performance Center Hosts 
and other Performance Center components.

HP ALM Performance 
Center 
Troubleshooting 
Guide

Provides information for troubleshooting problems while 
working with HP ALM Performance Center.

HP Performance 
Center of Excellence 
Best Practices

Provides best practices for successfully building and 
operating Performance Centers of Excellence.

HP Performance 
Monitoring Best 
Practices

Provides best practices for monitoring the performance 
of applications under test.

Guide Description
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ALM Best Practices

ALM API References

Guide Description

HP ALM Database 
Best Practices Guide

Provides best practices for deploying ALM on database 
servers.

HP ALM Upgrade 
Best Practices Guide

Provides methodologies for preparing and planning your 
ALM upgrade.

HP ALM Business 
Models Module Best 
Practices Guide

Provides best practices for working with the Business 
Models module.

HP ALM Entities 
Sharing Best 
Practices Guide

Provides best practices for sharing entities.

HP ALM Project 
Planning and 
Tracking Best 
Practices Guide

Provides best practices for managing and tracking 
releases.

Guide Description

HP ALM Project 
Database Reference

Provides a complete online reference for the project 
database tables and fields.

HP ALM Open Test 
Architecture API 
Reference

Provides a complete online reference for the ALM COM-
based API. You can use the ALM open test architecture to 
integrate your own configuration management, defect 
tracking, and home-grown testing tools with an ALM 
project.

HP ALM Site 
Administration API 
Reference

Provides a complete online reference for the Site 
Administration COM-based API. You can use the Site 
Administration API to enable your application to 
organize, manage, and maintain ALM users, projects, 
domains, connections, and site configuration 
parameters.
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HP ALM REST API 
Reference

Provides an online reference for the ALM REST-based API. 
You can use the REST API to access and work with ALM 
data.

HP ALM COM 
Custom Test Type 
Guide

Provides a complete online guide for creating your own 
testing tool and integrating it into the ALM 
environment.

HP ALM .NET Custom 
Test Type Developer 
Guide 

Provides a complete online guide for creating your own 
testing tool and integrating it into the ALM environment 
using a combination of DCOM and .NET classes. 

Guide Description
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Additional Online Resources

The following additional online resources are available from the ALM Help 
menu:

 

Part Description

Troubleshooting & 
Knowledge Base

Opens the Troubleshooting page on the HP Software 
Support Web site where you can search the Self-solve 
knowledge base. Choose Help > Troubleshooting & 
Knowledge Base. The URL for this Web site is 
http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support Opens the HP Software Support Web site. This site 
enables you to browse the Self-solve knowledge base. You 
can also post to and search user discussion forums, 
submit support requests, download patches and updated 
documentation, and more. Choose Help > HP Software 
Support. The URL for this Web site is 
www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an 
HP Passport user and sign in. Many also require a support 
contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site Opens the HP Software Web site. This site provides you 
with the most up-to-date information on HP Software 
products. This includes new software releases, seminars 
and trade shows, customer support, and more. Choose 
Help > HP Software Web site. The URL for this Web site 
is www.hp.com/go/software.

Add-ins Page Opens the HP Application Lifecycle Management Add-
ins Page, which offers integration and synchronization 
solutions with HP and third-party tools.

http://h20230.www2.hp.com/troubleshooting.jsp
http://www.hp.com/go/hpsoftwaresupport
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
http://www.hp.com/go/software
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1
Before You Install

This chapter provides information that will help you prepare for the 
Performance Center component installations. 

This chapter includes:

➤ Installation Flow on page 22

➤ Performance Center Components and Data Flow on page 23

➤ System Component Considerations on page 30

➤ General Pre-installation Considerations on page 34

➤ Required Services on page 35

➤ Performance Center Prerequisite Software on page 36
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Installation Flow

The diagram below provides an outline of the steps involved in installing or 
upgrading to HP ALM Performance Center 11.00.
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Performance Center Components and Data Flow

This section describes the HP ALM Performance Center system.

This section includes:

➤ "System Advantages" on page 23

➤ "Architecture and Components" on page 24

➤ "Applications" on page 25

➤ "Communication Paths" on page 26

➤ "Coexistence of Installed Components" on page 28

➤ "Load Considerations" on page 28

System Advantages
The ALM Performance Center system offers the following advantages:

➤ Performance Center leverages all the ALM features.

➤ The ALM Performance Center system provides an end-to-end process 
lifecycle.

➤ The ALM Performance Center system consolidates functional and 
performance assets.
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Architecture and Components
This section describes the architecture and components of 
HP ALM Performance Center.

➤ ALM Platform. Provides a platform for core ALM functionality. 

➤ ALM Client. Users log in to ALM (user site), Site Administration 
(project and user management), or Lab Management from their client 
machine.

➤ ALM Platform Repository. Used for file storage.

➤ ALM Platform Database. Contains a schema per Performance Center 
project, as well as a separate schema for Lab Management and Site 
Administration.

For more details about ALM Platform technology, see the HP Application 
Lifecycle Management Installation Guide.

➤ HP Performance Center Extension. Installed on the ALM Platform, 
enables Performance Center functionality. Creates the Lab Management 
project where Performance Center administration is managed.

➤ HP Performance Center Server. Hosts the Performance Center Web pages 
that enable you to design performance tests, configure monitors, reserve 
testing resources, run and monitor test runs, and analyze test results.

➤ Lab Management. The center for managing Performance Center system 
configuration (Performance Center Server, licenses, and so on), 
Performance Center lab resources (hosts, host pools, and so on), project 
limits, and usage reports.

➤ HP Performance Center Hosts. Used to control performance tests, 
generate load, and analyze data. Performance Center hosts can be 
configured as Controllers, load generators, or data processors:

➤ Controller. The manager of a performance test. The Controller receives 
scripts, runtime settings, and a list of load generators to use. The 
Controller issues instructions to the load generators including which 
scripts to run, how many Vusers to run per script, and scheduler 
settings. At the conclusion of the test run, the Controller collates the 
data. There is only one Controller per performance test.
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➤ Load Generator. Generate load by running virtual users (Vusers). The 
Controller dictates the manner in which they start and stop running. 
There can be any number of load generators for a given test. 

➤ Data Processor. Used for analyzing and publishing performance test 
results.

Applications 
The following standalone applications integrate with your 
Performance Center system:

➤ HP Virtual User Generator (VuGen). Generates Vusers by recording 
actions that typical end-users would perform on your application. VuGen 
records your actions into automated Vuser scripts which form the 
foundation of your performance tests. 

➤ HP Analysis. Provides graphs and reports with in-depth performance 
analysis information. Using these graphs and reports, you can pinpoint 
and identify the bottlenecks in your application and determine what 
changes need to be made to your system to improve its performance.

➤ MI Listener. Needed when running Vusers and monitoring applications 
over a firewall. 

➤ Monitors Over Firewall Agent. Used to monitor servers that are located 
over a firewall.

Use the diagram and table in the "Communication Paths" and "Load 
Considerations" sections that follow, to determine which machines to 
allocate for which performance testing tasks.

For example, you can combine a number of components that have a light 
load on a single machine. For details on which components can be installed 
together, see "Coexistence of Installed Components" on page 28.
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Communication Paths
When installing HP ALM Performance Center, it is important to consider 
the communication paths between the various components, and their 
resource demands. This information helps you configure your system to 
evenly distribute the load, and prevent overloading any particular resource.

When running a performance test, Performance Center components share 
information with ALM components via a distinct system of communication. 
Understanding which components communicate with one another and the 
method of communication is essential for configuring your system.

The following diagram illustrates the communication paths and protocols of 
the ALM Performance Center system:
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The following table displays the connection ports that are opened by default 
on the various ALM Performance Center components:

* HTTPS is also supported on this component.

Component Ports

ALM Platform HTTP (8080/80) *:

➤ For JBoss Web server: 8080

➤ For IIS Web server: 80

Performance Center Server HTTP (80) *

TCP (3333, 54245)

Performance Center Host HTTP (8731)

TCP (3333, 5001, 5002, 5003, 54245, 54345)

Database TCP (1433 (SQL)), 1521 (Oracle))

Repository NetBIOS

Diagnostics Server HTTP (80, 2006) *

TCP (54345)

Standalone Load Generator TCP (5001, 5002, 5003, 54245, 54345)

MI Listener HTTP/TCP (443)

TCP (50500)

Application under test Any; HTTP (Random)

SiteScope - Topology HTTP (8080) *

SiteScope - Monitor Profiles HTTP (8888) *
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Coexistence of Installed Components
The following table describes which components can and cannot coexist on 
the same machine. 

Load Considerations
The following table provides some basic installation considerations for each 
Performance Center component:

Machine
Quantity in 
the system

Load Considerations

Performance 
Center Server

At least two Heavy load.

To balance the load, the ALM Platform has 
built in load balancing capabilities. 

For additional load balancing support, you can 
install multiple Performance Center Servers.

For more information on load balancing, see HP 
Software Self-solve knowledge base article 
KM1052520 
(http://h20230.www2.hp.com/selfsolve/
document/KM1052520).



Chapter 1 • Before You Install

29

Performance 
Center Hosts:

➤ Controller

➤ Load 
Generator

➤ Data 
Processor

At least one 
of each

Controller has heavy load.

Load generator has medium load.

Data processor has medium to high load.

It is recommended to designate spare 
Controllers and load generators for fault-
tolerance and high availability purposes.

Note: 

➤ You can configure a host as a Controller + 
Load Generator, but this is not recommended 
because running Vusers consumes a lot of 
resources. Running Vusers on the Controller 
host is only appropriate for performance tests 
that have a very small number of Vusers.

➤ You can configure a host as a Controller + 
Data Processor, but this is not recommended 
because data processing might consume high 
amounts of CPU and resources. 

MI Listener At least 
one, if you 
are 
monitoring 
over a 
firewall

Medium load.

➤ Standalone installation is required. 

➤ Cannot exist on a machine running IIS.

Monitor Over 
Firewall 
machine

At least 
one, if you 
are 
monitoring 
over a 
firewall

Light load.

Standalone installation is required. 

SiteScope 
(optional)

One Light load.

Machine
Quantity in 
the system

Load Considerations
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System Component Considerations

The Performance Center system includes several components. This section 
provides pre-installation considerations for each of the components.

Note: For system requirement details for each component, see the 
HP Application Lifecycle Management Readme.

➤ "Performance Center Server" on page 30

➤ "Performance Center Host" on page 32

➤ "Standalone Load Generator (Windows)" on page 32

➤ "Standalone Load Generator (UNIX)" on page 32

➤ "Standalone VuGen and Standalone Analysis" on page 32

➤ "MI Listener" on page 33

➤ "Monitor Over Firewall Machine" on page 33

➤ "ERP and CRM Mediator" on page 33

➤ "SiteScope Server" on page 33

Performance Center Server

➤ We strongly recommend installing the Performance Center Server on a 
clean machine with a new image.

➤ Performance Center Servers conduct Performance Center administration, 
test design, run operations, monitoring, and the user interface services for 
these operations. Because performance test run operations create heavy 
load on the Performance Center Server, we recommend installing at least 
two Performance Center Servers in your system. Using built-in load 
balancers, calls to and from the ALM Platform are balanced among the 
Performance Center Servers in a round-robin fashion. 

➤ Before you install the Performance Center Server, you must install 
Microsoft Internet Information Services (IIS 6/7).
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➤ On all Performance Center Servers using IIS, ensure that the following 
Web Service Extensions are allowed in IIS:

➤ Active Server Pages

➤ ASP.NET v2.0.50727

➤ IIS 6 Management Compatibility 

➤ On all Performance Center Servers using IIS 6.0, IWAM_<machine_name> 
must exist, and must belong to the Administrators or IIS Worker Process 
groups.

➤ During installation of the Performance Center Server, the default 
Performance Center system user, IUSR_METRO (password 
P3rfoRm@1nce), is created in the Administrators user group of the 
machine. Ensure that there is no security system in place that will remove 
the system user from the Administrators group.

➤ If Performance Center is working with an Oracle database, ensure that the 
Oracle client installed on the Performance Center Server machine is at 
least the same version as on the Oracle server, and that connectivity is 
established with the Oracle Server. For details, see "Establishing 
Connectivity with Oracle" on page 135.

➤ The Oracle client installation should be compatible with 32-bit operating 
systems, even if the Performance Center Server is installed on a 64-bit 
operating system.

➤ If you install the Oracle client after installing the Performance Center 
Server, you must restart the machine after installing the Oracle client.

➤ Oracle Monitoring: If you will need to define Oracle monitors, ensure that 
you install the Performance Center Server in a directory whose path does 
not include any of the following characters: ( ) : ; * \ / ” ~ & ? { } $ % | < > 
+ = ^ [ ]. For example, on a 64-bit machine, do not install the 
Performance Center Server in the default installation directory 
(C:\Program Files (x86)\....), as this path includes illegal characters.

➤ Microsoft Windows Script Host should be version 5.6 or later. To verify 
the version number, navigate to the <Windows installation 
directory>\Windows\system32 directory. Right-click wscript.exe and 
select Properties. In the Version tab, verify the file version number.
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Performance Center Host

➤ During installation of Performance Center hosts, a default 
Performance Center system user, IUSR_METRO (password 
P3rfoRm@1nce), is created in the Administrators user group of the 
machine. Ensure that there is no security system in place that will remove 
the system user from the Administrators group.

➤ Recording VuGen scripts is supported on hosts on 32-bit machines only. 

Standalone Load Generator (Windows)

➤ You cannot install the Standalone Load Generator on the same machine 
as the Performance Center Server or Performance Center host.

➤ If both Standalone VuGen and Standalone Analysis are to be installed on 
the machine where you want to install the Standalone Load Generator, 
make sure to install the Standalone Load Generator last.

➤ During installation of the Standalone Load Generator, the default 
Performance Center system user, IUSR_METRO (password 
P3rfoRm@1nce), is created in the Administrators user group of the 
machine. Ensure that there is no security system in place that will remove 
the system user from the Administrators group.

Standalone Load Generator (UNIX)

➤ You can install the Standalone Load Generator on a UNIX platform to run 
Vusers. The UNIX Vusers interact with the Controller that is installed on a 
Windows machine. For more information, see "Installing 
HP Load Generator on UNIX" on page 83.

Standalone VuGen and Standalone Analysis

➤ If you are installing the Standalone Load Generator on the same machine 
as Standalone applications (VuGen or Analysis), install the Standalone 
applications first, and the Standalone Load Generator last.
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MI Listener

➤ The MI Listener must be installed on a standalone machine.

➤ The MI Listener cannot be installed on a machine running IIS. 

Monitor Over Firewall Machine

➤ The Monitor Over Firewall agent must be installed on a standalone 
machine.

ERP and CRM Mediator

➤ The ERP and CRM Mediator must be installed on a machine that resides 
in the same LAN as the monitored ERP/CRM server, preferably on a 
dedicated machine. It is not recommended to install the Mediator on a 
Siebel or Oracle server that is involved in the performance test.

Note: When using SAP Diagnostics, ensure that a SAPGUI client is 
installed on the same machine as the ERP/CRM Mediator.

➤ By default, the ERP/CRM Mediator agent is installed to run as a service. 
After installing the agent, verify that it is running as a service and not as a 
process. If it is running as a process, you must stop the process and run 
the agent as a service.

➤ For information about configuring the ERP/CRM Mediator after 
installation and using the ERP and CRM Mediator to collect diagnostics 
data, see the HP ALM Performance Center Guide.

SiteScope Server

➤ SiteScope is used for monitoring applications.

➤ Refer to the HP SiteScope Deployment Guide for minimum requirements.
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General Pre-installation Considerations

This section includes pre-installation considerations for all 
Performance Center components. 

➤ Before you begin installing, you should decide which machine is to be 
used for what purpose. Consider the expected load on each machine 
when determining which components to install on which machines. For 
more details, see "Coexistence of Installed Components" on page 28, and 
"Load Considerations" on page 28.

➤ Ensure that the server time on the ALM Platform server and 
Performance Center component machines are synchronized.

➤ Default Web Site must be configured on the machines that have IIS 
installed on them. To check if this is configured, right-click My Computer, 
and select Manage. The Computer Management console opens. Expand 
the Services and Applications node, and check that Default Web Site is 
displayed in the Internet Information Services folder. If it is not defined 
there, you should contact your system administrator or reinstall IIS.

➤ For standalone installations, you must manually install the prerequisite 
application, .NET Framework 3.5 SP1, from the Performance Center 
Installation DVD (..\Setup\Common\dotnet35_sp1).

➤ You cannot install Performance Center components on machines with 
existing LoadRunner installations. Before installing Performance Center, 
ensure that you have removed any version of LoadRunner from the 
machine.

➤ Hyper-Threading must be disabled. Performance Center does not support 
Intel Hyper-Threading technology. Hyper-Threading can be disabled in 
the BIOS.

➤ Ensure that the operating system and the database are both configured for 
the same language. If not, some texts displayed in Performance Center 
will be corrupted. For example, if you are working with German, ensure 
that you are working on a German operating system, and that the 
database is configured for German.

➤ IUSR_<machine_name> must exist on all Performance Center machines.
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Required Services

Before you install Performance Center components, check that the services 
defined in the table below are running on each component machine and 
that the startup type for each service is defined as Automatic.

Note: The default settings for running the services on the operating system 
may differ from one version to another. You should go through all of the 
services on each machine to ensure that the required services are running. 

Machine Services

All Performance Center 
Servers and Hosts

➤ IPSEC Services (for TCP/IP security)

➤ NTLM Security support provider

➤ Remote Procedure Call (RPC)

➤ Management Instrumentation (for 
Performance Center health check)

➤ Event Log (optional— used for debugging)

➤ COM+ services (Event System and System 
application)

➤ HTTP SSL (for SSL)

➤ System Event Notification (for COM+)

Performance Center 
Servers

➤ IIS Admin Service (Microsoft Service)

➤ Workstation

➤ TCP/IP NetBIOS Helper

➤ World Wide Web Publishing Service (Microsoft 
Service)

➤ Distributed Transaction Coordinator (MSDTC)

Performance Center 
Hosts

➤ Remote Registry Service (Windows Service)
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Performance Center Prerequisite Software

Before you can install Performance Center, some prerequisite software (for 
example, .NET Framework 3.5 SP1) must be installed on your machine. 
During installation, Performance Center checks whether the prerequisite 
software is installed on your machine. Performance Center enables you to 
automatically install missing software from the Performance Center disk.

The following table provides a list of the prerequisite software and how 
Performance Center detects whether the software is installed.

Prerequisite 
Software

Machines Means of detection

.NET 
Framework 3.5 
SP1

➤ All Performance Center 
machines

➤ Standalone VuGen 

➤ Standalone Analysis

Searches the registry key:

HKLM\\Software\\Microsoft\\NET 
Framework Setup\\NDP\\v3.5

Microsoft Data 
Access 
Components 
(MDAC) 2.8 
SP1 (or later)

➤ All Performance Center 
machines

➤ Standalone VuGen 

➤ Standalone Analysis

Searches the registry key:

HKLM\\Software\\Microsoft\\Data
Access 

Microsoft Core 
XML Services 
(MSXML) 6.0

➤ All Performance Center 
machines

➤ Standalone VuGen 

➤ Standalone Analysis

Queries the existence and 
version of: 
%systemroot%\system32\msxml
6.dll

Microsoft 
Visual C++ 
2008 
Redistributable 
Package (x86)

➤ All Performance Center 
machines

➤ Standalone VuGen 

➤ Standalone Analysis

Queries the MSI manager for 
one of the GUIDs below:

{A49F249F-0C91-497F-86DF-
B2585E8E76B7}

{437AB8E0-FB69-4222-B280-
A64F3DE22591} 
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Microsoft 
Windows 
Installer 3.1

➤ All Performance Center 
machines

➤ Standalone VuGen 

➤ Standalone Analysis

Looks for one of the following:

➤ Registration of the 
WindowsInstaller. 
Installer.com object version 
3 or later 

➤ MSI.dll version 3 or later in 
the %systemroot% 

Web Services 
Enhancements 
(WSE) 3.0 for 
Microsoft .NET 
Redistributable 
Runtime MSI

➤ All Performance Center 
machines

➤ Standalone VuGen 

➤ Standalone Analysis

Queries the MSI manager for 
the GUID: 

{E3E71D07-CD27-46CB-8448-
16D4FB29AA13} 

Web Services 
Enhancements 
(WSE) 2.0 SP3 
for Microsoft 
.NET 
Redistributable 
Runtime MSI

➤ All Performance Center 
machines

➤ Standalone VuGen 

➤ Standalone Analysis

Runtime installation GUID 
{F3CA9611-CD42-4562-ADAB-
A554CF8E17F1} 

Full installation GUID 
{6F 396FFB-CC3A-4335-BC0B-
2AEF38F4492C} 

Internet 
Information 
Services (IIS)

➤ Performance Center Server HKLM\\SOFTWARE\\Microsoft\\I
netStp 

Looks for both Major and 
Minor numbers. 

Supports versions 6.0, 5.1, and 
5.0

Strawberry 
Pearl 5.10.1

➤ Standalone VuGen Queries the MSI manager for 
the GUID:

{C977182F-221A-337A-B681-
963808E0023A}

Prerequisite 
Software

Machines Means of detection
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2
Installing HP ALM Performance Center

This chapter describes how to install HP ALM Performance Center 11.00 
components. 

This chapter includes:

➤ Installation Flow on page 42

➤ Installing HP Application Lifecycle Management on page 44

➤ Deploying the Performance Center Extension on page 45

➤ Installing and Configuring Performance Center Servers and Hosts 
on page 48

➤ Installing the Performance Center Server and Host Patch on page 64

➤ Installing the Performance Center Language Pack on page 67

➤ Initial Performance Center Manual Configuration on page 67

➤ Silent Installation of Performance Center on page 72

➤ Setting Up the Silent Configuration on page 79

➤ Installing Standalone Components (Windows) on page 80

➤ Installing HP Load Generator on UNIX on page 83

➤ Installing Additional Components on page 98

➤ Repairing the Performance Center Installation on page 101

➤ Uninstalling Performance Center Components on page 102
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Installation Flow

This section describes the steps required to install HP ALM 
Performance Center 11.00 components and patches. 

Note: To install HP ALM Performance Center 11.00 components, you must 
have full local administrative rights on the designated machines.

To install HP ALM Performance Center:

 1 Install Performance Center components and patches according to

                             the following checklist: 
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l

✔ Component Action
New 
Installation

Patch 
Installation

Page

ALM 
Platform

Install ALM Platform ✔ X 44

Install ALM latest patch ✔ ✔ 44

Install 
Performance Center 
extension - Patch 02

✔

(batch file)

✔

(deploy tool)

45

Performance
Center 
Server

Install 
Performance Center 
Server

✔ X 48

Install 
Performance Center 
Server - Patch 02

✔ ✔ 64

Optional: Install 
Performance Center 
language pack (for 
localized ALM versions)

✔ ✔ 67

Performance
Center 
Hosts

Install 
Performance Center 
host

✔ X 48

Install 
Performance Center 
host - Patch 02

✔ ✔ 64

Optional: Install 
Performance Center 
host language pack (for 
localized ALM versions)

✔ ✔ 67

Standalone 
Components
(optional)

Install 
Performance Center 
Standalone applications 
(Windows)

✔ X 80

Install 
Performance Center 
Standalone applications 
- Patch 02 (Windows)

✔ ✔ 82

HP Load Generator on 
UNIX - Patch 02

✔(Patch 02 

version only)

✔(must 

uninstall first)

83



Chapter 2 • Installing HP ALM Performance Center

44

 2 Ensure that the ALM client browser’s Trusted Sites list includes 
Performance Center Server.

For details, see step 19 on page 64.

 3 Verify that the installation was successful.

For details, see Chapter 3, "Post Installation Verification."

Installing HP Application Lifecycle Management

As a prerequisite to installing HP ALM Performance Center 11.00 
components, you must install HP Application Lifecycle Management 11.00 
and the latest patch.

To install HP Application Lifecycle Management 11.00:

 1 Install the appropriate version of HP ALM for your system 
(Windows/UNIX/localized). For details on installing HP ALM 11.00, refer 
to the HP Application Lifecycle Management Installation Guide, or the 
documentation for the localized ALM version with which you are 
working.

Note: Ensure that the ALM Platform is installed on a certified operating 
system. Consult the ALM Platform System Configurations section of the 
HP ALM Readme for a full list of recommended and supported operating 
systems for HP ALM Performance Center.

 2 Install the latest HP ALM Patch on the ALM Platform machine. (HP ALM 
Patch 01 is a minimum requirement.) For details, see the relevant HP ALM 
Patch Readme.

 3 Set up the HP ALM client machine with the correct browser 
configuration. For details, refer to the HP Application Lifecycle Management 
Installation Guide.
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Deploying the Performance Center Extension

This section describes the steps required to deploy the Performance Center 
extension on the ALM Platform. Installing the extension enables you to 
create Performance Center projects with Performance Center entities, such 
as monitors, scripts, performance tests. It also creates the Lab Management 
project (LAB_PROJECT), enabling you to define Performance Center lab 
resources and perform all Performance Center administration.

Note: 

➤ New installation: If the Performance Center 11.00 release version 
extension is not yet installed on your system, do not install it. Follow the 
procedure below to deploy the latest version of the extension for a new 
installation.

➤ Patch installation: If the Performance Center 11.00 extension is already 
installed on your system, follow the procedure on page 46 to deploy the 
latest version.

➤ UNIX installation: For an ALM Platform installed on a UNIX system, 
follow the procedure on page 47 to deploy the extension.

To deploy the Performance Center extension for a new installation:

 1 On the ALM Platform server, navigate to the relevant folder for your 
system in the Patch 02 installation package (for English or ALM localized 
version), and run the runPcQcConfigurator.bat installation file.

 2 The wizard opens, displaying the Performance Center extensions that will 
be deployed. Click Next.

 3 The wizard displays the deployment progress. The deployment may take 
some time. When the deployment is complete, click Next.

 4 Upon successful deployment, select Start JBoss to start the JBoss service. 

 5 Click Finish to exit the Deployment wizard. 

 6 The configuration tool opens. This tool creates the Lab Management 
schema (LAB_PROJECT project) in ALM. Click Next.
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 7 To connect to the ALM Platform, provide the ALM Platform internal URL, 
and the user name and password of the ALM Site Administrator. Click 
Next.

 8 Specify Site Administration database details, according to the following 
guidelines:

➤ The database server name must be the same database on which the Site 
Administration database was created.

➤ The database server name must be listed in the Site Administration 
DB Servers tab.

 9 The tool confirms the successful creation of Lab Management in ALM. 
Click Finish to exit the Configuration tool. 

To verify the creation of Lab Management:

➤ Open your Web browser and type your ALM URL
http://<ALM Platform server name>[<:port number>]/qcbin. Click the 
Lab Management link, and enter your credentials to log in.

➤ View the log file:

➤ Win 2003: c:\Documents and Settings\All Users\Application 
Data\HP\PC\log\PcQcConfiguratorLog_<Time>.log

➤ Win 2008: 
c:\ProgramData\HP\PC\log\PcQcConfiguratorLog_<Time>.log

To deploy the patch on the Performance Center extension:

 1 On the ALM Platform server, select Programs > HP ALM Platform > 
Extension Deployment Tool > Deploy. The Extension Deployment Wizard 
opens.

 2 Click Add, and browse to the location of the Performance Center 
Extension files. Two files are available for deployment: The Lab 
Management (PCLAB.qcx) and the Performance Center project 
(PCPROJECT.qcx) extension files.

 3 Add both the PCLAB.qcx and the PCPROJECT.qcx files and click Open. 
Then click Next, and then Next again to deploy the patch on the 
Performance Center Extension. Note: You must deploy both extension 
files at the same time to ensure a successful deployment.
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To deploy the extension on a UNIX system:

 1 On the ALM Platform server, locate the relevant extension folder for 
UNIX in the Patch 02 installation package, and run the following 
command in console mode:

according to the following guidelines:

➤ The database server name must be the same database on which the Site 
Administration database was created.

➤ The database server name must be listed in the Site Administration 
DB Servers tab.

➤ The ALM Site Administrator user password is not required if a 
password is not defined for the user.

The installation procedure copies the extension files, and the console 
displays the deployment progress.

 2 If you are working with an application server other than JBoss, you are 
prompted to manually deploy the qcbin.war file, located in 
/var/opt/HP/ALM/deployment. The following options display:

➤ 1 to continue: The installation process creates the Lab Management 
schema (LAB_PROJECT project) in ALM. Note: If you continue before 
completing manual deployment, LAB_PROJECT creation fails.

➤ 2 to exit: If you cancel the process in order to manually deploy the 
application data, you must rerun the script file in step 1.

 3 Upon completion, the console displays a message confirming the 
successful creation of Lab Management in ALM.

To verify the creation of Lab Management:

➤ Open a Web browser and type your ALM URL
http://<ALM Platform server name>[<:port number>]/qcbin. Click the 
Lab Management link, and enter your credentials to log in.

➤ View the log file, located in /var/opt/HP/PC/log.

runPcQcConfigurator.sh <DB Server name> <ALM Platform URL> 
<ALM Site Administrator user> <ALM Site Administrator user 
password>
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Installing and Configuring Performance Center Servers and 
Hosts

This section describes how to install and configure the Performance Center 
Server and Performance Center hosts.

Note: If you are upgrading to HP ALM Performance Center 11.00 from an 
earlier version of Performance Center, follow the instructions in Chapter 5, 
"Upgrading to HP ALM Performance Center 11.00."

Pre-Installation Considerations:

➤ Before you install the Performance Center components, review the pre-
installation information, described in Chapter 1, "Before You Install."

➤ To install a Performance Center Server or Performance Center host, you 
must have full local administrative rights on the designated machine.

➤ If the Performance Center installation directory is located on a network 
drive, it is recommended to map the network drive before you run the 
installation.

➤ To enable running the installation from a network location, make sure 
that the network location path is added to the Trusted Sites of the 
machine on which you are running the installation.

➤ If you are installing a Performance Center Server or Performance Center 
host using a Remote Desktop connection (RDP), you must install through 
the console.

➤ If you are working with an Oracle database, ensure that the Oracle client 
is installed on the Performance Center Server (with Administrator 
installation type), and that connectivity has been established with the 
Oracle Server. Ensure that the tnsnames.ora file contains the same TNS 
entry for the source and target database server.

➤ The Performance Center Server and the Performance Center host cannot 
be installed on the same machine.
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To install a Performance Center Server or Performance Center host:

 1 Launch the Performance Center installer.

Insert the HP ALM Performance Center installation disk and run 
setup.exe (<installation disk root directory>\setup.exe). 

 2 Select an installation option.

The setup program starts and displays the installation menu page. 
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Select one of the following options: 

➤ Performance Center Server

➤ Performance Center Host

Note: If you know in advance that a particular host machine is to be used 
as a load generator only, we recommend that you install the Standalone 
Load Generator for the following reasons: 

➤ The installation requires less disk space

➤ Moving the Load Generator’s setup files is less time consuming than 
moving the setup files of the Performance Center Host 

For details on installing the Standalone Load Generator, see "Installing 
Standalone Components (Windows)" on page 80.

To install a load generator on UNIX, see "Installing HP Load Generator on 
UNIX" on page 83.
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 3 If necessary, install prerequisite software.

Some prerequisite software (for example, .NET Framework 3.5 SP1) must 
be installed on the machine before installing the Performance Center 
component. If any of the prerequisite software is not already installed on 
the machine, the following dialog box opens:

Click OK and follow the on-screen instructions to install the prerequisite 
software before continuing with the Performance Center component 
installation. You cannot continue with the Performance Center 
component installation unless all the prerequisite software is installed.

For a full list of prerequisite software, see "Performance Center 
Prerequisite Software" on page 36.
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Note: 

➤ Performance Center Server installation: If Microsoft Internet 
Information Services (IIS) 6/7 is listed on this page, you must close the 
installation, install IIS, and start the installation again.

➤ If you are installing the Performance Center Server on the Windows 
2008 R2 Operating System, you must install Static Content as part of 
IIS installation. In Server Manager > Roles > Web Server (IIS), select 
Static Content.

➤ If you are working with Windows 2008 64-bit R2 Operating System, 
you must install .NET Framework 3.5 SP1 from the Server Manager 
Feature list.

➤ If you are prompted to restart the machine after installing the 
prerequisite software, you must do so before continuing with the 
installation.

After rebooting the machine, run setup.exe again to continue with the 
installation. If the installation continues from where it left off before 
rebooting, we recommend starting the setup again—the installer will 
detect the installed prerequisites and continue with the installation.

 4 Start the installation.

The Performance Center Setup Wizard opens, displaying the Welcome 
page for the relevant Performance Center component. Click Next.

 5 Review the License agreement.

To accept the terms of the license agreement, select I Agree. Click Next.
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 6 Register your customer information on your computer.

On the Customer Information page, enter your name and organization 
name, and click Next.
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 7 Select an installation folder.

Specify the location in which to install the Performance Center 
component. To browse possible locations, click the Browse button, select 
a location, and click OK. 

To check required and available disk space on each drive, click Disk Cost. 

Click Next.
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 8 Start the installation process.

The wizard prompts you to confirm the details and start the installation. 
To review or change any settings, click Back.

Click Next to start the installation. The wizard displays the installation 
progress.
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 9 Upon completion of the installation, configure the component.

The Welcome page of the Configuration wizard opens. 

Click Next. 

Click Next again to start the background configuration. The wizard 
displays the progress bar as it performs the following configurations on 
the relevant component:

Configuration PC Server PC Host

Copies and registers files on the machine Yes Yes

Creates the Performance Center system user, 
IUSR_METRO (default password: P3rfoRm@1nce),  
and adds it to the machine's Administrators group.

For information about changing the system user, 
see the HP ALM Performance Center Guide.

Yes Yes
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Next Step:

➤ For Performance Center Server configuration, continue with step 10 
on page 58. 

➤ For Performance Center Host configuration, proceed with step 15 on 
page 63.

Configures DCOM objects Yes Yes

Adds the Performance Center path to the 
environment variables

Yes Yes

Installs Performance Center services 

➤ DataCollectionAgent

➤ RemoteManagement Agent Service

Yes Yes

Installs Performance Center services

➤ Performance Center Agent Service

➤ Performance Center Load Testing Service

-- Yes

Configures IIS:

➤ Creates virtual directories and application pools

➤ Configures IIS application pools to work as 
32-bit application pools

IIS6:

➤ Installs extensions (if not already installed): ASP 
.Net 2.0, Active Server Pages, and enables them

IIS7:

➤ Enables Windows communication foundation

➤ Adds rules: Web-ASP, Web-Asp-Net

Yes --

Configuration PC Server PC Host
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 10 Performance Center Server only: Enter the Communication Security 
passphrase.

Enter the Communication Security passphrase for secure communication 
between the Performance Center Server and the ALM Platform. This must 
be identical to the passphrase defined during the ALM Platform 
installation. You can view the passphrase in Site Administration > Site 
Configuration tab > COMMUNICATION_SECURITY_PASSPHRASE 
parameter. For more details, refer to the HP Application Lifecycle 
Management Administrator Guide.

Click Next.
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 11 Performance Center Server only: Configure the internal connection to 
the ALM Platform.

Note: 

In the following steps (steps 11 through 14), the wizard enables you to 
configure the Performance Center Server and license details in Lab 
Management. You can skip these steps and configure these details 
manually before you start working with ALM Performance Center. For 
details, see "Initial Performance Center Manual Configuration" on 
page 67. 

To successfully configure these details, the Performance Center Server 
patch level must match the ALM patch level. If ALM Patch 01 or Patch 02 
is already installed on the ALM Platform, there is a mismatch between the 
ALM patch level and the Performance Center Server patch level. 
Therefore, you cannot successfully configure these details at this stage. To 
skip these steps and configure later, select Configure the connection later. 
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In this step, enter an internal URL that is to be used for all internal 
communication between the Performance Center components and the 
ALM Platform.

Enter the internal URL using the following format:

where <ALM Platform> is a logical name for the ALM Platform server.

For SSL connectivity with the ALM Platform, the internal URL must begin 
with https://, for example:

http://<ALM_Platform>:8080/qcbin

https://myalmp:8080/qcbin
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Note: If JBoss on the ALM Platform is configured with a non-default port, 
then the internal URL you enter above must reflect the updated port.

Alternatively, select Configure the connection later. 

Click Next. If you chose to configure the connection later, continue with 
step 16 on page 63.

 12 Performance Center Server only: Add the Performance Center Server to 
ALM.

Enter the Performance Center Server URLs:
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➤ External URL. The URL used to connect to the Performance Center 
Server from an external source.

➤ Internal URL. The URL used to connect to the Performance Center 
Server from within ALM. 

Note: If IIS on the Performance Center server is configured with a non-
default port, then the URLs you enter above must reflect the updated 
port.

 13 Performance Center Server only: Register the Performance Center license 
in ALM.

Enter the Performance Center license key, and click Next.
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 14 Performance Center Server only: Register the Performance Center Host 
license in ALM.

Enter the Performance Center host license key, and click Next.

 15 Confirm configuration changes.

The wizard prompts you to confirm the configuration of the 
Performance Center Server or host. Click Next.

 16 Close the configuration wizard and continue with installation. 

When the configuration is complete, the wizard confirms the 
configuration status. Click View Summary to view a summary of the 
configuration. 

Click Finish to exit the Configuration wizard.
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 17 Complete the installation process.

The Installation wizard, which remained open during the configuration, 
now displays the installation status. Click Finish to exit the Installation 
wizard. 

 18 Exit the Performance Center Installer.

On the Performance Center installation menu page, click Exit.

Note: If prompted, restart the computer.

 19 Add the Performance Center Server to the Trusted Sites of the ALM client 
browser.

Ensure that the Performance Center Server is listed in the Trusted Sites of 
the ALM client browser. 

 a In Internet Explorer, select Tools > Internet Options. The Internet 
Options dialog box opens.

 b In the Security tab, select Trusted Sites, and click Sites. 

 c If you are not using SSL, ensure that the Require Server verification 
(https:) for all sites in this zone option is not selected.

 d In the Add this website to the zone box, enter the Performance Center 
Server internal URL, and click Add.

Installing the Performance Center Server and Host Patch

The section describes how to install the Performance Center patch on the 
Performance Center Server and Performance Center hosts.

To install the patch on the Performance Center Server:

On the Performance Center Server, run the qfe.msp patch installation file 
and follow the onscreen installation and deployment instructions.
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To install the patch on Performance Center hosts:

There are two alternate methods of installing the patch on the hosts: direct 
installation or remote installation.

Direct installation. You install the patch directly on the host. To install the 
patch, on the host, run the qfe.msp patch installation file and follow the 
onscreen installation and deployment instructions.

Remote Installation. You install the patch on the host remotely from Lab 
Management. The advantage of this installation method is that it allows you 
to install the patch on more than one host simultaneously.

To install the patch remotely, perform the following steps:

 1 Prerequisite step: On the host that you intend to use the remote 
installation method, make sure that the Remote Procedure Call (RPC) 
service is started, as follows: Select Start > Run and type services.msc. 
Then in the Services window, locate Remote Procedure Call (RPC) and 
verify that its status is Started. If the status is not started, right-click it and 
select Start.

 2 Log in to Lab Management.

 3 On the Lab Management sidebar, under Lab Settings, select Patches.

 4 Click the New Patch button. The Select Patch dialog box opens.

 5 Navigate to the location of the patch file, and click Open. The New Patch 
dialog box opens.

 6 Enter the details for the new patch and click OK. The patch is added to 
the system and appears in the Patches grid. For an explanation of the New 
Patch dialog box fields, see the “Patch Management” chapter in the 
HP ALM Performance Center Guide.

 7 On the Lab Management sidebar, under Lab Resources, select Hosts.

 8 Click the New Host button. The New Host dialog box opens.

 9 Enter the details for the host on which you will install the patch. Then 
click OK. For an explanation of the New Host dialog box fields, see the 
“Lab Resource Management” chapter in the HP ALM Performance Center 
Guide.
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Note: 

➤ When adding the Performance Center host, its version must be the 
same as the Performance Center Server installed version. Therefore, in 
order to add the host and then install the patch from Lab 
Management, you must define its status as Unavailable.

➤ If the host is not added successfully, make sure that the 
Performance Center Load Testing Service is running on the host: Select 
Start > Run, and type services.msc. The Services window opens. Verify 
that the Performance Center Load Testing services is started.

 10 Right-click the host in the grid on which you want to install the patch 
and select Install Patch. To view the installation progress, in Lab 
Management select Tools > Task Manager.

Tip: You can install the patch on multiple hosts simultaneously. To select 
multiple hosts, hold down the CTRL key on your keyboard while selecting 
the hosts.

 11 When the patch installation process is complete, on the Lab Management 
sidebar, under Lab Resources select Hosts. Select the host on which you 
installed the patch, and click Reconfigure Host. 

 12 Verify the patch installation:

➤ In the host’s event log, verify that the patch installation was 
successful. For more information about the Event Log, see the 
HP ALM Performance Center Guide.

➤ You can also verify that patch was installed on the host in Control 
Panel > Add or Remove Programs or Control Panel > Programs and 
Features > View Installed Updates on the host machine.
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Installing the Performance Center Language Pack

If you are working with a localized version of HP ALM, you can install the 
Performance Center language pack on the Performance Center Server and 
hosts. The language pack is available as part of the patch installation 
package.

To install the language pack:

On the Performance Center Server or host, run the relevant qfe.msp 
language pack file, and follow the onscreen installation and deployment 
instructions.

Initial Performance Center Manual Configuration

After the Performance Center Server installation, the Performance Center 
Server Configuration wizard runs. If you chose to skip any of the 
configuration wizard steps, you must perform the configuration manually 
before you can use the product. 

This section describes how to perform the initial configuration manually in 
Lab Management.

Note: Alternatively, you can manually run the HP ALM Performance Center 
Server Configuration tool located on the Performance Center Server. (Start > 
Program Files > HP Performance Center Server > Tools > 
HP Performance Center Server Configuration Wizard).

If you provided all the required details during the configuration, and did not 
skip any of the configuration wizard steps, proceed with "Adding 
Performance Center Hosts" on page 71. 

This section includes:

➤ "Logging In to Lab Management" on page 68

➤ "Adding the Performance Center Server to the System" on page 68
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➤ "Setting the License Keys" on page 70

➤ "Adding Performance Center Hosts" on page 71

Logging In to Lab Management
All Performance Center administration tasks are done in Lab Management. 

To log in to Lab Management: 

 1 Open the Web browser and type the ALM URL
http://<ALM server name>[<:port number>]/qcbin.

The ALM Options window opens.

 2 Click Lab Management, enter the user name and password of a Site 
Administrator, and click Login. 

Adding the Performance Center Server to the System
To use the Performance Center Server, it must be defined in ALM. 

Note: From a performance and fault tolerance perspective, it is strongly 
recommended to define at least two Performance Center Servers.

To define the Performance Center Server:

 1 Log in to Lab Management. See "Logging In to Lab Management" on 
page 68.

 2 On the Lab Management sidebar, under Lab Settings, select PC Servers.
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 3 For each Performance Center Server:

 a In the PC Servers module, click New PC Server. 

 b Enter the details of the Performance Center Server as follows:

Note: To allow for proper communication between the ALM Platform 
and Performance Center servers, make sure that you validate the 
correct internal and external URLs of the Performance Center Servers. 
The internal URL must be accessible from within the ALM Platform 
and the Performance Center Servers. The external URL can include the 
relevant port, unless it was defined as part of the URL.

➤ Name. The name of the Performance Center Server. 

➤ External URL. The URL for accessing the Performance Center Server 
from external sources.

➤ Internal URL. The URL for accessing the Performance Center Server 
from within the system. For example, the Performance Center 
Server and the ALM Platform communicate with each other through 
this URL.

➤ Status. Make sure that the Performance Center Server’s status is 
Operational so that the ALM Platform and other 
Performance Center components can access it.
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Setting the License Keys
After you add the Performance Center Server to ALM, you are required to 
enter the Performance Center license and the Performance Center host 
license keys. 

➤ The Performance Center license enables you to use the product and run 
load tests. This license determines the number of performance tests that 
you can run concurrently, and the total number of Vusers available for 
the performance tests.

➤ The Performance Center Host license defines the Vuser protocols, 
monitors, and modules that are available on each host machine. This 
license also determines the number of Vusers available per protocol.

To set the license keys:

 1 On the Lab Management sidebar, under Lab Settings, select License. 

 2 In the Performance Center Licenses section, click New PC License and 
enter the Performance Center license key.

 3 In the Host Licences section, click Add Host License and enter the Host 
license key. Click OK to set the new host license key. Performance Center 
checks the validity of the license key, and closes the dialog box. 

If valid, the host license is updated on all the relevant host machines.

The license is not updated on the following machines as they do not 
require a host license:

➤ Standalone load generators on Window platforms

➤ Standalone load generators on UNIX platforms
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Adding Performance Center Hosts
To work with the Performance Center hosts, you must first add them to 
ALM. To add a host, you must first define the host’s location in ALM. If the 
host is a load generator over a firewall, you must define the MI Listener 
through which the load generator will communicate with the 
Performance Center Server.

Note: When adding the hosts, fields in red marked with an asterisk (*) are 
mandatory, including the type of operating system, and the purpose of the 
host. For details, see the HP ALM Performance Center Guide.

To add hosts:

 1 Log in to Lab Management. 

See "Logging In to Lab Management" on page 68.

 2 Add the host’s location.

 a Under Lab Resources, select Locations. 

 b In the Host Locations module, click the New Host Location button, 
and enter the host location’s details. 

 3 For a host over a firewall, add the MI Listener.

 a Under Lab Resources, select MI Listeners. 

 b In the MI Listeners module, click the New MI Listener button, and 
enter the MI Listener’s details. 

 4 Add the host.

 a Under Lab Resources, select Hosts. 

 b In the Hosts module, click the New Host button, and enter the host’s 
details. In particular:

➤ In the Installation field, select the type of host installation: Window 
Host; Windows Standalone LG; UNIX.

➤ In the Purpose field, select a purpose for the host.
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Silent Installation of Performance Center 

A silent installation is an installation that is performed automatically, 
without the need for user interaction. This section describes how to perform 
a silent installation of Performance Center components.

Before you perform the installation, review the pre-installation information, 
including the system requirements, described in Chapter 1, "Before You 
Install."

This section includes:

➤ "Silent Installation of Prerequisite Software" on page 73

➤ "Silent Installation of Performance Center Server and Performance Center 
Hosts" on page 75

➤ "Silent Installation of the Standalone Load Generator" on page 77
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Silent Installation of Prerequisite Software
Install the prerequisite software silently by running the relevant commands 
as follows: 

Note: Some of the paths in the table below include the <environment> 
parameter, which represents the language of the environment on which you 
are working. Replace this parameter as follows:

➤ For an English environment, replace with EN

➤ For a Korean environment, replace with KOR

➤ For a Japanese environment, replace with JPN

➤ For a Chinese environment, replace with CHS

Prerequisite Software Command 

.NET Framework 3.5 SP1 <Installation_Disk_Root_Directory>\Setup\Common\d
otnet35_sp1\dotnetfx35_sp1.exe /qb

Note: If you are prompted to restart the computer 
after installing this software, you must do so before 
continuing with the installation.

Microsoft Data Access 
Components (MDAC) 2.8 
SP1 (or later)

<Installation_Disk_Root_Directory>\Setup\<environm
ent>\prerequisites\mdac28\mdac28.exe /q:A 
/C:"setup /QNT"

Microsoft Core XML 
Services (MSXML) 6.0

msiexec /log c:\msxml.log /quiet  /I 
<Installation_Disk_Root_Directory>\Setup\<environm
ent>\prerequisites\msxml6\msxml6.msi

Microsoft Visual C++ 2005 
SP1 Redistributable Package 
(x86)

<Installation_Disk_Root_Directory>\Setup\<environm
ent>\prerequisites\vc2005_sp1_redist\vcredist_x86.e
xe /q:a

Microsoft Visual C++ 2008 
Redistributable Package 
(x86)

<Installation_Disk_Root_Directory>\Setup\<environm
ent>\prerequisites\vc2008_redist\vc_red.msi
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Microsoft Windows 
Installer 3.1

<Installation_Disk_Root_Directory>\Setup\Common\
msi31\WindowsInstaller-KB893803-v2-x86.exe /quiet

Web Services 
Enhancements (WSE) 3.0 
for Microsoft .NET 
Redistributable Runtime 
MSI

msiexec /log c:\WSE3.log /quiet /I 
<Installation_Disk_Root_Directory>\Setup\Common\
wse30\MicrosoftWSE3.0Runtime.msi ALLUSERS=1

Web Services 
Enhancements (WSE) 2.0 
SP3 for Microsoft .NET 
Redistributable Runtime 
MSI

msiexec /log c:\WSE2.log /qn /i 
<Installation_Disk_Root_Directory>\Setup\Common\
wse20sp3\MicrosoftWSE2.0SP3Runtime.msi 
ALLUSERS=1

Internet Information 
Services (IIS)

Note: Performance Center 
Server only!

➤ Use the following to install IIS6 on 
Windows 2003:

Sysocmgr.exe /i:sysoc.inf /r /q

C:\<WINDOWS directory>\Microsoft.NET\
Framework\v2.0.50727\aspnet_regiis.exe -i

➤ Use the following to install IIS7 on 
Windows 2008:

start /w pkgmgr /iu:IIS-WebServerRole;WAS-
WindowsActivationService;WAS-
ProcessModel;WAS-NetFxEnvironment;WAS-
ConfigurationAPI

For more details, see:

http://learn.iis.net/page.aspx/136/install-typical-iis-
workloads/ 

Prerequisite Software Command 

http://learn.iis.net/page.aspx/136/install-typical-iis-workloads/ 
http://learn.iis.net/page.aspx/136/install-typical-iis-workloads/ 
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Silent Installation of Performance Center Server and 
Performance Center Hosts
This section describes how to run the silent installation of the 
Performance Center Server and Performance Center hosts on a Windows 
platform.

The silent installation is followed by the silent configuration which calls the 
UserInput.xml file for configuration parameters. You can customize the 
parameters in this file for the Performance Center Server configuration.

To perform a silent installation of Performance Center:

 1 For the Performance Center Server installation: Set up the .xml file that 
provides the input for the initial Performance Center Server configuration 
that runs directly after the installation. For details, see "Setting Up the 
Silent Configuration" on page 79.

 2 Install the prerequisite software. For instructions, see "Setting Up the 
Silent Configuration" on page 79.

The silent installation cannot continue until all the prerequisite software 
is installed.

Note: If you are prompted to restart the computer after installing the 
prerequisite software, you must do so before continuing with the 
installation. 
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 3 After you have installed all the prerequisite software, install the 
Performance Center component by running the appropriate command 
from the command line.

➤ Performance Center Server:

➤ SIlent installation with non-customized UserInput.xml: 

➤ Silent installation with customized UserInput.xml:

where:

➤ <full path to UserInput file> is the path to your customized 
UserInput.xml file

➤ <Target_Installation_Directory> is the directory in which to install 
the Performance Center Server

➤ Performance Center Hosts: 

where <Target_Installation_Directory> is the directory in which you 
want to install the Performance Center host.

msiexec /i <Installation_Disk_Root_Directory>\Setup\Install\Server\HP_PCS.msi
ADDLOCAL=PCCore
TARGETDIR="<Target_Installation_Directory>" /qnb

msiexec /i <Installation_Disk_Root_Directory>\Setup\Install\Server\HP_PCS.msi
ADDLOCAL=PCCore UPGRADINGPRODUCTCODE="<full path to UserInput 
file>" TARGETDIR="<Target_Installation_Directory>" /qnb

msiexec /i <Installation_Disk_Root_Directory>\Setup\Install\Host\HP_LTS.msi
ADDLOCAL=PCCore
TARGETDIR="<Target_Installation_Directory>" /qnb



Chapter 2 • Installing HP ALM Performance Center

77

Silent Installation of the Standalone Load Generator
This section describes how to perform a silent installation of the standalone 
load generator.

Note: For instructions on installing the HP Load Generator silently on 
UNIX platforms, see "Silent Installation of the Standalone Load Generator" 
on page 77.

To perform a silent installation of the standalone load generator:

 1 Install all the prerequisite software except for IIS. For details, see "Silent 
Installation of Prerequisite Software" on page 73. 

 2 Extract the Load Generator installation files to a local directory:

 a Insert the DVD labeled HP ALM Performance Center 11.00 - 
Standalone Applications, and click Load Generator.

 b In the Save files in folder box, enter the name of the local directory 
where you want to save the installation files.

 3 Run the following command from the command line:

where <Installation_Folder> is the local directory where you saved the 
installation files.

msiexec /i "<Installation_Folder>\HP_LoadGenerator.msi" /qb
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 4 After you install the load generator, you need to install the 
Performance Center agent service and the Remote Management agent 
service.

 a To install the Performance Center agent service, run the following 
command from the command line:

 b To install the Remote Management agent service, run the following 
command from the command line:

"<load_generator_installation_directory>\Load 
Generator\launch_service\bin\magentservice.exe" -install

"<load_generator_installation_directory>\Load 
Generator\al_agent\bin\alagentservice.exe" -install IUSR_METRO 
<IUSR_METRO Password>
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Setting Up the Silent Configuration

This section describes how to customize the file used for silent configuration 
of the Performance Center Server. The UserInput.xml file—installed with the 
Performance Center Extension—contains parameters for the 
Performance Center Server and Performance Center Host configurations. 

For the Performance Center Server configuration, you can customize the 
parameters in the UserInput.xml file. You then instruct the Installer to use 
the customized file for the silent configuration input.

To configure the properties in the UserInput.xml file: 

 1 Copy the UserInput.xml file from the installation DVD 
(..\Setup\Install\Server\dat\Setup\PCS\Xml\) to another location. 

 2 Open the copy of the file and enter user-defined values for the following 
properties:

Property Description

PC_External_URL The external URL of the Performance Center 
Server.

PC_Internal_URL The internal URL of the Performance Center 
Server.

PC_License The Performance Center license key.

LR_License The Performance Center Host license key.

ALM_URL The internal URL used for all communication 
between the Performance Center components 
and the ALM Platform.

Format: http(s)://<ALM Platform>:<Port>/qcbin

LW_CRYPTO_INIT_STRING The Communication Security passphrase 
used for secure communication between the 
Performance Center Server and the 
ALM Platform.

Note: This passphrase must be identical to 
the passphrase defined during the 
ALM Platform installation.
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 3 Save the UserInput.xml file.

 4 Specify the location of the saved file when running the silent installation 
command. For details, see "Silent Installation of Performance Center" on 
page 72.

Installing Standalone Components (Windows)

You can install standalone components that provide advanced features for 
working with HP ALM Performance Center. 

To install a load generator on UNIX, see "Installing HP Load Generator on 
UNIX" on page 83.

Note: For all standalone applications, you must first manually install the 
prerequisite application, .NET Framework 3.5 SP1, from the 
Performance Center installation DVD (\Setup\Common\dotnet35_sp1).

This section includes:

➤ "Available Standalone Components for Windows" on page 81

➤ "Installing Standalone Components" on page 82

➤ "Installing the Patch for Standalone Components" on page 82
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Available Standalone Components for Windows
The following standalone components are available. To install these 
components, see "Installing Standalone Components" on page 82.

➤ HP Load Generator. Instead of installing a Performance Center Host and 
then configuring it as a load generator, you can install a standalone 
version of the load generator. This host can behave only as a load 
generator, unlike the Performance Center host, which can also be 
configured as a Controller or data processor.

Note: If you know in advance that a particular host machine is to be used 
as a load generator only, we recommend that you install the standalone 
Load Generator for the following reasons:

➤ The installation requires less disk space

➤ Moving the Load Generator’s setup files is less time consuming than 
moving the setup files of the Performance Center Host

➤ HP Virtual User Generator. HP Virtual User Generator (VuGen) generates 
virtual users, or Vusers, by recording actions that typical end-users would 
perform on your application. VuGen records your actions into automated 
Vuser scripts which form the foundation of your performance tests. 

➤ HP LoadRunner Analysis. HP Analysis provides graphs and reports with 
in-depth performance analysis information. Using these graphs and 
reports, you can pinpoint and identify the bottlenecks in your application 
and determine what changes need to be made to your system in order to 
improve its performance.

➤ MI Listener. The MI Listener is one of the components needed to run 
Vusers and monitor applications over a firewall. To install, run 
SetupMIListener.exe. For more information about firewalls in 
Performance Center, see Part IV, "Working with Firewalls."

➤ Monitor Over Firewall Agent. Used to monitor servers that are located 
over a firewall. For more information about firewalls in 
Performance Center, see Part IV, "Working with Firewalls."
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Installing Standalone Components
This section describes the installation process for standalone components.

To install any of the standalone components:

 1 Insert the HP ALM Performance Center Additional Components 
installation disk (DVD 2) and run the setup (<installation disk root 
directory>\setup.exe). The setup program displays the installation menu 
page. 

 2 Select one of the following options: 

➤ Load Generator. Installs the standalone Load Generator for Windows. 

➤ Virtual User Generator. Installs Standalone VuGen. For more details, 
see the HP LoadRunner Installation Guide.

➤ Analysis. Installs Standalone Analysis. For more details, see the HP 
LoadRunner Installation Guide.

➤ MI Listener. Installs the MI Listener component. For more details, see 
the HP LoadRunner Installation Guide.

➤ Monitor Over Firewall. Installs the Monitor Over Firewall component. 
For more details, see the HP LoadRunner Installation Guide.

 3 MI Listener/Monitor Over Firewall installations only: Follow the 
instructions in the installation wizard. After installation, the 
configuration wizard opens, requesting the name of the product you are 
working with. Select Performance Center.

Installing the Patch for Standalone Components
This section describes how to install the Performance Center patch on the 
standalone applications needed for working with Performance Center (HP 
Virtual User Generator and HP LoadRunner Analysis, Standalone Load 
Generator). 

To install the patch on standalone components:

To install the patch, on the machine where the application is installed, run 
the qfe.msp patch installation file and follow the onscreen installation and 
deployment instructions.
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Installing HP Load Generator on UNIX

This section describes how to install the HP Load Generator on UNIX.

Note: To install the HP Load Generator on UNIX silently, see "Silent 
Installation of the HP Load Generator on UNIX" on page 93.

This section includes:

➤ "UNIX System Requirements" on page 83

➤ "The Installation Process" on page 86

➤ "Installing Using the Setup Wizard" on page 87

➤ "Installing Using Native Package Commands" on page 91

➤ "Silent Installation of the HP Load Generator on UNIX" on page 93

➤ "After Installing the HP Load Generator on UNIX" on page 94

UNIX System Requirements
This section describes the system requirements necessary for installing the 
HP Load Generator on a UNIX machine.

The following table describes the memory requirements for installing the 
HP Load Generator on a UNIX machine.

Memory (RAM)

512 MB minimum

Note: Memory depends on protocol type and 
system under test and can vary greatly.

Available Hard Disk Space 400 MB minimum
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The following table describes the supported operating systems on which you 
can install a UNIX HP Load Generator. 

Notes: 

➤ If you are installing the load generator on an HP-UX operating system, 
you cannot install it from a network location. Install it directly from the 
installation disk, or copy the installer onto the local directory of the 
target machine.

➤ The HP Load Generator supports all X Servers. 

➤ For Linux platforms, you should install the updated glibc packages which 
provide security and bug fixes. For more information, refer to 
https://rhn.redhat.com.

OS Type OS Version Platform

Sun 
Solaris

➤ Solaris 9 (2.9)

➤ Solaris 10 (2.10)

Sun UltraSPARC-based systems

HP-UX ➤ HP-UX 11i (11.11)

➤ HP-UX 11iv2 (11.23)

HP PA-RISC

Red Hat 
Linux

➤ Enterprise Linux 3.0

➤ Enterprise Linux 4.0

➤ Enterprise Linux 5.0

➤ CPU Type: Intel Core, 
Pentium, AMD or 
compatible

➤ Speed: 1 GHz minimum. 2 
GHz or higher 
recommended
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HP-UX Required Patches

To run the HP Load Generator on HP-UX platforms, you must first install 
two HP patches, PHSS_17225 and PHSS_17872, which upgrade the C++ 
libraries. These patches are also available from the HP site.

 1 Log in as root user. 

 2 Copy PHSS_17225 and PHSS_17872 from the patch directory of the Load 
Generator installation to the /tmp directory. 

 3 Run sh PHSS_17225. This creates two files: PHSS_17225.text and 
PHSS_17225.ot. 

 4 Run swinstall -x matchtarget=true -s PHSS_17225.depot
After the patch installation, the system will be rebooted. 

 5 Run sh PHSS_17872. This creates two files: PHSS_17872.text and 
PHSS_17872.depot.

 6 Run swinstall -x matchtarget=true -s PHSS_17872.depot
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The Installation Process
The HP Load Generator installation on UNIX involves the following steps:

Note: If the HP Load Generator for UNIX is already installed on your system, 
you must uninstall the Load Generator before installing a patch version. For 
details, see "Uninstalling the HP Load Generator from UNIX" on page 103.

 1 Install the HP Load Generator on UNIX.

➤ You install the HP Load Generator using the HP Load Generator Setup 
wizard. The wizard runs the installation of the native package. For 
more information, see "Installing Using the Setup Wizard" on page 87.

➤ The installation files include a separate HP Load Generator native 
package for each UNIX platform. Advanced users can install the 
HP Load Generator native package directly using Native package 
commands. For example, if you are using a remote deployment tool to 
install the HP Load Generator on multiple machines, you may need to 
use native package commands. For more information, see "Installing 
Using Native Package Commands" on page 91.

➤ To install the HP Load Generator silently, see "Silent Installation of the 
HP Load Generator on UNIX" on page 93.

 2 Configure your environment.

See "After Installing the HP Load Generator on UNIX" on page 94.
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Installing Using the Setup Wizard
This section describes how to install the HP Load Generator on UNIX using 
the setup wizard. You use the same setup wizard for all UNIX platforms.

To install the HP Load Generator using the setup wizard:

 1 Ensure that you are logged in as root user.

 2 Set up a directory for load generator content - optional.

The load generator is installed in the/opt/HP/HP_LoadGenerator 
directory. To store the load generator content in another directory, before 
you install the load generator, create a symbolic link from the installation 
directory to the content directory 

 a Create the new content directory. For example, 
/usr/HP/HP_LoadGenerator:

 b Make sure that the directory /opt/HP exists. If it does not exist, create 
the directory as follows:

 c Create a symbolic link from /opt/HP/HP_LoadGenerator to the 
content directory. For example:

In the above example, the symbolic link called HP_LoadGenerator in 
the directory /opt/HP points to the directory 
/usr/HP/HP_LoadGenerator.

mkdir –p /usr/HP/HP_LoadGenerator

mkdir –p /opt/HP

ln -s /usr/HP/HP_LoadGenerator 
/opt/HP/HP_LoadGenerator
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 3 Launch the setup wizard.

Navigate to the installation package and run the following command to 
launch the setup wizard:

The setup wizard welcome screen opens.
 

Select Next.

 4 Review the License agreement.
 

To view the entire license agreement, select View agreement.

If you accept the terms of the license agreement, select Agree to continue.

<LoadGenerator UNIX installation package>/<platform>/installer.sh 
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 5 Start the installation process.

The wizard prompts you to confirm the installation.
 

The load generator is installed in the /opt/HP/HP_LoadGenerator 
directory for all platforms. 

Select Install to start the installation process. 

The wizard displays the progress of the installation.
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 6 Complete the installation.

When the installation is complete, the Finish screen opens.
 

➤ Select View Log to view the complete log of the installation process.

➤ Select Finish to complete the installation.

 7 Configure your environment.

After installing the load generator, perform the post installation steps 
described in "After Installing the HP Load Generator on UNIX" on 
page 94.
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Installing Using Native Package Commands
You can run the HP Load Generator UNIX installation using native package 
commands. The native package name for the HP Load Generator is 
LoadGenerator. 

There is a separate native package for each OS platform located in: <HP Load 
Generator installation package>/<Platform>/packages/
packages_<Platform>/<package file>. 

For example: /dev/cdrom/Solaris/packages/packages_SunOS/
LoadGenerator-11.00.000-SunOS5.10.sparc.

Note: This section contains general reference information about native 
package commands. For detailed information on the native package 
commands, refer to your relevant operating system documentation.
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To install the HP Load Generator using native package commands:

 1 Run the relevant installation command described in the following table:

 2 Run the run_after_install.sh script located in the 
/opt/HP/HP_LoadGenerator directory.

Platform Install Command
Get Package 
Information 
Command

Uninstall 
Command

Solaris

pkgadd -d  <path to package 
file> 

For example: 
pkgadd -d  
/dev/cdrom/Solaris/packages/
packages_SunOS/LoadGenerat
or-11.00.000-SunOS5.10.sparc

pkginfo 
LoadGenerator

pkgrm 
LoadGenerator

Linux

rpm --nodeps -i <path to rpm 
file>

For example: 
rpm --nodeps -i 
/dev/cdrom/Linux/packages/
packages_Linux/LoadGenerato
r-11.00.000-Linux2.6.rpm

rpm –q 
LoadGenerator

rpm -e 
LoadGenerator

HPUX

swinstall -s <path to depot 
file> <package name>

For example:
swinstall -s 
/dev/cdrom/Hp/packages/pack
ages_HPUX/LoadGenerator-
11.00.000-HPUX11.0.depot 
HP_LoadGenerator.LOADGEN
ERATOR

swlist 
HP_LoadGener
ator.LOADGEN
ERATOR

swremove 
HP_LoadGener
ator.LOADGEN
ERATOR
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Silent Installation of the HP Load Generator on UNIX
To perform a silent installation of the HP Load Generator on a UNIX 
platform, you use native package commands.

To perform a silent installation of the HP Load Generator on UNIX:

 1 Run the relevant installation command for your platform as described 
below:

 2 Run the run_after_install.sh script located in the 
/opt/HP/HP_LoadGenerator directory. 

Platform Silent Installation Command Example

Solaris

pkgadd -d <path to package 
file> -a <path to package 
admin file> all

pkgadd -d 
/dev/cdrom/Solaris/packages/pa
ckages_SunOS/LoadGenerator-
11.00.000-SunOS5.10.sparc –a 
/dev/cdrom/Solaris/sequencer/
resources/package_admin_file/
admin_file all

Linux

rpm --nodeps -i <path to rpm 
file>

rpm --nodeps -i  
/dev/cdrom/Linux/packages/pac
kages_Linux/LoadGenerator-
11.00.000-Linux2.6.rpm

HPUX

/usr/sbin/swinstall -s <absolute 
path to depot file> 
<product_name>.<package_na
me> 

Note: The product name and 
package name are case 
sensitive.

/usr/sbin/swinstall -s 
/dev/cdrom/Hp/packages/
packages_HPUX/LoadGenerator
-11.00.000-HPUX11.0.depot 
HP_LoadGenerator.LOADGENE
RATOR
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After Installing the HP Load Generator on UNIX
This section describes the configuration steps you need to complete before 
you can begin working with the HP Load Generator on UNIX. 

To complete the setup process:

 1 Set the appropriate environment variables. See "Setting Environment 
Variables" on page 94.

 2 Verify your UNIX installation. See "Verifying the HP Load Generator 
Installation on UNIX" on page 96.

 3 Check that the Controller can access the load generator. See "Checking 
Controller Connection" on page 98.

Setting Environment Variables

To work with the load generator, your UNIX startup configuration file needs 
to include specific environment variables. At the end of the load generator 
installation, the installer creates the env.csh script. 

For C Shell users, the env.csh script is used to set the appropriate 
environment variables. See "Setting Environment Variables For C Shell 
Users" on page 95. 

Bourne and Korn shell users need to set the variables manually. See "Setting 
Environment Variables For Bourne and Korn Shell Users" on page 96.
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The following environment variables need to be included:

➤ M_LROOT. The location of the HP Load Generator UNIX installation 
directory.

➤ PATH. The location of the UNIX Load Generator bin directory.

➤ LD_LIBRARY_PATH (Solaris, Linux), SHLIB_PATH (HP-UX). The location of 
UNIX Load Generator’s dynamic libraries. 

If you are running Vusers for a protocol that requires a client installation 
(for example, Oracle), make sure that the path for the client libraries is 
included in the dynamic library path environment variable 
(LD_LIBRARY_PATH or SHLIB_PATH).

To check the dynamic libraries used by your application, type:.

Setting Environment Variables For C Shell Users

At the end of the HP Load Generator UNIX installation, the installer creates 
the env.csh script. This script is used to set the appropriate environment 
variables.

To set the environment variables, you need to add the env.csh script to the 
.cshrc startup configuration file. 

To add the env.csh script to the startup configuration file:

➤ Add the following line in the .cshrc startup configuration file:

For example:

ldd application_name  /* Sun and Linux platforms */
chatr application_name /* HP platforms */

source <load generator installation directory>/env.csh

source /opt/HP/HP_LoadGenerator/env.csh
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Setting Environment Variables For Bourne and Korn Shell Users

Bourne and Korn shell users need to set the environment variables manually 
in the .profile startup configuration file. Use the following example to set up 
your environment variables:

Verifying the HP Load Generator Installation on UNIX

The installation includes a setup verification utility, verify_generator, that 
checks the load generator setup on your UNIX machine. It checks 
environment variables and your .cshrc or .profile file to verify that they are 
set up correctly. 

It is strongly recommended that you run verify_generator after an 
HP Load Generator installation before running the application. 

The verify_generator utility checks the following items: 

➤ There are at least 128 file descriptors

➤ The .rhost permissions have been defined correctly: -rw-r--r--

# Load Generator settings #
#Chooses a path based on the location of the machine dependent Load Generator 
installation

case "`uname`" in
SunOS)
M_LROOT={replace w/ load generator Solaris installation path} ; export M_LROOT
LD_LIBRARY_PATH=${M_LROOT}/bin ; export LD_LIBRARY_PATH
;;

HP-UX)
M_LROOT={replace w/ load generator HP-UX installation path} ; export M_LROOT
SHLIB_PATH={${M_LROOT}/bin ; export SHLIB_PATH
;;

Linux)
M_LROOT={replace w/ load generator Linux installation path} ; export M_LROOT
LD_LIBRARY_PATH=${M_LROOT}/bin; export LD_LIBRARY_PATH
esac

PATH=${M_LROOT}/bin:${PATH}; export PATH

# End Load Generator settings #
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➤ The host can be contacted by using rsh to the host. If not, it checks for 
the host name in .rhosts

➤ M_LROOT is defined

➤ .cshrc or .profile defines the correct M_LROOT

➤ .cshrc or .profile exists in the home directory

➤ The current user is the owner of the .cshrc or .profile

➤ An HP Load Generator UNIX installation exists in $M_LROOT

➤ The executables have executable permissions

➤ PATH contains $M_LROOT/bin, and /usr/bin

➤ The rstatd daemon exists and is running

To run the verify_generator utility:

 1 Before you run verify_generator, make sure that you have set the DISPLAY 
environment variable on your machine.

 2 From <load generator installation directory>/bin, run the following 
command:

for example:

If you want to receive detailed information about the checks, use the -
v option, as follows:

 3 View the results.

➤ If the settings are correct, verify_generator returns OK. 

➤ If they are incorrect, verify_generator returns Failed and a suggestion 
on how to correct the setup.

verify_generator

/opt/HP/HP_LoadGenerator/bin/verify_generator

verify_generator -v
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Checking Controller Connection

By default, the Controller connects remotely to the load generator using rsh 
(remote shell). You need to make sure that the load generator can be 
remotely accessed by the Controller.

If the Controller cannot connect to the load generator, contact your system 
administrator.

To make sure that the load generator can be remotely accessed by the 
Controller:

 1 On the load generator machine, go to the .rhosts file, located in the user 
home directory.

 2 In the .rhosts file, verify that the Controller is included in the list of 
machines. If it is not listed, add it to the list.

Installing Additional Components

You can install additional components that provide advanced features for 
working with Performance Center. You install these components from the 
Additional Components folder, located in the root folder of the installation 
disk. The following components are available:

➤ Agent for Citrix Server. Installs an optional component on the server 
machine that enhances VuGen’s capabilities in identifying Citrix client 
objects.

➤ Agent for Microsoft Terminal Server. Used for extended RDP protocol 
record-replay. This component runs on the server side, and is used to 
create and run enhanced RDP scripts.

➤ Assembly Crawler for Analysis API. Installs a command-line utility to 
build a .NET configuration file for a LoadRunner Analysis API application. 
For more information, refer to the Analysis API Reference.

➤ HP Diagnostics Mediator. Gathers and correlates offline transaction data 
for the ERP/CRM diagnostics modules.
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➤ HP Performance Validation SDK. Provides the tools to create a custom 
protocol for running performance tests on a previously unsupported 
application. For more information, see the HP Performance Validation SDK 
Developer’s Guide.

➤ HP SiteScope 11.00. Installs the SiteScope server used for monitoring the 
Performance Center servers and the machines containing the application 
under test. Topologies and monitor profiles also use SiteScope integration.

For installation details, see "Installing SiteScope for Performance Center" 
on page 100.

Note: 

➤ It is recommended to install SiteScope on a dedicated server. 

➤ The path to the directory where SiteScope is installed should not 
contain spaces and must end with a directory called SiteScope.

➤ IDE Add-ins. Installs a component that enables you to create and run 
scripts written in your standard development environment, in the 
application's native language. Select an add-in from the IDE Add-ins 
directory, and run the add-in’s executable file.

➤ Monitor Probe for Microsoft COM+ Server Components. Configures the 
server machine for COM+ monitoring.

➤ MQ Tester. Installs a component on the VuGen machine in order to 
generate scripts that load IBM MQ Series.

➤ SAP Tools. The following SAP tools are available:

➤ SAPGUI Spy. Helps examine the hierarchy of GUI Scripting objects on 
open windows of SAPGUI Client for Windows. To install the SAPGUI 
Spy component, copy the three files mscomctl.ocx, Msflxgrd.ocx, and 
msvbvm60.dll from the SAP_Tools\SapGuiSpy\System32VBdlls 
directory to your C:\WINNT\system32 directory, and register the files. 
To register each file, select Run from the Windows Start menu and 
type: regsvr32 <File name>. Run SapSpy.exe from the SAP_Tools 
directory.
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➤ SAPGUI Verify Scripting. Helps you verify whether the SAPGUI 
Scripting API is enabled. To install the Verify Scripting component, run 
VerifyScripting.exe from the SAP_Tools\VerifySAPGUI directory.

➤ Verify RFC User. Determines whether the SAP user you specified to 
connect to the SAP system has permissions to invoke the required RFC 
functions necessary for working with SAP Diagnostics. To install the 
Verify RFC User component, copy RFCFunctionsCollection.dll from the 
Verify RFC User directory to your local hard drive. Then register the file 
by selecting Run from the Windows Start menu and typing: regsvr32 
RFCFunctionsCollection.dll. In the Verify RFC User directory, load 
AddMTSDestinationsFolder.reg by double-clicking the file. Then run 
VerifyRFCUser.exe.

➤ Snapshot Viewer. The Snapshot Viewer enables you to view snapshot-on-
error pages captured from Web Vusers during performance test runs. The 
viewer displays snapshots from files with .SOE and .INF extensions. A 
Snapshot on Error (.SOE) file is a zipped file containing one or more 
snapshots in .INF format. To install, run 
\Applications\SetupSnapshotViewer.exe. 

➤ WinPcap. Installs the WinPcap utility. WinPcap allows the user to capture 
network traffic into a file for later analysis. WinPcap is used in the Server 
Side Recording feature in the VuGen Web Services protocol. For more 
information about WinPcap, see http://www.winpcap.org/.

Installing SiteScope for Performance Center
This section describes how to install SiteScope 11 for Performance Center to 
enable the integration of Topology with SiteScope.

To install SiteScope 11 for Performance Center:

 1 Insert the HP ALM Performance Center Additional Components 
installation disk (DVD 2) and run the setup (<installation disk root 
directory>\setup.exe). On the installation menu page, click the 
Additional Components link, and from the HP SiteScope 11.00 folder, 
run HPSiteScope_11.00_setup.exe.

 2 During installation, select HP SiteScope for Load Testing.

 3 If the latest version of Java is not installed on the client machine, install it 
from Java’s Website (www.java.com).

http://www.winpcap.org
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 4 After installation, start SiteScope. 

 5 Set a SiteScope Administrator user credentials: 

 a In User Management Preferences, double-click SiteScope 
Administrator.

 b Enter the user name and password, for example, admin\admin.

 c Click OK.

 6 In SiteScope, enter the Performance Center LW-SSO init-string as follows:

 a In General Preferences, expand the Security Panel.

 b Enter the ALM Communication Security passphrase (SSO init string). 
By default, this value is This value should be replaced. 

 c Click Save.

 7 Restart SiteScope: In Infrastructure Preferences, click Restart SiteScope.

Repairing the Performance Center Installation

If you have errors in your original Performance Center installation, such as 
missing or corrupt files, shortcuts and registry entries, you can repair them 
using the Performance Center Setup Wizard. 

To repair your Performance Center installation:

 1 Insert the Performance Center installation disk into your disk drive.

 2 From the Windows Control Panel, open the Add/Remove Programs dialog 
box.

 3 Select HP Performance Center <component> from the list of currently 
installed programs and click Change. The Performance Center Setup 
Wizard opens, displaying the Welcome page. Click Next.

 4 On the Maintenance Type page that opens, select Repair. 

Click Next and follow the instructions in the wizard to complete the 
repair process.
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Uninstalling Performance Center Components

This section describes how to uninstall Performance Center components 
from Windows and UNIX machines.

Uninstalling the Performance Center Server and Hosts
You can uninstall Performance Center servers and hosts using the 
Performance Center Setup Wizard or using the silent commands.

To uninstall Performance Center components using the setup wizard:

 1 From the Windows Control Panel, open the Add/Remove Programs dialog 
box.

 2 From the list of currently installed programs, select HP 
Performance Center and click Remove. 

 3 Follow the instructions in the wizard to complete the uninstall process.

To uninstall Performance Center components silently:

➤ Run the applicable command from the command line.

➤ Performance Center Server:

➤ Performance Center Host:

msiexec /uninstall 
“<Installation_Disk_Root_Directory>\Setup\Install\Server\HP_PCS.msi” /qnb

msiexec /uninstall 
“<Installation_Disk_Root_Directory>\Setup\Install\Host\HP_LTS.msi” /qnb
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Uninstalling the HP Load Generator from UNIX
You can uninstall the HP Load Generator from the UNIX machine using the 
Maintenance wizard. 

Note: You can also uninstall the HP Load Generator using native package 
commands as described in "Installing Using Native Package Commands" on 
page 91. 

To uninstall the HP Load Generator using the Maintenance wizard:

 1 Make sure that you are logged in as root user.

 2 Make sure that the load generator is not connected to any Controller 
machine.

 3 Make sure that the m_agent_daemon process is not running on your 
machine.

 4 Launch the maintenance wizard by running the following command:

 5 Follow the instructions in the wizard to uninstall the HP Load Generator.

/var/opt/HP/iHP/HP_LoadGenerator/11.00.000/installer.sh
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3
Post Installation Verification

This section describes how to verify that the installation of the 
Performance Center Server and hosts was successful. The environment for 
this process should be a staging environment, including a 
Performance Center Server and two to three Performance Center hosts.

Note: You can run a full validation on your ALM-Performance Center 
system from Lab Management, in the System Health module’s System Check 
tab. For more details, see the HP ALM Performance Center Guide.

This chapter includes:

➤ Administrator Workflow on page 105

➤ Performance Tester Workflow on page 109

Administrator Workflow

This section describes the workflow for the Performance Center 
administrator.

 1 Log on to Site Administration.

 a Open the Web browser and type the ALM URL
http://<ALM platform server>[<:port number>]/qcbin.

The ALM Options window opens.

 b Click Site Administration, enter the user name and password of a Site 
Administrator, and click Login. 
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 2 Create a project administrator user.

 a In Site Administration, select the Site Users tab and click New User. 
The New User dialog box opens.

 b Enter the details of the project administrator user, and click OK.

 c Select the user, click Password, enter the password, and click OK.

 3 Create a domain.

 a In Site Administration, select the Site Projects tab and click Create 
Domain. The Create Domain dialog box opens.

 b Enter a name for the new domain, and click OK. 

 4 Create a new project.

In the Site Projects tab, select the domain you just created, and click 
Create Project. Follow the steps to create the project. When prompted:

 a Add the project administrator user you created above to the Selected 
Project Administrators list.

 b HP ALM (consolidated license): Select Performance Center Project 
Extension.

 5 Assign more project administrators to the project - optional.

 a Click the Site Projects tab.

 b In the Projects list on the left, select the project you created.

 c In the right pane, click the Project Users tab.

 d Add another user, and select Project Administrator. 

 6 Log on to Lab Management. 

 a Open the Web browser and type the ALM URL
http://<ALM platform server>[<:port number>]/qcbin.

The ALM Options window opens.

 b Click Lab Management, enter the user name and password of a Site 
Administrator, and click Login. 
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 7 Verify initial Performance Center configuration.

If you defined the Performance Center Server and license information 
during the post-installation configuration, verify that this information is 
defined in Lab Management.

On the Lab Management sidebar: 

➤ Select PC Servers and verify that the Performance Center Server is 
listed.

➤ Select License and verify that the Performance Center license and Host 
license are displayed.

If you did not perform the post-installation configuration, perform it 
now. For details, see "Initial Performance Center Manual Configuration" 
on page 67. 

 8 Define additional hosts for the staging environment.

For the staging environment, you should have two to three 
Performance Center hosts, where at least one host purpose is configured 
as Controller, and at least one host purpose is configured as 
Load Generator.

Note: When adding hosts, fields in red marked with an asterisk (*) are 
mandatory. Make sure to include the operating system type, and the 
purpose of the host. For more details, see the HP ALM Performance Center 
Guide.

 a In Lab Management, under Lab Resources, select Hosts.

 b Click the New Hosts button. The New Host dialog box opens, enabling 
you to define the host details. 
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 9 Create host pools.

 a In Lab Management, under Lab Resources, select Host Pools.

 b Click the New Host Pool button. The New Host Pool dialog box opens, 
enabling you to define a new host pool. 

 c In the Host Pools module, right-click the new host pool and select 
Host Pools Details. 

 d In the Host Pool Details dialog box, select Linked Hosts, and click the 
Add Hosts to Pool button. 

 e In the Add Hosts to Pools dialog box, select the hosts to add to the 
pool, and click Add. The hosts are added to the pool.

 10 Define project settings.

 a In Lab Management, under Lab Settings, select Project Settings.

 b Right-click the project and select Project Settings Details. In the 
Project Settings Details dialog box, define the project’s settings. In 
particular, set the Vuser limit, Host limit, and Concurrent run limit. 
Also, select the host pool you created above for the project.
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Performance Tester Workflow

This section describes the workflow for the Performance Center tester. 

 1 Log on to a Performance Center project.

Log on to the project you created in the administration workflow with 
the user credentials you created.

 2 Create a monitor profile. 

Note: The monitor profile is selected for a performance test when you 
design the test.

 a On the ALM sidebar, under Testing, select Test Resources. 

 b Click the New Resources Folder button and specify a name for the 
folder. 

 c In the tree, right-click the new folder, and select New Resource. 

 d In the New Resource dialog box, in the Type box, select Monitor 
Profile, and give the profile a name. 

 e In the tree, select the new monitor profile, and in the right pane, click 
the Monitors Configuration tab.

 f Click the Add Monitor button. 

 g In the Add New Monitors dialog box, select the monitor that you want 
to add to the profile. The relevant Edit Monitor dialog box opens.

 h Enter the details of the server to be monitored, and select the counters 
that you want to monitor.
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 3 Create a topology.

Note: The topology is selected for a performance test when you design the 
test.

You can create a topology that graphically displays the logical 
components that make up the application under test (AUT) and the 
relationships between the components.

This provides a useful method for managing your inventory of AUT hosts 
and enables topology-oriented monitoring and analysis.

 a On the ALM sidebar, under Lab Resources, select Topologies. 

 b Click the New Topology button. The New Topology dialog box opens.

 c Enter the topology details. If you want to add SiteScope monitors to 
the topology, specify the SiteScope server details. Click OK. The 
Topology Designer window opens.

 d (Optional) Define your AUT hosts. For each host, click the New AUT 
Host button on the toolbar, and enter the AUT host’s details. These 
hosts are automatically added to your project’s AUT host pool. 

Note: An AUT host pool is created automatically as soon as you add an 
AUT host.

 e From the palette on the left, select relevant server/component nodes 
for your topology, and drag them onto the Topology canvas.

 f To connect two nodes, click one node and drag the mouse to another 
node.

 g (Optional) For each node, select the node and enter the relevant 
properties in the Properties pane in the top-right corner of the 
Topology Designer. 
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 h To configure a SiteScope monitor on a node, select the node and click 
the Configure Monitors button. The Configure Monitors dialog box 
opens. 

 i Create a new SiteScope monitor: Define the monitor type, the instance 
(where necessary), and the data collection interval. 

Note: If an AUT host is assigned to the node, it is passed to SiteScope as 
a remote host and inserted as a default monitored server for all 
monitors created on the node.

 j Click Save and Close to save the topology. 

 4 Create a performance test.

You create performance tests in the Test Plan module.

 a On the ALM sidebar, under Testing, select Test Plan.

 b Click the New Folder button, and specify a name for the folder.

 c In the tree, right-click the new folder and select New Test. 

 d In the New Test dialog box, in the Type box, select Performance Test, 
and enter a name for the test. 

 5 Upload Vuser scripts.

You can upload Vuser scripts either directly from VuGen or from within 
the Test Plan module.

Note: 

➤ You select scripts for a performance test when you design the test.

➤ When uploading a script in the Test Plan module, the script must be 
zipped and must be saved locally.
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To upload scripts in the Test Plan module:

 a On the ALM sidebar, under Testing, select Test Plan module. 

 b Click the Upload Script button. 

 c In the Upload VuGen Scripts dialog box, in the Select Folder box, 
select the folder you created in step 4 above as the location to save the 
script. 

 d In the Select Scripts fields, click Browse to navigate to the location of 
the scripts. You can upload five scripts at a time.

 e Click Upload.

 6 Design the performance test.

The following steps guide you through designing a performance test with 
a basic workload, using default settings. Some options and steps may vary 
if you change any of the default settings.

 a Open the Performance Test Designer. 

On the ALM sidebar, under Testing, select Test Plan. In the tree, right-
click the test that you created above, and select Edit Test. The 
Performance Test Designer window opens, displaying the Workload 
tab.

 b Select a workload. 

In the Workload Types dialog box, select the default workload type: 
Basic Schedule, by test, by number.

 c Assign a Controller.

By default, a dedicated Automatch Controller is selected. 

Note: A dedicated Automatch Controller functions as a Controller 
only, and cannot perform the functions associated with other hosts, 
such as load generators or data processors. 
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 d Add Vuser scripts.

Click the Select Scripts button. The scripts you uploaded are displayed 
in the Scripts Tree in the right pane. Select scripts for the test, and click 
the left arrow button to add them to the test. A Vuser group is created 
for each script, with a default of 10 Vusers.

 e Distribute load generators among the Vuser groups.

In the LG Distribution box, keep the default selection, Assign all to 
each group, and in the LG box, enter the desired number of 
load generators to be assigned to each group—enter 1.

 f Define a test schedule.

In the Scheduler pane, keep the default scheduler actions or modify 
them as desired. The available scheduler actions are:

➤ Initialize. Instructs the Scheduler to prepare the Vusers so that they 
are ready to run.

➤ Start Vusers. Instructs the Scheduler to start running the Vusers.

➤ Duration. Instructs the Scheduler to continue running the current 
action for the specified amount of time.

➤ Stop Vusers. Instructs the Scheduler to stop the running Vusers.

Tip: The schedule graph on the right of the Scheduler pane provides a 
graphical representation of the schedule actions defined in the Actions 
grid.

 g Select monitor profiles.

Click the Monitors tab and click Add Monitor Profile. The defined 
monitor profiles are displayed in the Monitor Profiles Tree in the right 
pane. Select monitor profiles for the test, and click the left arrow 
button to add them to the Monitor Profiles grid.
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 h Select a topology.

Click the Topology tab and click Select Topology. The topology you 
created earlier appears in the Topologies Tree in the right pane. Select 
the topology, and click the left arrow button to select it for the test.

 i Save the test.

When you are finished designing the test, click Save. A message is 
displayed in the bottom-left corner of the Performance Test Designer 
window. Verify that the test was saved without errors and is valid. 

 7 Add the test to a test set.

 a On the ALM sidebar, under Testing, select Test Lab.

 b Click the New Folder button. Specify a name for the folder.

 c In the tree, right-click the new folder, and select New Test Set. The 
New Test Set dialog box opens.

 d Enter a name for the test set, and in the Type box, select Performance.

 e In the tree, select the new test set, and in the right pane, click the 
Execution Grid tab.

 f Click Select Tests. The performance tests defined in the Test Plan 
module are displayed on the right, under the Test Plan Tree tab. Select 
the desired test and drag it to the execution grid.

 8 Reserve a timeslot for the test.

Decide on a time in the future to run the test, and reserve a timeslot to 
ensure that the required resources are available.

 a Under Lab Resources, select Timeslots.

 b In the Timeslots module calendar view, click the New Timeslot button. 
The Timeslot Reservation dialog box opens.

 c Define the following information:

➤ Name. Enter a name for the timeslot.

➤ Start Time. Enter a start time for the timeslot.

➤ Duration. Set the duration for the performance test.
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➤ Test. Navigate to the test set you created above, and link the test 
instance to the timeslot. The number of Vusers and the hosts 
(Controller and load generators) defined in the test are displayed 
under Vusers and Requested Hosts respectively.

➤ Vusers. You can reserve more Vusers in addition to those defined for 
the test.

 d To set the test to start running at the beginning of the timeslot, select 
Autostart. 

 e (Optional) Click Add Automatch LGs or Add Specific LGs to reserve 
additional load generators for the timeslot. There must be a Controller 
and at least one load generator requested for the timeslot.

 f Click Calculate Availability. ALM calculates the availability of the 
requested resources during the selected timeslot. The result of this 
calculation is displayed in the Timeslot Status tab, as well as 
graphically on the time chart.

If the timeslot can not be reserved, reselect your resources taking into 
account the reasons displayed in the Timeslot Status tab. 

 g If the requested resources are available, click Submit to save the 
timeslot.

 9 Run the test.

 a Under Testing, select Test Plan.

 b Right-click the test in the tree, and select Run Test. The Select Timeslot 
dialog box opens, displaying available timeslots for running the test, 
including the timeslot you created above. 

Note: If no timeslot was reserved in the Timeslots module, the Select 
Timeslot dialog box can be used to create one.

 c Select a timeslot in the grid and click Run.
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Note: Running a test directly from the Test Plan module should only 
be used as a shortcut option, and not as a complete test execution 
method. The Test Lab module is specifically designed to manage test 
execution, and it is recommended to always first add the test to a test 
set before considering using the shortcut provided. The main purpose 
of the shortcut is to enable running previously designed tests without 
having to return each time to the Test Lab module.

 10 Track existing performance test runs.

Under Testing, select Test Lab, and click the Test Runs tab. In this tab, you 
can track the state of existing test runs, as well as perform other post-run 
actions, such as collate, analyze, recalculate the SLA, and generate and 
view HTML reports.
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4
Performance Center Configuration 
Options

The Performance Center system comes with default configuration settings. 
These settings enable you to use Performance Center for its intended 
purpose. This chapter describes additional tuning and configuration to help 
you get the most out of your Performance Center system. 

Note: Not all the procedures in this chapter are suitable for all usage 
scenarios. You should assess which procedures are suitable to your system’s 
needs.

This chapter includes:

➤ Configuring Host Security Settings on page 118

➤ Windows XP Professional Configuration on page 119

➤ Configuring IIS on Performance Center Machines to Use SSL on page 120

➤ Working with Performance Center Agent on page 127

➤ HP Load Generator (UNIX) Configuration on page 129

➤ Establishing Connectivity with Oracle on page 135

➤ Enabling Downloading Standalone Applications on page 136

➤ Enabling MS-SQL Windows Authentication on page 138
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Configuring Host Security Settings

The need to secure communication channels from hackers attacking the 
corporate networks is critical. The ability to secure communication channels 
ensures confidentiality, integrity, and the user's authenticity within the 
scope of the testing application. 

Secure communication is established between Performance Center hosts 
using a security key. This security key must be defined on each host. Then, 
as long there is one host with security enforced, secure channels can be 
established between that host and other hosts.

You configure initial security settings locally on the host using the Host 
Security Setup utility. To run this utility, on the host machine select Start > 
Program Files > Performance Center Host > Tools > Host Security Setup. 

Another utility, the Host Security Manager, which is installed on the 
Performance Center Server machine, can be used to remotely and 
simultaneously update security settings on all the hosts. You can use the 
Host Security Manager to:

➤ Update the security key of all the hosts is the system simultaneously

➤ Change the mode of security on selected hosts. That is, you can enforce 
selected hosts to communicate over secure channels, or allow selected 
hosts to communicate over non-secure channels.

Note: Initial security settings must be set locally on each host using the Host 
Security Setup utility. After that, the Host Security Manager utility can be 
used to update security settings on all of the hosts.

For more information about configuring secure host communication, see 
the HP ALM Performance Center Guide.
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Windows XP Professional Configuration

If you are running Windows XP, the Windows Firewall is turned on by 
default. The firewall does not allow Performance Center components to 
function as designed and must be turned off on all host machines on which 
the upload/download features are used.

Note: Turning off the Windows Firewall increases the risk to your 
computer's security. 

To turn off the Windows Firewall: 

 1 Select Start > Settings > Control Panel > Security Center (not in Advanced 
look of Control Panel).

 2 Click Windows Firewall.

 3 In the General tab select Off.

For each process that needs the firewall, you can unblock the process by:

➤ clicking the unblock button in the popup window that indicates that 
the program needs it

➤ tuning the Windows Firewall manually from the Exceptions tab
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Configuring IIS on Performance Center Machines to Use SSL

IIS (Microsoft Internet Information Server) is a prerequisite software for the 
Performance Center Servers. You can configure the IIS Performance Center 
virtual directories (PCS and LoadTest) to use SSL (Secure Socket Layer).

This section describes how to configure IIS Performance Center virtual 
directories to use SSL.

Before You Configure IIS
IIS uses port 443 to work over SSL. However, certain Performance Center 
components may also be configured to use this port. Therefore, you need to 
ensure that port 443 is available to be used by IIS and configure these 
Performance Center components to use a port other than 443.

Note: The Remote Management agent may be configured to use port 443.

Changing the Port on the Remote Management Agent

On all Performance Center Server machines, you need to change the port 
being used by the Remote Management agent for over firewall 
communication.

To change the port on the Remote Management agent:

 1 On the Performance Center Server machine, open <Performance Center 
Server installation directory>\al_agent\dat\mdrv.dat in a text editor.

 2 In the [launcher] section add the following line:

where <port_number> is the port you want to open. Enter a number 
other than 443. 

 3 In the same directory, open the file channel_configure.dat in a text editor.

OFWPort=<port_number>
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 4 In the [General] section add the following line:

where <port_number> is the port you want to open. Enter the same 
number that you entered in step 2.

 5 Restart the Remote Management agent service for the configuration 
changes to take effect. To restart the service, select Start > Run and type 
services.msc. The Services dialog box opens. Locate the service 
RemoteManagement Agent Service and restart it.

Configuring IIS to Work Over SSL
This section describes the basic steps involved in setting up IIS on the 
Performance Center Server machine to use SSL. 

To configure IIS to use SSL on the Performance Center Server machine:

 1 Create the SSL certificate.

 2 Install the certificate you created onto the relevant machine that you are 
configuring for SSL.

 3 Install the certificate on the Performance Center Server that needs to 
communicate with the relevant machine that you are configuring for SSL.

The certificate should appear in the Microsoft Management Console 
under Certificates (Local Computer) > Trusted Root Certification.

Note: For more information about how to configure IIS with SSL, see 
http://support.microsoft.com/

OFWPort=<port_number>

http://support.microsoft.com/
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Configure IIS to Support Internal Communication
The following steps must be performed to enable secure internal 
communication on the Performance Center Server and Hosts.

To support internal communication on the Performance Center Server:

 1 Configure IIS to support SSL on port 443 as described above.

 2 Edit the web.config file located in the following path: <install path>\PCS

 a Under the <system.servicemodel><services> tag, there are six areas 
where the following comment appears: Uncomment to enable SSL. 
Uncomment the XML lines which appear thereafter. For example:

Before:

After:

 b Under the <system.servicemodel><behaviors> tag, there are six areas 
where the httpsGetEnabled parameter is set to false. Change each one 
so that the parameter is set to true. For example:

Before:

After:

 <!- Uncomment to enable SSL ->
<!-- endpoint binding="basicHttpBinding" 
bindingConfiguration="BasicHttpBinding_TransportSecurity" 
contract="HP.PC.PCS.ILabService">
<identity><dns value="localhost"/></identity>
</endpoint -->

<!-- Uncomment to enable SSL -->
<endpoint binding="basicHttpBinding" 
bindingConfiguration="BasicHttpBinding_TransportSecurity" 
contract="HP.PC.PCS.ILabService">
<identity><dns value="localhost"/></identity>
</endpoint>

<serviceMetadata httpGetEnabled="true" httpsGetEnabled="false" />

<serviceMetadata httpGetEnabled="true" httpsGetEnabled="true" />
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 3 Add the Performance Center Server to ALM and define the Internal URL 
to connect through port 443. The URL must begin with https.

To support internal communication on a host:

 1 Configure SSL on the host for port 8731. For details, refer to the Microsoft 
Web Site: How To Configure a Port with an SSL Certificate, using the 
following URL: http://msdn.microsoft.com/en-us/library/ms733791.aspx.

 2 Edit the LtopSvc.exe.config file located in the following path: <install 
path>\bin

 a Under the <system.servicemodel><bindings><basicHttpBinding> tag, 
there are two areas where the following comment appears: 
Uncomment to enable SSL. Uncomment the XML lines which appear 
thereafter. For example:

Before:

<binding name="BasicHttpBinding_ILoadTestingService" 
closeTimeout="00:10:00"
             openTimeout="00:01:00" receiveTimeout="00:20:00" 
sendTimeout="00:10:00"
             allowCookies="false" bypassProxyOnLocal="false" 
hostNameComparisonMode="StrongWildcard"
             maxBufferSize="2147483647" maxBufferPoolSize="2147483647" 
maxReceivedMessageSize="2147483647"
             messageEncoding="Text" textEncoding="utf-8" transferMode="Buffered"
             useDefaultWebProxy="true">
          <readerQuotas maxDepth="2147483647" 
maxStringContentLength="2147483647" maxArrayLength="2147483647"
          maxBytesPerRead="2147483647" 
maxNameTableCharCount="2147483647" />
          <!-- Uncomment to enable SSL -->
          <!--<security mode="Transport">
            <transport clientCredentialType="None"/>
          </security>-->
        </binding>
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After:

<binding name="BasicHttpBinding_ILoadTestingService" 
closeTimeout="00:10:00"
             openTimeout="00:01:00" receiveTimeout="00:20:00" 
sendTimeout="00:10:00"
             allowCookies="false" bypassProxyOnLocal="false" 
hostNameComparisonMode="StrongWildcard"
             maxBufferSize="2147483647" maxBufferPoolSize="2147483647" 
maxReceivedMessageSize="2147483647"
             messageEncoding="Text" textEncoding="utf-8" transferMode="Buffered"
             useDefaultWebProxy="true">
          <readerQuotas maxDepth="2147483647" 
maxStringContentLength="2147483647" maxArrayLength="2147483647"
          maxBytesPerRead="2147483647" 
maxNameTableCharCount="2147483647" />
          <!-- Uncomment to enable SSL -->
          <security mode="Transport">
            <transport clientCredentialType="None"/>
          </security>
        </binding>
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 b Under the <system.servicemodel><services> tag, switch between the 
non-secured and secured endpoints and base addresses. For example:

Before:

<endpoint contract="HP.PC.LTOP.Services.ILoadTestingService" 
address="LoadTestingService" name="basicHttp" binding="basicHttpBinding" 
bindingConfiguration="BasicHttpBinding_ILoadTestingService"/>

        <!-- Use the first endpoint for regular communication and the second 
endpoint for SSL -->
        <endpoint contract="IMetadataExchange" binding="mexHttpBinding" 
name="mex" />
        <!--<endpoint contract="IMetadataExchange" binding="mexHttpsBinding" 
name="mex" />-->

        <host>
          <baseAddresses>
            <!-- Use the first address for regular communication and the second 
address for SSL -->
            <add baseAddress="http://localhost:8731/LTOP/LoadTestingService"/>
            <!--<add 
baseAddress="https://localhost:8731/LTOP/LoadTestingService"/>-->
          </baseAddresses>
        </host>
      </service>
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After:

 c Under the 
<system.servicemodel><behaviors><serviceBehaviors><behaviorname
=”CommonBasicHTTPBehavior”> tag, change the httpGetEnabled 
parameter to false, and the httpsGetEnabled parameter to true. For 
example:

Before:

After:

 3 Restart Windows on the host.

<service name="HP.PC.LTOP.Services.LoadTestingService" 
behaviorConfiguration="CommonBasicHTTPBehavior">
        <endpoint contract="HP.PC.LTOP.Services.ILoadTestingService" 
address="LoadTestingService" name="basicHttp" binding="basicHttpBinding" 
bindingConfiguration="BasicHttpBinding_ILoadTestingService"/>

        <!-- Use the first endpoint for regular communication and the second 
endpoint for SSL -->
        <!-- <endpoint contract="IMetadataExchange" binding="mexHttpBinding" 
name="mex" />-->
        <endpoint contract="IMetadataExchange" binding="mexHttpsBinding" 
name="mex" />

        <host>
          <baseAddresses>
            <!-- Use the first address for regular communication and the second 
address for SSL -->
            <!--<add 
baseAddress="http://localhost:8731/LTOP/LoadTestingService"/>-->
            <add baseAddress="https://localhost:8731/LTOP/LoadTestingService"/>
          </baseAddresses>
        </host>
      </service>

<serviceMetadata httpGetEnabled="true" httpsGetEnabled="false" />

<serviceMetadata httpGetEnabled="false" httpsGetEnabled="true" />
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 4 On the Performance Center Server, edit the PCS.config file, located in the 
<install path>\dat path, as follows: Change the value of the ItopIsSecured 
parameter to true. For example:

Before:

After:

 5 Restart IIS on the Performance Center Server.

Working with Performance Center Agent

The Performance Center Agent runs on the load generators and enables 
communication between the Controller, load generators, and MI Listeners 
(in over-firewall configurations). The agent receives instructions from the 
Controller to initialize, run, pause, and stop Vusers. At the same time, the 
agent also relays data on the status of the Vusers back to the Controller. 

To check the agent’s current configuration, move your mouse over the 
Agent’s icon in the Task Bar area, and read the description. The description 
will display either Performance Center Agent Service or 
Performance Center Agent Process.

Running the Performance Center Agent as a Process
In some cases, such as SAPGUI replay, running GUI Vusers on remote 
machines, or terminal sessions, the Performance Center Agent must run as a 
process.

To change the Performance Center Agent from a service to a process:

➤ On the host machine, select Start > Programs > HP Performance Center 
Host > Advanced Settings > Performance Center Runtime Settings 
Configuration, and select Manual log in to this machine.

<PCSSettings ltopPortNumber="8731" ltopIsSecured="false" 
StartRunMaxRetry="3" DataProcessorPendingTimeoutMinutes="2880"/>

<PCSSettings ltopPortNumber="8731" ltopIsSecured="true" 
StartRunMaxRetry="3" DataProcessorPendingTimeoutMinutes="2880"/>
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Running the Performance Center Agent as a Service
In most cases, the Performance Center Agent runs as a service.

To change the Performance Center Agent from a process to a service:

➤ On the host machine, select Start > Programs > HP Performance Center 
Host > Advanced Settings > Performance Center Runtime Settings 
Configuration, and select Allow virtual users to run on this machine 
without user login, and enter a valid user name and password.

Configuring the Agent on Load Generator Machines
When working with protocols that use network files or Web protocol Vusers 
that access the Internet through a proxy server, the Load Generator agent 
must have network privileges. Note that the default user created by 
Performance Center, IUSR_METRO, does not have network privileges. 

By default, the agent runs as a service on the load generator machines. You 
can either run the agent as a process or you can continue running the agent 
as a service. To continue running it as a service, configure it to run the 
session using the local system account or another user account with 
network access privileges.

Running SAPGUI Vusers
To run SAPGUI Vusers on a remote host, make sure of the following:

➤ The Performance Center agent is configured to run as a process (as 
described in "Running the Performance Center Agent as a Process" on 
page 127).

➤ A user with administrative privileges is logged on to the host machine 
during run-time. 

Mapping Network Drives when Running Agent as Service
For all Windows platforms, when the user is logged off, the service cannot 
resolve the mapping of network drives. For Windows XP, the service also 
cannot resolve the mapping of network drives when the user is logged on. 

In cases when the service cannot work with mapped network drives, use the 
full path to the directory, for example, <\\<machine-name>\<directory>\>.
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HP Load Generator (UNIX) Configuration

You can increase the number of file descriptors, process entries, and amount 
of swap space by configuring the kernel, as described in this section.

Note: Most operating systems using the UNIX load generator have sufficient 
default file descriptors, process entries, and swap space, and rarely require 
reconfiguration.

This section includes recommendations for improving load generator 
performance. This section includes:

➤ "Increasing Process Entries" on page 129

➤ "Increasing File Descriptors" on page 131

➤ "Increasing Swap Space" on page 134

Increasing Process Entries 
Each Vuser requires several free process entries. To increase the number of 
process entries on your system, you must reconfigure the kernel. 

Solaris

This section describes how to reconfigure the kernel for Solaris operating 
systems.

To reconfigure the kernel for Solaris operating systems:

 1 Locate the /etc/system file.

 2 Set the maximum number of processes in the system file. Type:

set max_nprocs=number (e.g.712)
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 3 Execute the touch/reconfigure command. Type:

 4 Reboot the machine. 

HP-UX

This section describes how to reconfigure the kernel for HP platforms.

To reconfigure the kernel for HP platforms:

 1 Log in as root.

 2 Invoke the sam tool to reconfigure the kernel. Type:

 3 Select Kernel Configuration > Configurable Parameters. 

 4 Set the following parameters to the desired values:

➤ nproc: The number of simultaneous processes—(# of Vusers * 2) + 200

➤ maxuser: The number of maximum users—DB + RTE Vusers + 20

➤ maxuprc: The number of processes per user—# of Vusers * 2

 5 Reboot the machine.

Linux

This section describes how to reconfigure the kernel for Linux platforms.

To reconfigure the kernel for Linux platforms:

 1 Locate the /etc/security/limits.conf file.

 2 Set the maximum number of processes in the limits file. Type:

 3 Reboot the machine.

touch /reconfigure

sam &

hard nproc 8192
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Increasing File Descriptors
A load generator uses the following File Descriptor resources:

➤ 14 file descriptors for the launch service

➤ 20 file descriptors for the agent

➤ 30 file descriptors for each Vuser driver. By default, there is a driver for 
every 50 Vusers.

For example, to compute the number of file descriptors used in running 100 
threaded Vusers, the load generator requires:

Total: 294 File Descriptors

If Vusers are run as processes instead of threads, one driver is run per Vuser. 
Therefore, each Vuser requires 30 file descriptors.

The procedure to increase the number of file descriptors differs between 
platforms and shells. 

All Platforms

In these examples, the number of descriptors is increased to the maximum 
of 1024.

➤ For sh and ksh users, type:

➤ For csh users type:

14 for the launcher

20 for the agent

60 for 2 drivers (30 x 2, each one drives 50 Vusers)

200 for 100 Vusers (each Vuser requires 2)

ulimit -n 1024

limit descriptors 1024
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Solaris

This section describes some alternate procedures to increase file descriptors 
on Solaris operating systems. In these examples, the number of descriptors is 
increased to the maximum of 1024. 

 1 Use the adb command to increase file descriptors (all shells). Note that 
400 HEX is the equivalent to decimal 1024. In the following example, 
kernel is the name of the kernel file, e.g., kernel/unix.

 2 You can also increase the maximum number of file processes by 
reconfiguring the kernel. 

Log in as root and set the rlim_fd_max parameter inside the /etc/system 
file by typing:

 3 Save the file and reconfigure the system by typing:

 4 After reconfiguring the system, reboot the machine.

adb -w -k /kernel/dev/mem
rlimits+28?W 400
rlimits+28/W 400

set rlim_fd_max=1024

touch /reconfigure
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HP-UX

This section describes how to increase file descriptors for HP platforms.

To increase file descriptors for HP platforms:

 1 Log in as root.

 2 Invoke the sam tool to reconfigure the kernel. Type:

 3 Select Kernel Configuration > Configurable Parameters. 

 4 Set the maxfiles parameters to the desired values. This is the equivalent to 
file descriptors on Sun platforms. 

➤ maxfiles: The number of files open at a given time, typically set to 60. 
Change it to 500 - 1024. 

 5 Reboot the machine.

Linux

This section describes some alternate procedures to increase file descriptors 
on Linux operating systems. In these examples, the number of descriptors is 
increased to the maximum of 8192. 

To increase file descriptors on Linux operating systems:

 1 Add the following line to the /etc/security/limits.conf file:

 2 Add the following line to the /etc/sysctl.comf file:

 3 Reboot the machine.

sam &

hard nfile 8192

fs.file-max = 8192



Chapter 4 • Performance Center Configuration Options

134

Increasing Swap Space
Each Vuser requires swap space ranging from 200 KB to 4 MB. Before adding 
space to your system configuration, you should determine your paging 
requirements. For environments running programs with very large memory 
requirements, it is recommended to have paging space of four times the 
physical memory. If you do not have enough paging space, certain processes 
may be killed, and others will be unable to start.

Solaris

This section describes how to increase swap space for machines running 
Solaris.

To increase swap space for machines running Solaris:

 1 List the available paging areas. Type:

 2 Display the available swap space. Type: 

 3 Create a new paging file. Type:

 4 Add the page file to the existing configuration. Type:

 5 Enable all swap areas listed in the filesystem configuration. Type:

swap -l

swap -s

mkfile size  path (e.g. mkfile 50m /extra/page_1)

/usr/etc/swapon -a /extra/page_1 0 102400

/usr/etc/swapon -a 
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Establishing Connectivity with Oracle

When working with Oracle, ensure that the Oracle client is installed on the 
same machine as the Performance Center Server and that connectivity is 
established with the Oracle Server. 

The tnsnames.ora file located on the Performance Center Server 
(..\oracle\product\10.2.0\client_1\NETWORK\ADMIN\tnsnames.ora) 
must contain a TNS entry for the source and target database servers. This 
entry can be copied from the tnsnames.ora file on the Oracle server to the 
Oracle client machine. 

For example, for the Oracle database instance, ALMInst, the tnsnames.ora 
file, should contain the following entry:

To test that the TNS name entry is properly configured:

 1 On the Performance Center Server machine, open a command prompt.

 2 Type:

where <instancename> is the name of the current instance. 

 3 Verify that you are successfully connected to the Oracle server.

ALMInst =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = TCP)(HOST = <db_host>)(PORT = 1521))
    )
    (CONNECT_DATA =
      (SERVICE_NAME = ALMInst)
    )
  )t

sqlplus system/manager@<instancename>
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Enabling Downloading Standalone Applications

This section explains the steps necessary to enable you to download 
standalone applications from the Download Applications window. 

Note: To access the Download Applications window, in Lab Management or 
in the ALM project, select Tools > Download Standalone Applications. 

To enable downloading standalone applications:

 1 Insert the HP ALM Performance Center Additional Components 
installation disk (DVD 2) and navigate to the Additional Components 
directory. This directory contains the applications’ execution (.exe) files. 

Note: The necessary .exe files for downloading VuGen, Analysis, 
Snapshot Viewer, Standalone Load Generator, Monitor over Firewall, and 
MI Listener, are located in the Applications directory, which is contained 
within the Additional Components directory.

 2 On the Performance Center server, navigate to the Downloads directory, 
which is located in C:\Program files\HP\Performance Center 
Server\PCWEB\Downloads.

 3 To enable downloading an application, copy the relevant execution file 
(.exe) from the Additional Components directory on the DVD to the 
Downloads directory on the Performance Center server.

Note: You may need to refresh the Download Applications window for 
the changes to take effect.
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Customizing the Download Applications Window
You can edit and customize the appearance of the Downloads Applications 
window. To customize the window, edit the downloads.xml file located in 
the Downloads directory on the Performance Center server.

The following tags in the downloads file control the following features on 
the window. Edit the tags as desired to change the appearance of the 
window.

➤ App Name. The name of the application.

➤ Image. Whether the application’s icon appears to the left or to the right 
of the name.

➤ File Name. If you changed the name of the application’s execution file, 
you must update this section so that it matches the new name of the 
execution file.

➤ Description. The application’s description.
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Enabling MS-SQL Windows Authentication

To configure an MS-SQL database with Windows authentication, perform 
the following steps:

Note: The procedure below requires you to make changes to the MS-SQL 
database. It is strongly recommended that you make these changes using 
the SQL Server Management Studio tool.

To enable Windows authentication:

 1 Prerequisites: 

➤ Make sure that the relevant project is created in Site Administration 
with the MS-SQL (Win Auth) database type. For more information, see 
the “Configuring Servers and Parameters” chapter in the 
HP Application Lifecycle Management Administrator Guide.

➤ Make sure that the Performance Center Server, ALM Platform, and 
database server, all belong to the same domain, and that there is a 
domain user with administrator privileges common to all the 
machines.

➤ Download the SQL Server Management Studio tool from the Microsoft 
Download Center (http://www.microsoft.com/downloads/en/default.aspx).

 2 In SQL Server Management Studio, perform the following actions:

 a In the Object Explorer pane, expand the Security folder.

 b Rich-click Logins and select New Login.

 c Enter the domain user in the Login name box, and make sure that 
Windows Authentication is selected.

Note: Make sure that the domain user is assigned the same Server 
Roles as the database administrative user (td_db_admin).
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 3 On the Performance Center Server, open the Internet Information 
Services (IIS) Manager (select Start > Run and type inetmgr). 

 4 In IIS, perform the following actions:

 a In the Internet Information Services pane, select Web Sites > 
Default Web Site. 

 b Right-click LoadTest and select Properties.

 c In the Properties dialog box, select the Directory Security tab.

 d Under Authentication and Access Control, click Edit. The 
Authentication Methods dialog box opens.

 e Select Enable Anonymous Access and enter the details of the domain 
user.

 f In the Authenticated Access area, select Integrated Windows 
Authentication.

 g Click OK, then OK again to close the Properties dialog box.

 h In the Default Website list, right-click PCS and select Properties.

 i Repeat steps c through h.

 j In the Internet Information Services pane, expand the Application 
Pools folder.

 k Right-click LoadtestAppPool and select Properties.

 l In the Properties dialog box, select the Identity tab.

 m Select Configurable and enter the domain user’s details.

 n Click OK to close the Properties dialog box.

 5 On the Performance Center server, select Start > Run and type secpol.msc. 
The Local Security policy window opens.

 6 In the tree in the left pane, select Local Policies > User Rights Assignment.
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 7 In the Policy list in the right pane, right-click the following items and 
select Add User to Group. Then add the domain user specified above.

➤ Allow logon locally

➤ Log on as a batch job

➤ Log on as a service

➤ Access this computer from the network

For more information about these policies, see “Required Policies for the 
Performance Center System User” in the HP ALM Performance Center 
Guide.
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5 
Upgrading to HP ALM 
Performance Center 11.00

This chapter provides instructions for upgrading your Performance Center 
system (versions 8.1 and later) to HP ALM Performance Center 11.00. Before 
performing the upgrade, make sure you understand all the procedures 
involved in the upgrade process.

This chapter includes:

➤ The Upgrade Process: Basic Steps on page 144

➤ Pre-Upgrade Preparation and Considerations on page 146

➤ Backing Up Performance Center Data on page 147

➤ Uninstalling Earlier Versions of Performance Center on page 150

➤ Installing and Configuring HP ALM Performance Center 11.00 
on page 153

➤ Verifying Successful Installation on page 153

➤ Migrating Performance Center Data on page 154

➤ Post-Migration Verification on page 182

➤ Post Migration Considerations on page 185
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The Upgrade Process: Basic Steps

This section provides a general outline of the steps that you need to carry 
out to upgrade your current version of Performance Center to HP ALM 
Performance Center 11.00. Review these steps before you begin the upgrade 
process. 
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To upgrade your current version of Performance Center to version 11.00:

 1 Prepare your system for the upgrade process.

For details, see "Pre-Upgrade Preparation and Considerations" on 
page 146.

 2 Back up Performance Center data.

For details, see "Backing Up Performance Center Data" on page 147.

 3 Uninstall the current version of Performance Center.

This step is relevant only when upgrading on a production environment. 
When upgrading on a staging environment do not uninstall or clean any 
of the machines in your current environment.

For details, see "Uninstalling Earlier Versions of Performance Center" on 
page 150.

 4 Install and Configure HP ALM Performance Center 11.00.

For details, see Chapter 2, "Installing HP ALM Performance Center."

 5 Verify that the ALM Performance Center environment was installed 
correctly.

For details, see Chapter 3, "Post Installation Verification."

 6 Migrate the data.

Use the Performance Center Migration tool to migrate your 
Performance Center data to HP Performance Center 11.00. For details, see 
"Migrating Performance Center Data" on page 154.

Note: If you are migrating data from Performance Center versions 8.1 
through 9.50, you must first run the Performance Center 9.51 Migration 
tool.

 7 Verify that the data was migrated successfully.

For details, see "Post-Migration Verification" on page 182.
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Pre-Upgrade Preparation and Considerations

Before you start upgrading to HP ALM Performance Center 11.00:

➤ Estimate how long the upgrade process, including migration, will take 
and ensure that no timeslots are reserved from the time you start the 
upgrade process until you expect it to be complete. 

For example, if you start the upgrade process today, and expect it to 
take 2 days, ensure that there are no timeslots reserved for the next 2 
days. 

➤ Ensure that there are no tests with any of the following run states:

If there are runs in any of these states, make sure that the current 
operation finishes before performing the upgrade.

To check the run state of the test, do one of the following:

➤ Check in the Performance Center Administration Site, on the Test 
Runs page (Site Management > Test Runs)

➤ Run the following query on the Performance Center source 
database: 

➤ Some tests may have finished running but may still be in the Before 
Collating or Before Analyzing state. To avoid losing data from these 
runs, you must collate and analyze the run results before performing 
the upgrade.

Ready

Collating Results

Running

Stopping

Creating Analysis Data

Deleting Temporary Results

SELECT * FROM SessionRuns WHERE State in (1,2,3,7,8,13)
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➤ Ensure that all host machines configured in the Administration Site 
actually exist. If a host does not exist, is turned off, or does not have a 
network connection, you must delete it from the Administration Site 
resources to prevent configuration problems later on.

➤ To avoid file server and database conflicts, stop IIS on all 
Performance Center Web server machines before backing up the data.

➤ Save your license key details. For more information, see "Backing Up 
License Keys" on page 148.

Backing Up Performance Center Data

Before performing database migration you must back up your current 
Performance Center data. 

Note: Make sure that the file system backup is synchronized with the 
database backup. To avoid file server and database conflicts, we recommend 
stopping IIS on all Performance Center Web server machines before backing 
up the data.

This section includes:

➤ "Backing Up License Keys" on page 148

➤ "Backing Up Host Data" on page 148

➤ "Backing Up the File System" on page 149

➤ "Backing Up the MI_LRDB Database" on page 149
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Backing Up License Keys
After you migrate your database, all license information is deleted from the 
Performance Center system and you have to configure the license keys 
again. To use the same license keys in the migrated system, save the 
Performance Center and host license keys.

Note: ALM Performance Center 11.00 no longer supports host-locked 
licenses. To obtain a replacement license, contact HP Software Support.

To save your license key:

 1 From the Performance Center Administration Site left menu, select 
System Configuration > License. 

 2 Copy the License Key strings displayed under Performance Center License 
and Host License.

This information is required when you reconfigure the 
Performance Center system settings in "Installing and Configuring 
Performance Center Servers and Hosts" on page 48.

Backing Up Host Data
To avoid data loss from test runs that have not yet been collated or analyzed, 
perform the following steps before you start upgrading the system and 
migrating the data:

➤ Collate and analyze results from the load test runs on the User Site.

➤ Delete all unnecessary runs.

➤ Back up the Temp and orchidtmp directories on each host machine. To 
locate a machine’s Temp directory, open Windows Explorer, type %temp% 
in the address bar, and press Enter. To locate the orchidtmp directory, 
navigate to <Performance Center directory>\orchidtmp.
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Backing Up the File System
Before migrating the Performance Center file system, you must back up the 
user data folders to protect your data in case of migration error.

 1 On the File Server machine, open the <Performance Center 
directory>\LRFS directory.

 2 Create a backup copy of the entire LRFS directory on a separate machine. 

Note: After the file system data is backed up, this data becomes the source 
data for migration, and you should not continue working on your current 
version of Performance Center. 

In addition, we strongly recommend that you copy the backed up LRFS 
directory to a location on the ALM Platform repository machine. This 
backed up copy is later used for migration.

Backing Up the MI_LRDB Database
Before performing database migration, you must create a database backup to 
protect your data in case of migration error. 

For details about backing up and restoring your database, refer to the 
HP ALM Database Best Practices Guide.
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Uninstalling Earlier Versions of Performance Center

After backing up relevant data, you need to uninstall earlier versions of 
Performance Center and clean the machines.

Note: 

➤ If you are upgrading to a staging environment, skip this section!

➤ We support uninstallation of host machines only. We strongly 
recommend installing the Performance Center Server and other 
Performance Center components on clean machines with a new image.

To uninstall Performance Center:

 1 From the Windows Control Panel, open the Add/Remove Programs dialog 
box.

 2 Select HP Performance Center from the list of currently installed 
programs and click Remove. 

 3 Follow the instructions in the wizard to complete the uninstall process.

 4 Reboot the machine.

To clean Performance Center machines:

 1 Ensure that you have backed up the relevant Performance Center 
subdirectories. For details, see Chapter 5, "Backing Up 
Performance Center Data."

 2 Delete the Performance Center directory.
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 3 Ensure that the virtual directories were deleted. If they were not removed 
automatically, delete them manually as follows:

➤ On the User Site machine, in IIS:

➤ Under Default Web Site, delete the Loadtest virtual directory.

➤ Open the Default Web Site Properties window. In the ISAPI Filters 
tab, ensure that there are no filters. If there are filters, remove them.

➤ On the Administration Site machine, in IIS, delete the Admin virtual 
directory, located under Default Web Site.

➤ If you are uninstalling Performance Center 9.0: On all 
Performance Center machines, in IIS, delete the PCWSApplicationPool 
virtual directory, located under Application Pools.

 4 Delete the IUSR_METRO user and the crypto key from the Crypto 
directory: Delete the files starting with 
f9416f003254e6f10da1fbad8e4c383_ from C:\Documents and 
Settings\All Users\Application 
Data\Microsoft\Crypto\RSA\MachineKeys

 5 Delete cookies and temporary internet files from your browser to avoid 
user interface problems (Tools > Internet Options > General tab).

 6 If you are uninstalling Performance Center 8.1: Remove the 
Performance Center folder from the Start menu. To do this, right-click 
Start and select Explore All Users. The Start Menu folder opens. Double-
click the Programs folder, and delete the Performance Center folder. 
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 7 If you are uninstalling Performance Center 8.1: Clean the environment 
variables.

➤ On all Performance Center machines: From the path system variable, 
delete the following paths: (These are paths that include the old 
Performance Center installation folder.)

➤ <Old PC Installation folder>\java\J-INTE~1\com\bin

➤ <Old PC Installation folder>\DbSetup

➤ <Old PC Installation folder>\bin

Note: Some of the above paths may not exist on all of the 
Performance Center machines.

To edit the path system variable, right-click My Computer and select 
Properties. In the Advanced tab, click Environment Variables to open 
the Environment Variables dialog box. In the System Variables area, 
select the Path variable and click Edit.

➤ On the User Site server only: Delete the following Environment 
variables:

➤ CATALINA_HOME

➤ CLASSPATH

➤ JAVA_HOME

➤ JINTEGRA_HOME

 8 Reboot the machine.
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Installing and Configuring 
HP ALM Performance Center 11.00

After you have backed up your Performance Center data, and cleaned your 
machines, install and configure HP ALM Performance Center 11.00. 

For details on installing HP ALM Performance Center 11.00, see Chapter 2, 
"Installing HP ALM Performance Center."

Verifying Successful Installation

After you have installed and configured HP ALM Performance Center 11.00, 
and before you start migrating data from your previous version of 
Performance Center to the new production environment, create a staging 
environment and verify that the components were installed successfully. For 
details, see Chapter 3, "Post Installation Verification."
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Migrating Performance Center Data

This section explains how to migrate the Performance Center file system 
and database (versions 8.1 and later) to HP ALM Performance Center 11.00.

This section includes:

➤ "Pre-Migration Considerations" on page 154

➤ "Copying and Restoring Backed Up Data" on page 155

➤ "Configuring the ALM Repository on a Linux system" on page 155

➤ "Performing the Migration" on page 161

Pre-Migration Considerations
During the migration of the Performance Center source database, a data 
migration report and other tables are created and added to the source 
database. Check the disk space on the source database server to ensure that 
it can accommodate these extra tables.

Note:

➤ No users should be logged in to the system while the migration process is 
running.

➤ If you performed the migration prior to installing the patch on your 
system, there is no need to verify and repair the migrated projects. You 
can continue to work normally. For details about verifying and repairing 
projects, see the “Upgrading Projects” chapter in the HP Application 
Lifecycle Management Administrator Guide.

➤ Do not perform the verify and repair procedure on the LAB_PROJECT.
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Copying and Restoring Backed Up Data

➤ If you backed up the host data (see "Backing Up Host Data" on page 148), 
you need to restore the orchidtmp and temp directories. To restore these 
directories, copy orchidtmp to the new installation directory (for 
example, C:\Program Files\HP\Performance Center Host\orchidtmp), and 
copy the temp directory to its original location on the host machines.

➤ To maximize performance during the migration process, copy the file 
system directory (LRFS) that you saved on a separate machine (see 
"Backing Up the File System" on page 149) to a directory on the same 
machine as the ALM Platform repository. 

➤ Copy the backed up database (MI_LRDB) on the database server that is to 
act as your source database server, and restore the database. For details 
about restoring your database, refer the HP ALM Database Best Practices 
Guide.

Configuring the ALM Repository on a Linux system
If the ALM Platform is installed on a Linux system, you must configure the 
ALM Platform repository before migrating your Performance Center 
database and file system.

To configure the ALM Platform repository:

 1 Log in to your ALM Platform repository machine.

 2 Make sure Samba is installed on the machine.

 3 Configure the following Samba files:

Note: Separate the domain and user names with a slash '/', for example: 
DOMAIN/username. 

 a Edit the following file: /etc/samba/smb.conf

➤ Under the [global] section, set the following attributes:

workgroup = <domain name> 
password server = <domain controller>
realm = <domain name>
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➤ Add the following section at the end of the file:

[slesh]
path = /
write list = user (For example: qcuser)
browseable = yes
writable = yes
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 b Create the file /etc/samba/smbusers.map with the following data:

 c Edit the following file: /etc/krb5.conf 

➤ Under the [libdefaults] section, set the following attribute:

➤ Under the [realms] section, set the following:

root = administrator admin <username> <domain name>/<user name> 
<domain>/<admin user on this domain>

default_realm = <domain name>

<domain name> = {
kdc = <server name> 
admin_server = <server name>
}
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➤ Under the [domain_realm] section, set the following attributes:

 d Run the following command:

.<full domain name> = <domain name>

.<domain name> = <domain name>
<full domain name> = <domain name>

net ads join <domain name> -U <administrator username on the domain>
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 e Edit the following file: /etc/nsswitch.conf

Add the winbind option:

passwd: files nis winbind
shadow: files nis winbind
group: files nis winbind
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 f Run the following commands:

 g Verify successful configuration.

From a Windows machine, check that you can navigate to the 
ALM Platform repository using the UNC path and the domain user 
you defined. For example, \\<ALM Platform server 
name>\slesh\var\opt\HP\ALM\repository.

You can now migrate your Performance Center data using the HP ALM 
Performance Center Migration tool. When prompted enter the same 
repository path as above.

/etc/init.d/winbind start
/etc/init.d/smb start
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Performing the Migration
This section describes how to install and run the HP ALM 
Performance Center Migration tool to migrate your Performance Center 
database and file system to the ALM Platform database and repository.

Note: We recommend that you install and run the migration tool on the 
machine where the Performance Center Server is installed because the 
prerequisite software needed to run this tool is already installed on this 
machine.

To migrate the data:

 1 Install the prerequisite software.

Tip: If you are performing the migration from the Performance Center 
Server machine, skip this step as the prerequisite software is already 
installed on this machine.

Ensure that the following prerequisite software has been installed on the 
machine on which you are going to install the migration tool: 

➤ .NET Framework 3.5 SP1

➤ Oracle client: If you are working with an Oracle database, ensure that 
the Oracle client is installed, and that connectivity has been 
established with the Oracle Server. Ensure that the tnsnames.ora file 
contains a TNS entry for the source and target database servers.

 2 Access the Migration tool.

Download and install the latest version of the HP ALM 
Performance Center Migration Tool, included with the latest 
Performance Center patch. Patches and the Migration Tool are available 
on the HP Software Support Web site 
(http://h20230.www2.hp.com/selfsolve/patches). 
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 3 Launch the ALM Performance Center 11.00 Migration Tool wizard.

Note: If you are upgrading from Performance Center version 8.1 through 
Performance Center version 9.50, you must first run the 
Performance Center 9.51 Migration Tool. This tool is located in a 
subdirectory of the ALM Performance Center 11.00 Migration Tool 
installation directory 
(..\ALM Migration\DBMigrationTool95\DBMigration95_SP1.exe).

Navigate to the location where you installed the Migration tool, and run 
MigrationToolStart.exe. Alternatively, double-click the 
MigrationToolStart.exe icon on the desktop. The Migration Tool wizard 
opens on the Welcome page. Click Next.
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 4 Provide the details of the source database.

On the HP Performance Center Source Details - Source Database page, 
enter the details of the HP Performance Center Database Server that 
contains the source database.

➤ Database Type. Select the type of source database: Oracle or MS-SQL.

Note: You can migrate one type of database to another. That is, if the 
source Performance Center database is MS-SQL, you can migrate it to a 
target Oracle database in ALM; if the source Performance Center 
database is Oracle, you can migrate it to a target MS-SQL database in 
ALM. It is recommended to migrate all projects to the same database or 
server on which the Lab project is located.
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➤ Database Server. (MS-SQL only) Enter the path and name of the source 
database server. 

Tip: Click the Browse button to browse to a server instance where the 
database is installed.

➤ Authentication type. (MS-SQL only) Enter the method used to connect 
to the database: SQL Server Authentication or Windows 
Authentication.

➤ SID. (Oracle only) Enter the Service ID of the source database server as 
defined in the tnsnames.ora file.

➤ Username and Password. Enter the user name and password:

➤ For Oracle: Enter the Performance Center database user (DB Name), 
for example, MI_LRDB, and its password. 

➤ For MS-SQL: Enter the user name and password of the 
Performance Center database administrator user. When running the 
migration tool, always use the same database administrator user.

➤ Database Name. (MS-SQL only) Enter the name of the source database 
schema. By default, the schema name is MI_LRDB.

Click Test Connection to verify that you can connect to the source 
database. If the connection fails, a message displays the possible reasons. 
In this case, verify that the details you provided are correct and that the 
database server is up and running. 

Click Next.
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 5 Provide the details of the source file system.

On the HP Performance Center Source Details - Source File System (LRFS) 
page, enter the details of the directory containing the backed up 
Performance Center source file system (LRFS).

Tip: To avoid network traffic delays and for a more reliable migration, it is 
strongly recommended to save a copy of this directory in a location on 
the same machine and parallel to the ALM Platform repository.
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➤ File System Path. Enter the path and name of the backed up copy of 
the source file system (LRFS) that you saved on the same machine as 
the ALM Platform repository.

➤ Username and Password. Enter the user name and password of a user 
with file system administration privileges on the backed up copy of the 
source file system (LRFS).

➤ Domain. Enter the domain in which the backed up copy of the source 
file system is located.

Click Test Connection to verify that you can connect to the backed up 
copy of the source file system. If the connection fails, a message displays 
possible reasons for the failure. In this case, verify that the details you 
provided are correct. 

Click Next.
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 6 Provide ALM Platform credentials.

On the HP ALM Target Details - Site Administration Details page, enter 
the details of the ALM Platform, and the credentials of the user with 
administrative privileges on the ALM Platform.

➤ ALM Platform URL. Enter the URL of the ALM Platform in the 
following format: 

For example, http://alm_platform139:8080/qcbin.

➤ Username and Password. Enter the Site Administrator user name and 
password, as defined when installing the ALM Platform.

http://<ALM Platform name><:port number>/qcbin
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➤ Communication Security Passphrase. Enter the passphrase used for 
secure communication with the ALM Platform, as defined when 
installing the ALM Platform.

Click Test Connection to verify connectivity with the ALM Platform. If 
connectivity fails, a message displays possible reasons for the failure. In 
this case, verify that the details you provided are correct. 

Click Next.
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 7 Provide the details of the target database.

On the HP ALM Target Details - Target Database page, enter the details of 
the ALM Platform database server to which the source database is to be 
migrated.

Note: If you are performing the migration from a remote location: 

➤ If you are migrating to an MS-SQL database, ensure that the MS-SQL 
Server name defined when configuring ALM is not localhost or 
localhost\SQLSERVER, and that its name is a full host machine name, 
for example, DbServerMachine23.domain.it. 

➤ If you are migrating to an Oracle database, the client configuration file 
(tnsnames.ora) must include a servicename section that is exactly the 
same as the servicename section located on the ALM client 
configuration. Click the Server Details button on the HP ALM Target 
Details - Target Database page to view the SID that must be used.
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➤ Database Server. From the dropdown list, select a target ALM Platform 
database server, as defined in ALM. 

Click the Server Details button to view the full details of the server.

Note: You can migrate one type of database to another. That is, if the 
source Performance Center database is MS-SQL, you can migrate it to a 
target Oracle database in ALM; if the source Performance Center 
database is Oracle, you can migrate it to a target MS-SQL database in 
ALM.

➤ DB Username and DB Password. Enter the password of the database 
administrator user.

➤ Server Name (Oracle only). The SID defined in the Server Details.
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➤ Tablespace and Temp Tablespace (Oracle only). The tablespaces to 
which the projects are migrated.

Click Test Connection to verify that you can connect to the database 
server. If the connection fails, a message displays possible reasons for the 
failure. In this case, verify that the details you provided are correct and 
that the database server is up and running. 

Click Next.

 8 Provide the details of the target file system directory.

On the HP ALM Target Details - Target File System (Repository) page, enter 
the details of the ALM Platform repository. The data in the 
Performance Center source file system directory (LRFS) is migrated to this 
repository.
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➤ File System Path. The path to the ALM Platform repository. The source 
file system (LRFS) will be migrated to this repository. This value is read-
only and is taken directly from the ALM Platform.

➤ Username and Password. Enter the user name and password of the 
user with file system administration privileges on the ALM Platform 
repository. To use the same user as the source file system directory 
(LRFS) user, select Use the same user credentials as the PC FS.

➤ Domain. Enter the user domain.

Click Test Connection to verify that you can connect to the ALM Platform 
repository. If the connection fails, a message displays possible reasons for 
the failure. In this case, verify that the details you provided are correct. 

Click Next.
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 9 View the migration validation.

With all the relevant source and target details, the tool validates the 
feasibility of the migration. Review the list of warnings and errors. If you 
need to make any changes before you migrate the data, close the 
migration tool, and start the tool again when you are ready.
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 10 Specify whether to migrate administration data.

The Data Selection - Migrate Administration Data page opens. 

➤ To migrate all of the data from the Performance Center Administration 
site, such as Performance Center resources (hosts, host pools, 
locations, MI Listeners), user-project assignments, and server data, 
select Migrate Lab Project Data.

If you are running the migration tool to migrate additional projects 
only, but you do not want to migrate the administration data again, 
ensure that Migrate Lab Project Data is NOT selected.
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Note: The first time you run the Migration Tool, the Migrate Lab 
Project Data option is selected by default, and the Performance Center 
administration data is migrated the first time by default. In subsequent 
migrations, you can select whether or not to migrate the 
administration data. It is important to note that when you migrate the 
administration data again, all Performance Center administration data 
and other Performance Center projects that have already been 
migrated are deleted. For this reason, it is strongly recommended to 
ensure that the migration process is fully complete before working 
with new data and projects in ALM Performance Center 11.00.

➤ HP ALM Platform Domain. Enter the name of the ALM domain to 
which to migrate the projects that you select in the next wizard page. 
You can enter the name of an existing domain, or enter a new domain 
name. If you enter a new domain name, the domain is created on the 
ALM Platform.

Note: Administration data is always migrated to the LAB_PROJECT, 
which is located on the default domain.

Click Next.
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 11 Select Performance Center projects to migrate.

On the Data Selection - Select Projects to Migrate page, select the 
Performance Center projects to migrate. You must select at least one 
project. 

To select all of the projects, click the Select All button.

Projects that have already been migrated are marked Migrated in the 
Project Migration Status column. If you select a project that has already 
been migrated, the project is deleted from ALM before it is migrated 
again.
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Note: If you are running the migration tool only to migrate additional 
projects, but you do not want to migrate the administration data again, 
ensure that the Migrate Lab Project Data option on the previous wizard 
page is NOT selected.

Click Next.

 12 Confirm the migration.

The Confirm Migration page opens, displaying a summary of the options 
you selected in the preceding steps.

Click Next.
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 13 Track the migration progress.

On the Migration Progress page, you can track the migration progress.

In addition, for each project, you can view the migration progress of 
project entities such as scripts, load tests, monitors, timeslots, and so on.



Chapter 5 • Upgrading to HP ALM Performance Center 11.00

179

 14 View migration report.

Note: After the migration, you are prompted to restart the ALM Platform 
before starting to work in ALM Performance Center. 

To restart the machine do one of the following:

➤ Reboot the machine 

➤ Go to services (services.msc), restart the HP Application Lifecycle 
Management service, and then restart IIS.

When the migration is complete, the Migrate Report page opens. The 
report displays the migration results for each project, including warnings 
and errors.

Note: The report may take several minutes to generate.



Chapter 5 • Upgrading to HP ALM Performance Center 11.00

180

You can generate the following filtered reports: 

➤ A summary for each migrated project

➤ Errors only (per project)

➤ Warnings only (per project)

You can also select to view data from all migration procedures performed 
on the machine, or only from the latest migration.

To save the report, click the Save button, and select a location to save the 
report.

If necessary, the report data can also be accessed from the source 
Performance Center database, from the EntityMappings table that is 
created and updated during migration.
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To access the report, run the following SQL query:

Click Finish to exit the HP ALM Performance Center Migration tool.

If you did not save the migration report, you are prompted to save it 
before closing the wizard.

 15 Reconfigure the Performance Center hosts.

Note: If you did not yet restart the ALM Platform after the migration, it is 
recommended to do so before continuing with this step. See step 14 on 
page 179.

After migration, the status of all migrated hosts is Unavailable.

For staging environment: Keep the migrated hosts in the Unavailable 
status, and add several new hosts to validate your environment.

For production environment: To change the status of the hosts after 
migration to Operational and set up the host license, you must 
reconfigure the hosts. 

 a Log in to Lab Management. 

 b Select Lab Resources > Hosts, select the migrated host, and click the 
Reconfigure Hosts button.

 16 Verify the migration.

After migrating the file system and database, verify that the data was 
migrated successfully. For details, see "Post-Migration Verification" on 
page 182.

select * from EntityMappings
order by CompanyID, EntityType,PCID
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Post-Migration Verification

After migrating the files and database, verify that the data was migrated 
successfully.

Note: Ensure that the hosts were reconfigured as described at the end of the 
migration process. For details, see step 15 on page 181.

Site Administration

 1 Log in to Site Administration as Site Administrator.

 2 Check that the domain you created during migration exists and that the 
projects you selected are listed in the domain and are active.

 3 Choose two projects and check that the correct users are assigned to the 
projects.

 4 In the Lab Management tab, check that assigned users are the same as 
source Performance Center administrators.

Lab Management

 1 Log in to Lab Management with your Performance Center administrator 
credentials.

 2 Verify the following:

➤ On the Lab Management sidebar, under Lab Settings, select Project 
Settings, and verify that the migrated projects are listed and that the 
host pool and Vuser limit, Concurrent Run limit, and Host limit details 
are correct.

➤ On the Lab Management sidebar, under Lab Resources, verify that the 
data listed in the Hosts, Host Pools, Locations, and MI Listeners 
modules includes all data relevant to the migrated projects.
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➤ On the Lab Management sidebar, under Lab Usage, verify that the 
following data exists for a selected migrated project:

➤ Timeslots module: A month’s worth of past timeslots and, if 
relevant, existing future timeslots.

➤ Test Runs module: Test runs from the last month.

➤ Usage Report module: Reports for the last month.

HP Application Lifecycle Management

 1 Log in to a migrated project in ALM, using your Performance Center 
administrator credentials.

 2 Verify the following:

➤ On the ALM sidebar, under Lab Resources, verify that the Hosts 
module contains the hosts that belong to the project you are logged in 
to.

➤ On the ALM sidebar, under Testing, select Test Resources, and review 
the monitor profiles listed in the tree. Verify the details and monitor 
configuration for a familiar monitor profile.



Chapter 5 • Upgrading to HP ALM Performance Center 11.00

184

➤ On the ALM sidebar, under Testing, select Test Plan. 

➤ Review the full tree for scripts and performance tests. Check also for 
failed performance tests, if you know of any that exist.

➤ Review one familiar VuGen script - Details and Test Script tabs. 

➤ Review one test in the project that you are familiar with. Click the 
Test Design tab and check the details in the General Details section. 
Verify that there are no errors. 

Click Edit Test. In the Workload tab, verify that the Controller, load 
generator distribution method, Vuser groups, runtime settings, and 
test schedule details are all correct. Check also that the monitor 
profiles selected in the Monitors tab are correct. 

➤ On the ALM sidebar, under Testing, select Test Lab. Review the data in 
the Test Runs tab. If you do not see any data, ensure that the filter is 
clear.

 3 Try to run a familiar test with its original hosts. Ensure that the hosts have 
been upgraded to Performance Center 11.00 hosts.
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Post Migration Considerations

This section points out issues to consider after migration.

This section includes:

➤ "User Migration" on page 185

➤ "Roles (Groups) Migration" on page 186

➤ "Project Migration" on page 189

➤ "Host and Pool Migration" on page 190

➤ "Load Test Migration" on page 190

➤ "Timeslot Migration" on page 191

➤ "Script Migration" on page 192

➤ "General Notes" on page 192

User Migration

➤ Deleted / Non-Active / Expired users in Performance Center

➤ Shown in entities - Timeslots (Reserved By), Test Runs (User Name), 
Event Log (not relevant, not migrated), Trend Reports - Run By

➤ Shown in Lab Usage reports - Site Users Report, Resource by Duration 
Report, Resource by Runs Report in the Resource Usage by User tab

➤ Migrating deleted users (may have the same name as existing users):

➤ This type of user does not exist in ALM.

➤ Deleted users are not migrated.

➤ Migrating Non-Active / Expired users:

➤ Non-Active or Expired Users - 

➤ Migrates the user and assigns it the groups and project

➤ Non-active users are migrated as Expired.

➤ Users with future expiration date are migrated as explained above and 
assigned the appropriate expiration date.
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➤ User name issues:

➤ If a user name contains invalid characters, all invalid characters are 
replaced with an underscore (_). For details on invalid characters, see 
"General Notes" on page 192.

➤ If ALM contains the same user name as in the migrated 
Performance Center project:

➤ If both user definitions contain an email address, and the email 
address is identical, this indicates that this is the same user, and the 
user is not migrated.

➤ If both user definitions contain a full name and they are identical, 
this indicates that this is the same user, and the user is not migrated.

➤ If there is a user in the ALM target system with the same user name, 
and it has been established that they are not the same user, then the 
new (migrated) user is created with a 01 (02, 03, ...) suffix appended.

Roles (Groups) Migration

➤ Canned group migration

PC 9.5 PC 11.00

Admin 
Site

Administrator Lab 
Management

TDAdmin 

(existing ALM group)

User Site Guest Project Viewer 

(existing ALM group)

User Site LT Adviser Project Performance Adviser 

(new ALM group, 
customized when 
Performance Center 
extension is deployed)

User Site Tester Project Performance Tester

(new ALM group, 
customized when 
Performance Center 
extension is deployed)
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➤ Roles marked as Administration from User site only are not migrated, and 
users who belongs only to such roles in the scope of Performance Center 
are not added to Lab Management.

➤ Customized Groups migration

➤ A Performance Center Template project is created which includes all 
the customized groups from the source Performance Center system.

➤ Enabling the Performance Center extension on a project adds the 
canned Performance Center groups to the project.

➤ Migrated projects will be attached to a Performance Center Template 
project that will include all the customized groups defined in 
Performance Center 9.x.

➤ ALM Consolidated installation:

User Site Power Tester Project Performance Test Specialist

(new ALM group, 
customized when 
Performance Center 
extension is deployed)

User Site Project 
Manager 

Project Project Manager

(existing ALM group)

Performance
Center

Consolidated 
Installation

Flow

Internal Internal ➤ Define match - Username, Full Name 
(optional)

➤ Create unmatched users in ALM (with 
password) 

Internal LDAP ➤ Define match – Username

➤ Create unmatched users in ALM (no 
password)

➤ New user in ALM require LDAP lookup  
on the first login (no DN in ALM)

PC 9.5 PC 11.00
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➤ Validation stage messages regarding authentication:

➤ If Performance Center 9.5x uses SSO, then warns that ALM does not 
support SSO.

➤ If Performance Center 9.5x uses LDAP or SSO and ALM is not LDAP, 
then warns that then user should configure LDAP in ALM before 
migration. If LDAP is not configured, all of the users password are reset 
to Welcome1.

LDAP Internal ➤ Define match – Username

➤ Create unmatched users in ALM (default 
password – Welcome) 

LDAP LDAP ➤ Define match – Username

➤ Create unmatched users in ALM (no 
password) 

➤ New user in ALM will require LDAP 
lookup on the first login (no DN in 
ALM) 

SSO Internal ➤ Define match – Username

➤ Create unmatched users in ALM (default 
password – Welcome) 

SSO LDAP ➤ Define match – Username

➤ Create unmatched users in ALM (no 
password) 

➤ New user in ALM will require LDAP 
lookup on the first login (no DN in 
ALM) 

Performance
Center

Consolidated 
Installation

Flow
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Project Migration

➤ Performance Center project expiration date:

➤ If the Performance Center source project has expired, the project is 
migrated as Deactivated.

➤ If Performance Center source project has not expired, it is migrated as 
Active. If the project had an expiration date, a warning is included in 
the migration report with the expiration date.

➤ Project names:

➤ Invalid characters are replaced with underscores (_). For details on 
invalid characters, see "General Notes" on page 192.

➤ The user enters a domain name to which to migrate the projects. If this 
domain already exists in ALM, projects are migrated to this domain. If 
it does not exist, then the new domain is created.

➤ When migrating a project with the same name as a project that was 
previously migrated, the migrated project is deleted and is migrated 
again. 

➤ When migrating a project, and a project with the same name already 
exists, then the migration of the project fails.

➤ Migrating deleted projects:

➤ Deleted projects can be viewed in the Resource by Duration Report and 
Resource by Runs Report in the Resource Usage by Project tab.

➤ Deleted projected are named <project>_deleted.

➤ Data from deleted projects is migrated only if it is requested by the 
user.

➤ Data is relevant to Test Runs in Lab.
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Host and Pool Migration

➤ Merged pools are not supported in Performance Center 11.00. Hosts are 
migrated with direct connection to their pools.

➤ Host priority changes:

➤ In Performance Center 9.5x the priority was a number between 1 and 
30000, where the lower the number the higher the priority. 

➤ In Performance Center 11.00 the priority has a value between 1 and 9, 
where 1 is the lowest priority and 9 is the highest priority.

➤ During migration, the values are changed based on their priority 
relative to each other. For example: Priorities 1, 2, 3 in 
Performance Center 9.5x change to 9, 5, 1 respectively.

Load Test Migration

➤ Performance Center 11.00 does not support the Real-World > By test > 
By Number scheduler mode. This needs to be changed to Real-World > By 
test > By percent. This change should be logged in the migration log.

➤ Migrating Load Generator distribution methods in Performance Test 
Designer:

Performance Center 9.5x had 5 distribution methods (see image below) 
and Performance Center 11.00 only has 2. 

Migration changes the distribution method in the following way:

PC 9.5 Distribution Method PC 11.00 Distribution Method

Assign all load generators to each group Assign all load generators to each 
group

Assign one load generator to each group Manual distribution

Assign an equal number of load 
generators to each group

Manual distribution

Assign virtual load generators to groups at 
design time

Manual distribution

Assign actual load generators to groups Manual distribution
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The following image illustrates the mapping of Performance Center 9.5x 
to Performance Center 11.00 load generator distribution methods:

➤ Controller selection was not available in Performance Center 9.5x. During 
migration this option is set to Dedicated Controller for all tests.

➤ Local Monitor Profile:

➤ Does not exist in Performance Center 11.00. A local monitor profile is 
migrated to Performance Center 11.00 as a monitor profile in the Test 
Resources module, under the name Local_Profile_<LT_Name>.

➤ The test is connected to the migrated monitor profile if the test used a 
local monitor profile.

➤ Topology: Not migrated. If a test is associated with a topology, the 
association is removed.

Timeslot Migration

➤ If the timeslot is connected to a test, then the Controller option in the 
new timeslot is set to Automatic. If the timeslot is not connected to a test 
then it is set to Allocate only Controller that is also LG or Automatic based 
on whether the timeslot in Performance Center 9.5x was set to allow 
Vusers on Controller or not respectively.
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Script Migration

➤ URL-based scripts are migrated to regular Web (HTTP/HTML) scripts.

➤ When migrating script files, MDRV logs are not migrated.

General Notes

➤ Event logs and topologies are not migrated.

➤ Run states are migrated as follows:

ID
Pre-Migration 
State

Migrated State
Migrated 
Status

Comments

1 Ready Run Failure Not 
Completed

Run Failure with 
a comment

2 Collating Results Run Failure Not 
Completed

Run Failure with 
a comment

3 Running Run Failure Not 
Completed

Run Failure with 
a comment

4 Finished Finished Not 
Completed

Same

5 Run Failure Run Failure N/A Same

7 Stopping Run Failure Not 
Completed

Run Failure with 
a comment

8 Creating 
Analysis Data

Run Failure Not 
Completed

Run Failure with 
a comment

9 Before Collating 
Results

Before Collating 
Results

Not 
Completed

Same

10 Before Creating 
Analysis Data

Before Creating 
Analysis Data

Not 
Completed

Same

11 Failed Collating 
Results

Failed Collating 
Results

Not 
Completed

Same

12 Failed Creating 
Analysis Data

Failed Creating 
Analysis Data

Not 
Completed

Same
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➤ Source File System (LRFS) <=> Target File System (Smart repository) 
changes: 

In the source file system (LRFS) all project files were located in the same 
folder with meaningful file names. In the new Smart Repository all 
project files are still located in the same folder but file names have no 
meaning—they are numbers.

13 Deleting 
Temporary 
Results

Finished Not 
Completed

With a comment

14 Temporary 
Results Deleted

Finished Not 
Completed

15 Failed Delete 
Results

Finished Not 
Completed

16 Deleted Deleted Migrate only to 
lab as deleted

17 Results Deleted Finished Not 
Completed

ID
Pre-Migration 
State

Migrated State
Migrated 
Status

Comments
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➤ Special characters change as a result of migration:

➤ In Performance Center the following characters are invalid:

➤ In ALM the following characters are invalid (depends on the entity):

Entity Invalid Characters

Script name Only "!" can be used. 

User cannot write any other special characters.

LT name /\<>.|:;!?&*#

MP name ;""&!@#$%*\/ 

Group name Only "!" can be used. 

User cannot write any other special characters.

User name :;&*\'/#~,?{}$%|<>+-=`@^()[]!

Project name ;:&*\"/#~?{}$%|<>+='@()[]^ 

Roles name </> 

Location name No special character can be used.

Host pools name :;"'<>%$&+`" 

Entity Invalid Characters

Test \/:\"?'<>|*% 

Resource \/:\"?'<>|*%!{} 

Library \/:*?\"<>| 

Project  =~`!@#$%^&*()+|{}()[]:'';"<>?,./\- 

Domain  =~`!@#$%^&*()+|{}()[]:'';"<>?,./\- 

Group ~`!@#$%^&*()+|{}[]:'';"<>?,/ 

User ()@\/[]'':|<>+=;",?*`%
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➤ If the project you are upgrading includes QuickTest tests, you must use 
the HP QuickTest Professional Asset Upgrade Tool to upgrade these tests 
for use with ALM Performance Center 11.00. This upgrade tool is installed 
with QuickTest Professional 11.00 on your Performance Center host or 
Standalone Load Generator machine. For more information, see the HP 
QuickTest Professional Asset Upgrade Tool for Quality Center Help (available 
from HP Software Self-solve knowledge base article KM910435 
(http://h20230.www2.hp.com/selfsolve/document/
KM910435)).

Tip: You must migrate each QuickTest test in each migrated project. You 
can verify which projects contain QuickTest tests by running the 
following SQL query on the migrated database:

SELECT DISTINCT(NAME) FROM COMPANIES WHERE COMPANYID IN 
(SELECT COMPANYID FROM SCRIPTS WHERE SCRIPTTYPE=5)

➤ If you experience problems with the migration process, check the 
database migration log file for any errors or relevant messages. The log file 
(log.txt) is located in the ..\<Migration tool 
Installation>bin\orchidtmp\LTLogger\ directory.

For example, if you installed the migration tool on the 
Performance Center Server machine, the log file is located at \<PC Server 
installation>\orchidtmp\LTLogger\
HP.PC.PCS.Configurator\log.txt.
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6 
Working with Firewalls

You can set up your Performance Center system to run Vusers and monitor 
servers over a firewall.

This chapter includes:

➤ About Using Firewalls in Performance Center on page 200

➤ Example: Over Firewall Deployment on page 202

➤ Setting Up the System to Use Firewalls: Basic Steps on page 203

➤ Installing Over-Firewall Components on page 205

➤ Initial Configuration of the Over-Firewall System on page 205

➤ Specifying MI Listeners in ALM on page 210
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About Using Firewalls in Performance Center

Working with a firewall means that you can prevent unauthorized access to 
or from a private network, on specific port numbers.

For example, you can specify that no access is allowed to any port from the 
outside world, with the exception of the mail port (25), or you can specify 
that no outside connection is allowed from any ports to the outside except 
from the mail port and WEB port (80). The port settings are configured by 
the system administrator.

In a regular performance test (not over a firewall), the Controller has direct 
access to the Performance Center agents running on remote machines. This 
enables the Controller to connect directly to those machines. 

When running Vusers or monitoring applications over a firewall, this direct 
connection is blocked by the firewall. The connection cannot be established 
by the Controller, because it does not have permissions to open the firewall. 

Performance Center solves this problem by using a communication 
configuration based on HTTPS or secured TCP/IP. This configuration uses 
the standard SSL port on the firewall (port 443). For more information on 
HTTPS and TCP/IP system configuration, see "Setting Up Your Deployment 
(TCP or HTTPS)" on page 206.
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A Performance Center agent is installed on load generators running Vusers 
over a firewall, and on Monitor Over Firewall machines that monitor the 
servers that are located over a firewall. The agent communicates with the 
MI Listener machine through port 443 in the firewall. 

The MI Listener is a component that serves as router between the Controller 
and the Performance Center agent. 

When the Performance Center agent connects to the MI Listener, the 
MI Listener keeps a listing of the connection to the agent using a symbolic 
name that the agent passed to it. 

When the Controller connects to the MI Listener, it communicates to the 
MI Listener through port 50500. 

The Controller uses a symbolic name for the agent, and provides the 
MI Listener machine’s name. If there has been a connection from the agent 
with the same symbolic name to this MI Listener, the connection is made 
between the Controller and the agent. Once you have a connection with the 
agent, you can run or monitor Vusers over a firewall. 
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Example: Over Firewall Deployment

The following diagram is a basic example of a Performance Center 
deployment over a firewall.  

As explained in the previous section, the Performance Center agent is 
installed on both the load generator machine and the Monitor Over Firewall 
machine. During installation, the Performance Center agent is added as a 
Windows service.

The MI Listener serves as a router between: 

➤ The agent on the load generator machine and the Controller, enabling 
the Controller to run Vusers over a firewall.

➤ The agent on the Monitor Over Firewall machine and the Controller, 
enabling the Controller to monitor the servers that are located over a 
firewall.
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Setting Up the System to Use Firewalls: Basic Steps

Setting up the system to use firewalls involves the following stages of 
configuration:

➤ Installation and initial configuration. Install the necessary components 
and perform initial configuration settings. For details, see "Installing 
Over-Firewall Components" on page 205, and "Initial Configuration of 
the Over-Firewall System" on page 205.

➤ Enabling running Vusers over a firewall. When there is a firewall between 
the Controller and load generator host machines, set up the system to run 
Vusers over the firewall. For details, see "Running Vusers Over a Firewall" 
on page 213.

➤ Enabling monitoring over a firewall. Set up your system to monitor the 
application under test (AUT) when there is a firewall between the 
Controller and the AUT. For details, see "Monitoring Over a Firewall" on 
page 219.

➤ Checking Connectivity. After installing and configuring all the necessary 
components, check that you are able to establish a connection between 
the Performance Center agent, the MI Listener, and the Controller 
machine. For details, see "Checking Connectivity" on page 240.
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The following flow chart provides a general outline of the steps that you 
need to perform to set up your system to work with firewalls.
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Installing Over-Firewall Components

To enable over-firewall communication, ensure that you have installed the 
following Performance Center components:

➤ MI Listener. Serves as a router between the Controller and the 
Performance Center agent. You install the MI Listener component on a 
dedicated machine. For installation instructions, see "Installing 
Standalone Components (Windows)" on page 80.

For instructions on configuring the MI Listener machine, see 
"Configuring the MI Listener" on page 208. 

➤ Monitor Over Firewall component. Used to monitor the servers that are 
located over a firewall. You install the Monitors over Firewall component 
on a dedicated machine. For installation instructions, see "Installing 
Standalone Components (Windows)" on page 80.

For information about configuring the Monitor Over Firewall machine, 
see "Monitoring Over a Firewall" on page 219. 

Initial Configuration of the Over-Firewall System

After you have installed the necessary components as described in 
"Installing Over-Firewall Components" on page 205, you are ready to 
configure your over-firewall system. 

To perform initial configuration of your over-firewall system:

 1 Configure the system according to TCP or HTTPS. 

See "Setting Up Your Deployment (TCP or HTTPS)" on page 206.

 2 Modify the firewall settings to enable communication between the 
machines on either side of the firewall. 

See "Configuring the Firewall to Allow Agent Access" on page 207.

 3 Configure the MI Listener. 

See "Configuring the MI Listener" on page 208.
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Setting Up Your Deployment (TCP or HTTPS)
To run Vusers or monitor servers over the firewall, configure your system 
according to one of the following configurations. Note that these 
configurations contain a firewall on each LAN. There may also be 
configurations where there is a firewall for the Over-Firewall LAN only.

➤ TCP Configuration

The TCP configuration requires every Performance Center agent machine 
behind the customer’s firewall to be allowed to open a port in the firewall 
for outgoing communication. 
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➤ HTTPS Configuration

In the HTTPS configuration, only one machine (the proxy server) is 
allowed to open a port in the firewall. Therefore it is necessary to tunnel 
all outgoing communications through the proxy server. 

Configuring the Firewall to Allow Agent Access
You modify your firewall settings to enable communication between the 
machines inside the firewall and machines outside the firewall. 

TCP Configuration

The Performance Center agent attempts to establish a connection with the 
MI Listener using port 443, at intervals specified in the Connection Timeout 
field in the Agent Configuration dialog box. To enable this connection, 
allow an outgoing connection for HTTPS service on the firewall for port 443. 
The agent can then connect to the MI Listener, and the MI Listener can 
connect back to the agent. From this point on, the agent listens to 
commands from the MI Listener.
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HTTPS Configuration

The Performance Center agent attempts to establish a connection with the 
MI Listener, using the proxy port specified in the Proxy Port field, and at 
intervals specified in the Connection Timeout field in the Agent 
Configuration dialog box. When the connection is established, the proxy 
server connects to the MI Listener. To enable this connection, allow an 
outgoing connection for HTTPS service on the firewall for port 443. The 
proxy server can then connect to the MI Listener, and the MI Listener can 
connect back to the agent through the proxy server. From this point on, the 
agent listens to commands from the MI Listener.

Configuring the MI Listener
To enable running Vusers or monitoring over a firewall, you need to install 
the MI Listener on one or more machines in the same LAN as the Controller 
outside the firewall. For installation instructions, see, Chapter 2, "Installing 
Standalone Components (Windows)."

Note: When installing the MI Listener:

➤ The MI Listener must be installed on a dedicated machine.

➤ Make sure that IIS is not running on the MI Listener or Monitor Over 
Firewall machine. IIS uses port 443 and does not allow the access 
required by the listening and monitoring processes.
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To configure the MI Listener:

 1 Open incoming HTTPS service for port 443. The port settings are set by 
your system administrator.

 2 Stop the Performance Center agent by right-clicking its icon in the system 
tray and selecting Close.

 3 Select Start > Programs > Performance Center > Advanced Settings > 
MI Listener Configuration, or open
<Performance Center root>\launch_service\bin\MILsnConfig.exe.
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 4 Set each option as described in the following table:

Click OK to save your changes or Use Defaults to use the default values.

 5 Restart the Performance Center agent from Start > Programs > 
HP Performance Center.

Specifying MI Listeners in ALM

In Lab Management, you specify one or more MI Listeners to enable 
running Vusers or monitoring data over a firewall.

To add an MI Listener:

 1 On the Lab Management sidebar, under Lab Resources, select 
MI Listeners.

 2 In the MI Listeners module, click the New MI Listener button. The New 
MI Listener dialog box opens.

Option
Default 
Value 

Description

Check Client Certificates False Select True to request that the client 
send an SSL certificate when 
connecting, and to authenticate the 
certificate.

Private Key Password None The password that may be required 
during the SSL certificate 
authentication process.
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 3 Enter the following details:

 4 Click OK. The MI Listener is added to the table.

Field Description

Description A description of the MI Listener.

MI Listener IP The IP address of the MI Listener. 

Note: If you have two different IP addresses for the 
same MI Listener—one for internal communication 
with the Controller and a second for public 
communication with a load generator located over a 
firewall—enter the internal IP address here. Enter the 
public IP address in the MI Listener Name field (see 
below).

MI Listener Name The name of the MI Listener.

Note: If you have two different IP addresses for the 
same MI Listener—one for internal communication 
with the Controller and a second for public 
communication with a load generator located over a 
firewall—enter the public IP address here. Enter the 
internal IP address in the MI Listener IP field (see 
above).

Purpose The role designated to the MI Listener: 

➤ Diagnostics data collection over a firewall

➤ Monitoring over a firewall

➤ Running Vusers over a firewall



Chapter 6 • Working with Firewalls

212



213

7
Running Vusers Over a Firewall

You can set up Performance Center to run Vusers over a firewall.

This chapter includes:

➤ Running Vusers Over a Firewall: Basic Steps on page 214

➤ Configuring Hosts to Run Vusers Over a Firewall on page 216
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Running Vusers Over a Firewall: Basic Steps

Note: Before you configure your system to run Vusers over the firewall, 
ensure that you have completed the configuration steps described in "Initial 
Configuration of the Over-Firewall System" on page 205.
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To run Vusers over a firewall:

 1 In Lab Management, specify the details of the MI Listener that will be 
used to run Vusers over the firewall. For details, see "Specifying MI 
Listeners in ALM" on page 210.

 2 Configure the Performance Center agent on each load generator machine 
that will run over a firewall to communicate with the MI Listener.

For information on how to configure the Performance Center agent, see 
"Configuring the Performance Center Agent" on page 231.

Note: After you configure the Performance Center agent on the load 
generator machine, you can edit the configuration settings from Lab 
Management. For more information, see the HP ALM Performance Center 
Guide. 

 3 In Lab Management, configure the relevant load generator hosts to run 
over a firewall. For details, see "Configuring Hosts to Run Vusers Over a 
Firewall" on page 216.
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Configuring Hosts to Run Vusers Over a Firewall

To use a Performance Center host to run Vusers over a firewall, you need to 
configure the relevant hosts as load generators in Lab Management. 

Part of the process of configuring a Performance Center host involves 
selecting a location for your host. For example, locations can be defined 
according to physical areas. The location also determines whether the host 
is located over a firewall.

Before you configure the host, you need to ensure that you have added a 
location over a firewall. When you are configuring a host to operate over a 
firewall, you select a location that is located over a firewall.

This section describes the basic steps of how to add a host as a load 
generator for running Vusers over a firewall. For detailed information about 
adding hosts in Performance Center, refer to the HP ALM Performance Center 
Guide.

To configure a host to run Vusers over a firewall:

 1 Add the location that is over a firewall.

 a On the Lab Management sidebar, under Lab Resources, select 
Locations. 

 b In the Host Locations module, and click the New Host Location 
button. The New Host Location dialog box opens.

 c Enter the following details:

Field Description

Description A description of the host location.

Location Name The name of the host location. The name should have 
a logical connection to the host location

Over Firewall Indicates whether the host location is over a firewall or 
not.
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 2 Add the over-firewall host.

 a On the Lab Management sidebar, under Lab Resources, select Hosts. 

 b In the Host module, click the New Host button. The New Host dialog 
box opens.

 c Enter the following details:

Field Description

Belongs to Pools The host pools to which the host is assigned. 

Host pools enable you to control which hosts are 
allocated to which projects. 

Description A description of the host.

Host Attributes Attributes of the host.

Example: Memory, strength, installed components

Installation Indicates the type of host installation.

For a standalone installation of the load generator, 
select Windows Standalone LG. 

Location The location of the host that is over the firewall.

MI Listener The IP address or name of the MI Listener that 
enables data collection.

If no MI Listener is found, it means that the Load 
Generator Performance Center Agent was not 
correctly configured to operate over a firewall. In this 
case, you need to manually select an MI Listener from 
the MI Listener list and then configure the 
Performance Center Agent on the load generator 
machine to operate over a firewall. 

For more information about configuring the 
Performance Center Agent to operate over a firewall, 
see Chapter 9, "Configuring the Performance Center 
Agent." 

Name The fully qualified domain name or IP address of the 
host that was assigned when creating the host.
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Password The password of the Performance Center system user 
on the host machine.

Priority A rank assigned to the host. The higher the priority 
you give the host, the more likely the host will be 
allocated to a test. There are a number of criteria to 
consider when assigning priority. The main 
considerations are whether the host is a dedicated 
machine or a shared resource, and the type of 
hardware installed on the machine.

Purpose A host over a firewall can only have a load generator 
purpose.

Enable SSL Indicates whether the load generator is to 
communicate with the Controller via SSL (Secure 
Socket Layer) or not. This option is available when 
the load generator is located over a firewall.

Note: The load generator uses SSL to communicate 
with the Controller during run time only. For non 
runtime functionality (including collating results), 
the load generator does not use SSL as the 
communication protocol.

Status The status of the host. An indicator is displayed next 
to the host name, reprsenting its current status.

The possible statuses are: 

➤ Operational. The host machine is up and running.

➤ Non-operational. The host machine is down.

➤ Unavailable. There is no information available 
about the status of the host.

User Name The user name of the UNIX load generator machine.

Field Description
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8 
Monitoring Over a Firewall

You can set up Performance Center to monitor servers over a firewall.

This chapter includes:

➤ Monitoring Over a Firewall: Basic Steps on page 220

➤ Configuring Monitor Settings on page 222

➤ Configuring the Project to Receive Monitor Over Firewall  Information 
on page 228

➤ Editing Monitor Over Firewall Machines During a Test Run on page 229
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Monitoring Over a Firewall: Basic Steps

Note: Before you configure your system to monitor servers over a firewall, 
ensure that you have completed the configuration steps described in "Initial 
Configuration of the Over-Firewall System" on page 205.



Chapter 8 • Monitoring Over a Firewall

221

To set up your system to monitor servers over a firewall:

 1 In Lab Management, specify the details of the MI Listener that will be 
used to monitor servers over the firewall. For details, see "Specifying MI 
Listeners in ALM" on page 210.

 2 Configure the Performance Center agent on each Monitor Over Firewall 
machine to communicate with the MI Listener.

For details, see "Configuring the Performance Center Agent" on page 231.

 3 Use the Monitor Configuration tool to configure the servers to monitor 
and define specific measurements that Performance Center collects for 
each monitored server.

For details, see "Configuring Monitor Settings" on page 222.

 4 In the relevant project, establish a connection between the tests you are 
running and the Monitor Over Firewall machines.

For details, see "Configuring the Project to Receive Monitor Over Firewall  
Information" on page 228.
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Configuring Monitor Settings

You configure the monitor settings from the Monitor Over Firewall 
machine, using the Monitor Configuration tool. You select the type of 
monitors to run and the server whose resources you want to monitor, add 
the measurements to monitor for each server, and specify the frequency at 
which the monitored measurements are to be reported.

To configure monitor settings:

 1 On the Monitor Over Firewall machine, choose Start > Programs > 
HP LoadRunner > Advanced Settings > Monitor Configuration. For 
machines without the complete Performance Center installation, choose 
Start > Programs > Server Monitor > Monitor Configuration. The Monitor 
Configuration dialog box opens.
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 2 Click the Add Server button. The New Monitored Server Properties dialog 
box opens.

 3 In the Monitored Server box, type the name or IP address of the server 
whose resources you want to monitor. 

Note: To add several servers simultaneously, you can specify IP ranges, or 
separate the server names or IP ranges with commas. For example, 
255.255.255.0-255.255.255.5, or server1, server2.

 4 From the Available Monitors list, select the monitors suitable for the 
server being monitored. 
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 5 Click OK to close the New Monitored Server Properties dialog box. The 
Monitored Servers list is displayed in the Monitor Configuration dialog 
box. 

Default measurements are displayed for some of the monitors in the 
Measurements to be Monitored section. You can specify the frequency at 
which to report the measurements in the Measurement Properties 
section. 

 6 To add additional monitored servers to the list, repeat steps 2 through 5.

 7 To edit the monitor configuration properties for a server, click the Edit 
button. The Monitored Server Properties dialog box opens enabling you 
to edit the monitors for the server whose resources you are monitoring.

 8 Click Apply to save your settings.
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Cloning a Monitored Server’s Properties
To monitor the same properties on different server machines, you can clone 
a selected server’s properties using the Clone Monitored Server Properties 
dialog box.

To clone a monitored server’s properties:

 1 Open the Monitor Configuration dialog box.

 2 Right-click the server you want to clone, and select Clone. The Clone 
Monitored Server Properties dialog box opens.

 3 In the Monitored Server box, type the name or IP address of the cloned 
server you want to create. 

Tip: To create several cloned servers simultaneously, you can specify IP 
ranges, or separate the server names or IP ranges with commas. For 
example, 255.255.255.0-255.255.255.5, or server1, server2.
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 4 The Available Monitors list displays the monitors that were selected for 
the server being cloned. Select additional suitable monitors for the cloned 
server. 

 5 Click OK to close the Clone Monitored Server Properties dialog box. The 
cloned server is displayed in the Monitored Servers list.

 6 Click Apply to save your settings.

Adding and Removing Measurements 
After you configure one or more server machines to monitor, you add 
measurements to monitor for each server. If Performance Center added 
default measurements, you can edit them as required.

To add a measurement to monitor:

 1 Open the Monitor Configuration dialog box.

 2 Select a server from the Monitored Servers list.

 3 Click the Add Measurement button. Select the appropriate monitor. A 
dialog box opens, enabling you to choose measurements for the monitor 
you selected.

 4 Select the measurements that you want to monitor, and click OK.

 5 Click Apply to save your settings.

To remove a measurement from the measurements list:

 1 Select the measurement, and click the Delete button. 

 2 Click Apply to save your settings.
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Configuring Measurement Frequency 
After you have configured monitor measurements, you set a schedule for 
reporting each measurement.

To configure measurement frequency:

 1 In the Monitor Configuration dialog box, under the Measurement 
Properties section, select the configured server measurement you want to 
schedule.

 2 Specify the frequency at which you want Performance Center to report 
the measurement.

 3 Click Apply to save your settings.
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Configuring the Project to Receive Monitor Over Firewall 
Information

After you configure the monitors, you configure the project to receive 
Monitor Over Firewall information during performance test runs.

Note: The steps in the section are described in more detail in the section 
about monitor profiles in the HP ALM Performance Center Guide. 

To configure the project to receive Monitor Over Firewall information:

 1 Add a monitor over firewall which can be accessed by performance tests 
in this project.

 a On the ALM sidebar, select Test Resources.

 b In the Test Resources module, right-click and select New Resource.

 c In the Type box, select Monitor Over Firewall. 

 d Enter a name, the machine key, and select the MI Listener with which 
the monitor is to connect. 

 2 Select the Monitor Over Firewall agent to use in a specific performance 
test.

 a In the Test Plan module, right-click a performance test, and click Edit 
Test to open the test in the Performance Test Designer window.

 b In the Monitors tab, select the Monitor Over Firewall agent. 
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Editing Monitor Over Firewall Machines During a Test Run

While a performance test is running, you can change the status of a Monitor 
Over Firewall agent or add another monitor to the test.

To modify the Monitor Over Firewall machines:

 1 On the Test Run page, click the Design button. The Performance Test 
Designer window opens.

 2 Click Settings. The Settings dialog box opens. 

 3 In the Server Monitors tab, you can view the Monitor Over Firewall 
agents that are monitoring the test, as well as their connection status. 

➤ To connect or disconnect a Monitor Over Firewall agent, click the 
Connect/Disconnect button.

➤ To add a Monitor Over Firewall agent to the test, select it from the Add 
Monitor Over Firewall list.

 4 Click OK.

 5 Click Close to close the Settings dialog box.
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9 
Configuring the Performance Center 
Agent

You can set up your Performance Center system to run Vusers and monitor 
servers over a firewall. As part of the process of setting up your 
Performance Center system to work over firewalls, you configure the 
Performance Center agent.

This chapter includes:

➤ About Configuring Performance Center Agents Over the Firewall 
on page 232

➤ Configuring the Windows Performance Center Agent on page 233

➤ Configuring and Running the UNIX Performance Center Agent 
on page 235

➤ Agent Configuration Settings on page 237

➤ Checking Connectivity on page 240
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About Configuring Performance Center Agents Over the 
Firewall

As part of the process of setting up your Performance Center system to work 
over firewalls, you configure the Performance Center agent on each load 
generator machine that will be running over a firewall and on each Monitor 
Over Firewall machine.

You configure the Performance Center agent to communicate with the 
MI Listener. The MI Listener serves as a router between the 
Performance Center agent and the Controller.
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Configuring the Windows Performance Center Agent

This section describes how to configure the Performance Center Agent on 
Windows machines to communicate with the MI Listener.

To configure the Performance Center agent on Windows machines:

 1 Select Start > Programs > Performance Center > Advanced Settings > 
Agent Configuration, or run 
<Performance Center root>\launch_service\bin\AgentConfig.exe.

The Agent Configuration dialog box opens.

 2 Select Enable Firewall Agent.

 3 Click Settings. The Agent Configuration dialog box displays a list of 
settings.
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 4 Set each option as described in "Agent Configuration Settings" on 
page 237. Pay careful attention to the first three settings.

Note: When specifying the Local Machine Key, you must use the format 
hostname_locationname where hostname is the name of the host, as 
defined in the Hosts module in Lab Management, and locationname is the 
name of the host location, as defined in the Host Location module.

 5 Click OK to save your changes.

 6 When prompted, click OK to restart the Performance Center agent.

 7 Check the connection status between the Performance Center agent and 
the MI Listener. 

An illuminated green light next to the Performance Center Agent icon in 
the system tray indicates a successful connection between the agent and 
the MI Listener. A red light indicates that there is no connection between 
the agent and the MI Listener.

Notes:

➤ When you configure the Performance Center agent on Windows 
machines, the Remote Management agent is automatically configured 
with the same settings. The Remote Management agent enables you to 
manage remote machines from Lab Management or from ALM.

➤ After you have configured the Performance Center agent on the load 
generator machine, you can edit the configuration settings from Lab 
Management. For more information, see the HP ALM Performance Center 
Guide.
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Configuring and Running the UNIX Performance Center 
Agent

Load generator hosts can be installed on UNIX machines. This section 
describes how to configure and run Performance Center agents on UNIX 
machines.

Note: As part of the process of configuring the Performance Center Agent on 
UNIX machines, you also need to configure the Remote Management agent. 
The Remote Management agent enables you to manage remote machines 
from Lab Management or from ALM.

To configure the Performance Center Agent on UNIX machines:

 1 Activate the firewall service for the Performance Center agent:

 a Open <Performance Center root folder>/dat/br_lnch_server.cfg in a 
text editor.

 b In the Firewall section, set FireWallServiceActive to 1 and save your 
changes.

 2 Activate the firewall service for the Remote Management agent:

 a Open <Performance Center root folder>/al_agent/dat/
br_lnch_server.cfg in a text editor.

 b In the Firewall section, set FireWallServiceActive to 1 and save your 
changes.

 3 Run agent_config from the <Performance Center root folder>/bin 
directory and enter the agent configuration settings (see "Agent 
Configuration Settings" on page 237).

Note: When you set the agent configuration settings, they are applied to 
both the Performance Center and Remote Management agents.
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 4 Restart the Performance Center agent for the configuration changes to 
take effect.

 a To stop the Performance Center agent, run the following command 
from the <Performance Center root folder>/bin directory:

 

 b To start the Performance Center agent, run the following command 
from the <Performance Center root folder>/bin directory:

 

Note: When the Performance Center agent is configured to run over a 
firewall, and the agent is connected to the MI Listener, a file called 
<local_machine_key>_connected_to_MI_Listener is created in the 
temporary directory of the Performance Center agent machine. This file is 
deleted when the Performance Center agent disconnects from the MI 
Listener.

 5 Restart the Remote Management agent for the configuration changes to 
take effect.

 a To stop the Remote Management agent, run the following command 
from the <Performance Center root folder>/al_agent/bin directory:

 

 b To start the Remote Management agent, run the following command 
from the <Performance Center root folder>/al_agent/bin directory:

 

m_daemon_setup -remove

m_daemon_setup -install 

al_daemon_setup -remove 

al_daemon_setup -install 



Chapter 9 • Configuring the Performance Center Agent

237

Agent Configuration Settings 

The following table provides an explanation of the agent configuration 
settings:

Setting Default Value Description

MI Listener name none The name, full name, or IP address 
of the MI Listener.

Local Machine Key none A symbolic string identifier used 
to establish a unique connection 
between the Controller host and 
the agent machine, via the MI 
Listener machine.

When configuring to monitor 
over a firewall, you can enter any 
logical name, using lowercase 
letters only.

When configuring to run Vusers 
over a firewall, you must use the 
format hostname_locationname 
where:

➤ hostname is the name of the 
host as found in Lab 
Management’s Hosts module.

➤ locationname is the name of the 
host location as found in Lab 
Management’s Host Locations 
module.

Connection Timeout 
(seconds)

20 seconds The length of time you want the 
agent to wait before retrying to 
connect to the MI Listener 
machine. If zero, the connection 
is kept open from the time the 
agent is run.

MI Listener User Name none The user name needed to connect 
to the MI Listener machine.
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MI Listener Password none The password needed to connect 
to the MI Listener machine.

Server Domain none The domain name needed to 
connect to the MI Listener 
machine. This field is required 
only if NTLM is used.

Connection Type - 
TCP/HTTP

TCP Select either TCP or HTTP, 
depending on the configuration 
you are using.

Connection Type - 
HTTP Proxy Name

none The name of the proxy server. This 
field is mandatory if the 
Connection Type setting is HTTP.

Connection Type -
HTTP Proxy Port

none The proxy server connection port. 
This field is mandatory if the 
Connection Type setting is HTTP.

Connection Type - 
HTTP Proxy User Name

none The user name of a user with 
connection rights to the proxy 
server.

Connection Type - 
HTTP Proxy Password

none The password of the user with 
connection rights to the proxy 
server.

Connection Type - 
HTTP Proxy Domain

none The user’s domain if defined in 
the proxy server configuration. 
This option is required only if 
NTLM is used.

Use Secure Connection 
(SSL)

disabled Enable to connect using the 
Secure Sockets Layer protocol.

Setting Default Value Description
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Use Secure Connection 
(SSL) - Check Server 
Certificates

none Authenticates the SSL certificates 
that are sent by the server. Select 
Medium to verify that the server 
certificate is signed by a trusted 
Certification Authority. Select 
High to verify that the sender IP 
matches the certificate 
information. This setting is 
available only if Use Secure 
Connection is set to True. 

Use Secure Connection
(SSL) - Private Key 
Password

none The password that might be 
required during the SSL certificate 
authentication process. This 
option is relevant only if the 
Client Certificate Owner option is 
enabled.

Use Secure Connection
(SSL) - Use Client 
Certificate

disabled Enables you to upload the SSL 
certificate (if required by the 
server to allow the connection to 
be made). This option is relevant 
only if the Use Secure Connection 
option is enabled.

Setting Default Value Description
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Checking Connectivity

To run Vusers or monitor servers over a firewall, you must be able to 
establish a connection between the Performance Center agent, MI Listener, 
and the Controller machine. 

If you encounter connectivity problems after installing and configuring all 
the necessary components, check the table below for troubleshooting tips. 

Check Solution

To check that the Firewall 
service was activated on the 
agent machine:

There should be a traffic light to the right side 
of the Performance Center Agent icon on the 
machine running/monitoring Vusers over a 
firewall. If there is no traffic light, this 
indicates that the FirewallServiceActive=1 is 
not set in the [FireWall] section of the Agent 
Settings. For details, see "About Configuring 
Performance Center Agents Over the Firewall" 
on page 232.

To check that port 443 is open: On the agent machine, open a command 
prompt window, and type the following: 
telnet <MI_Listener_IP> 443. 
For example: telnet 111.111.111.1111 443. 
If port 443 is open, a new Telnet window 
opens. If port 443 is not open, contact your 
network administrator. 

To check that port 443 is 
available:

If a Web server is running on the MI Listener 
or Monitor Over Firewall machine, port 443 
does not allow the access required by the 
listening and monitoring processes. Contact 
your network administrator to change the 
Web server port.
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To check connectivity between 
the agent and the MI Listener, 
when running the 
Performance Center agent as a 
service:

If there is a red light to the right of the 
Performance Center agent icon  when 
running the Performance Center agent as a 
service, do the following:

➤ Check that port 443 is open. See above.

➤ Check that the Agent Settings and Agent 
Configuration are correctly set. For details, 
see "About Configuring 
Performance Center Agents Over the 
Firewall" on page 232.

➤ Run the agent as a process by launching 
Installation>\Launch_service\bin\magent
proc.exe. If you are successful, this 
indicates an authentication issue with the 
Performance Center Agent Service. Browse 
to the Service > Performance Center Agent 
Service and change the properties of this 
service to System User Account, or provide 
the username and password of a user who 
has administrative privileges on this 
machine.

Check Solution
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10
Troubleshooting Installation

This chapter provides troubleshooting for issues that arise when installing 
ALM Performance Center 11.00 components, when migrating data from 
earlier versions of Performance Center, and during initial configuration.

This chapter includes:

➤ HP ALM patch installation fails on Windows 2003 on page 247

➤ Cannot run the Performance Center Extension installation on page 248

➤ After Performance Center Extension deployment, the configuration tool 
does not run on page 248

➤ The application cannot locate an extension with path  
\Extensions\PCProject.qcx on page 249

➤ During Performance Center Server setup, installation of a prerequisite 
fails on page 249

➤ Performance Center Server installation cannot be completed: IIS is not 
installed on page 251

➤ Cannot connect to Performance Center Server or Host on page 251

➤ Failed to add Performance Center Server to Lab Management during 
Performance Center Server configuration on page 253

➤ Performance Center Server cannot be added to ALM due to mismatch in 
Communication Security Passphrase on page 255

➤ Performance Center host cannot be added to Lab Management, or is non-
operational, due to mismatch in Communication Security Passphrase 
on page 256

➤ Cannot add hosts to Lab Management / Cannot start LTOP service on 
host machine on page 257
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➤ Connection to Controller failed when starting a run and the online run 
screen did not load on page 258

➤ Uninstall of host failed or has frozen on page 258

➤ Patch Installation Fails on page 259

➤ Installing a patch requires you to stop the Performance Center Load 
Testing Service on the host machine on page 260

➤ Cannot launch ALM: Message that software not installed on page 261

➤ Cannot log in to Performance Center via the client machine: Error 
regarding JavaScript on page 261

➤ When starting a test run, the host is added, but the Initializing Run page 
does not load on page 262

➤ Cannot run Performance Center component installation from a network 
drive on page 262

➤ Installing Performance Center components does not start when selecting 
them from the DVD menu on page 264

➤ Installing one of the Performance Center components cannot use default 
port. Port already in use. on page 264

➤ Cannot connect to the hosts using IUSR_METRO user  with the 
MIOrchid#1 password on page 266

➤ Errors in the Migration Tool Report on page 267

➤ Cannot Connect to Oracle Database on 64-bit Windows OS on page 268

➤ Cannot Migrate a Project Again Because it Cannot be Deleted on page 269

➤ Errors in the Migration Log on page 270

➤ A Migrated Project is not Linked to a PC_PROJECT_TEMPLATE Project 
After the Migration on page 270

➤ Migration Tool Logs on page 272

➤ Migration Tables Not Found on page 274

➤ Migration Tool Report Data Not Found on page 275

➤ Error When Opening Timeslot Module and Saving a Performance Test 
on page 276
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HP ALM patch installation fails on Windows 2003

One of following errors is displayed:

➤ Failed to resolve source. The installation source for this product is not 
available. Verify that the source exists and that you can access it.

➤ File was rejected by digital signature policy.

Troubleshooting

A detailed explanation of the issue and hotfix provided by Microsoft can be 
found at the following URL: http://support.microsoft.com/kb/925336.
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Cannot run the Performance Center Extension installation

This problem occurs when you run the installation from a network path.

Troubleshooting

Do one of the following:

➤ On the network drive, run the runPcQcConfigurator.bat script located in 
the following folder: HP ALM Performance Center 11.00 DVD\Setup\
Install\ALM Extension\Configurator.

➤ Install NET Framework 3.5 SP1 before running the setup.

After Performance Center Extension deployment, the 
configuration tool does not run

After deploying the Performance Center Extension, the Performance Center 
Extension configuration tool that creates Lab Management does not run. 

Troubleshooting:

The configuration tool cannot run if the JBoss service is down. Even if you 
started the JBoss service at the end of the Performance Center Extension 
deployment, it is possible that the service did not start. In this case, you 
need to redeploy the Performance Center Extension, and start the JBoss 
service manually.

 1 Run the Performance Center Extension deployment again from: 

 2 In the last step of the deployment tool, you are prompted to start the 
JBoss service—this option is selected by default. Clear the check box and 
start service manually as follows:

 a Select Start > Run and type Services.msc.

 b Start the HP Application Lifecycle Management service.

<PC Server DVD>\Setup\Install\ALM Extension\Configurator\
runPcQcConfigurator.bat
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 3 Click Finish to complete the deployment phase. The Configuration tool 
that creates Lab Management schema opens. Continue with the 
instructions described in "Deploying the Performance Center Extension" 
on page 45.

The application cannot locate an extension with path 
\Extensions\PCProject.qcx

The following error is displayed when running the HP ALM Platform 
Extension Deployment Wizard: 

The application cannot locate an extension with path 
\Extensions\PCProject.qcx.

Troubleshooting

This error occurs when the user copies the Performance Center extensions 
locally and runs the configuration tool. Extension deployment fails if both 
the configuration tool and extensions folders were not copied.

To resolve this issue:

 1 Copy both configuration tool and the extensions folder to the same 
location.

 2 Run runPcQcConfigurator.bat from the configuration tool folder.

During Performance Center Server setup, installation of a 
prerequisite fails

Some of the system components require installation of various software as a 
prerequisite to successful setup of the component.

For example, the setup of the Performance Center Server requires an 
installation of WSE 2.0. This installation may fail during installation of 
Performance Center components.
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Example of the error:

 

Troubleshooting

Component setup uses MSI. This error is often related to problems with the 
MSI engine. 

Restart the machine and try again. If the problem persists, contact 
Microsoft. 

For more information, see the following Microsoft knowledge base articles: 
http://support.microsoft.com/kb/315346 and 
http://social.technet.microsoft.com/Forums/en/officesetupdeploy/thread/83b157
08-b22e-4744-8c6d-375bf1cf7d6f

http://social.technet.microsoft.com/Forums/en/officesetupdeploy/thread/83b15708-b22e-4744-8c6d-375bf1cf7d6f
http://social.technet.microsoft.com/Forums/en/officesetupdeploy/thread/83b15708-b22e-4744-8c6d-375bf1cf7d6f
http://support.microsoft.com/kb/315346
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Performance Center Server installation cannot be 
completed: IIS is not installed

The Performance Center Server installation did not complete successfully. 
The virtual directories are not created on the Performance Center Server.

Troubleshooting

This error occurs when IIS is not installed prior to installation of the 
Performance Center Server.

 1 Complete the Performance Center Server installation by skipping the 
ALM Platform and Performance Center Server configuration steps.

 2 Install IIS.

 3 Run Performance Center Server Configuration Tool from:

Start > Program Files > HP Performance Center Server > Tools > 
HP Performance Center Server Configuration Wizard

 4 (Optional) Set Performance Center and Performance Center Host license 
keys.

Cannot connect to Performance Center Server or Host

Connection issues may cause different errors.

These include:

➤ Inability to add Performance Center Server to the system

➤ Inability to add Performance Center Host to the system

➤ Cannot view Performance Center web pages (for example: License page, 
Performance Test Designer, and so on)

Troubleshooting

➤ Make sure a network connection is available from one machine to the 
other. To check connectivity, make sure you can ping from one machine 
to another, or alternatively use telnet <port number>.
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➤ Verify all servers (ALM Platform, Performance Center Servers and 
database server) and Performance Center hosts are configured with the 
same time and time zone. A difference in the date and time of the servers 
may cause various exceptions and errors. We recommend synchronizing 
all machines with the domain server or time server.

➤ Make sure that the Communication Security passphrase on the 
Performance Center Server and Performance Center hosts match the 
passphrase defined on the ALM Platform in Site Administration. 

For more information see the following:

➤ "Performance Center Server cannot be added to ALM due to mismatch 
in Communication Security Passphrase" on page 255. 

➤ "Performance Center host cannot be added to Lab Management, or is 
non-operational, due to mismatch in Communication Security 
Passphrase" on page 256.

➤ For the Performance Center Server: Make sure that IIS is up and running. 
For more details, see "Failed to add Performance Center Server to 
Lab Management during Performance Center Server configuration" on 
page 253.

➤ For hosts, see "Cannot add hosts to Lab Management / Cannot start LTOP 
service on host machine" on page 257.
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Failed to add Performance Center Server to 
Lab Management during Performance Center Server 
configuration

Cannot connect the Performance Center Server to Lab Management during 
Performance Center configuration.

The following error is displayed:

Troubleshooting

➤ Check that the Performance Center Server is up and running. 

➤ Check that IIS is running.

The error may occur if IIS on the Performance Center Server is in Stopped 
mode.

 a On the Performance Center Server machine open the IIS Manager: 
Select Start > Run and enter inetmgr. IIS Manager opens. 

 b In the IIS Manager, select Web Sites > Default web site, and make sure 
that IIS is running. If not, click the Reset button.

 c In Lab Management, add the Performance Center Server to the system. 
For details see the HP ALM Performance Center Guide.

➤ Modify the configuration files.

 a Identify the following configuration files:

➤ C:\Windows\Microsoft.NET\Framework\v2.0.50727\aspnet.config

➤ C:\Windows\Microsoft.NET\Framework\v2.0.50727\CONFIG\
machine.config
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 b Open each configuration file. Under the <configuration> element, add 
the following: 

If the </runtime> element already exists, you must replace it with the 
above.

➤ Check that port 80 is open.

The Performance Center Server connects by default through port 80.

 a On ALM Platform, select Start > Run and enter the following:

 b If the connection was not established, open port 80 or change the 
Default web site port and set the new port in the external and internal 
Performance Center Server URL. For information about changing the 
external and internal Performance Center Server URL, see the 
HP ALM Performance Center Guide.

<runtime>
<generatePublisherEvidence enabled="false"/>
</runtime>

telnet <PC_Server_machine_Name> 80
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Performance Center Server cannot be added to ALM due to 
mismatch in Communication Security Passphrase

The Communication Security passphrase on the Performance Center Server 
and the ALM Platform do not match and the servers cannot communicate.

Troubleshooting

This can occur if an incorrect Communication Security passphrase was 
provided during the initial configuration of the Performance Center Server, 
or if the passphrase on the ALM Platform was changed.

To solve the mismatch, update the Communication Security passphrase on 
the ALM Platform and on the Performance Center Server.

To update the Communication Security passphrase on the ALM Platform:

 1 Log in to Site Administration.

 2 In the Site Configuration tab, update the 
COMMUNICATION_SECURITY_PASSPHRASE parameter.

 3 Restart the HP Application Lifecycle Management service on the 
ALM Platform server.

To update the Communication Security passphrase on the 
Performance Center Server:

 1 On the machine where the Performance Center Server is installed, run the 
Performance Center Server Configuration Wizard:

Start > Program Files > HP Performance Center Server > Tools > 
HP Performance Center Server Configuration Wizard

 2 On the Communication Security page, enter the new Communication 
Security passphrase.

 3 Click Next on all of the subsequent wizard pages and Finish to close the 
wizard.
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Performance Center host cannot be added to Lab 
Management, or is non-operational, due to mismatch in 
Communication Security Passphrase

The Communication Security Passphrase should be the same on both the 
host and the Performance Center Server. The mismatch may occur if you 
run the Host Configuration wizard, since this wizard resets the 
Communication Security Passphrase value.

Troubleshooting

Check that both the host and the Performance Center Server have the same 
Communication Security Passphrase value. If the values are not the same, 
you can change them in one of two ways: Directly on the 
Performance Center Server or host, or by reconfiguring the 
Performance Center Server or host from Lab Management:

➤ From Lab Management. For information about reconfiguring 
Performance Center Servers and hosts, see the HP ALM Performance Center 
Guide.

➤ Directly on the Performance Center Server. On the Performance Center 
Server, navigate to the PCS.config file as follows: <Performance Center 
Server path>\dat\PCS.config. Under the <appSettings> tag, the value 
appears by the LW_CRYPTO_INIT_STRING key.

For information about how to configure the Communication Security 
Passphrase via the Performance Center Server Configuration Wizard, see 
"Performance Center Server cannot be added to ALM due to mismatch in 
Communication Security Passphrase" on page 255.

➤ Directly on the host. On the host, navigate to the LTS.config file as 
follows: <Performance Center Host path>\dat\LTS.config. Under the 
<appSettings> tag, the value appears by the LW_CRYPTO_INIT_STRING 
key.



Chapter 10 • Troubleshooting Installation

257

Cannot add hosts to Lab Management / Cannot start LTOP 
service on host machine

You cannot add hosts to the system if the Performance Center Load Testing 
Service is not running.

Note: This issue does not arise if you add the host to Lab Management after 
installing HP ALM Performance Center 11.00 Patch01.

Troubleshooting

 1 Modify the host installation configuration files.

 a Identify the following configuration files in the host installation 
directory (<Performance Center installation dir>\bin\):

➤ LTOPSvc.exe.config

➤ HP.PC.LTOP.QCOTAOperationServiceWrapper.exe.config

➤ HP.PC.AnalysisWrapper.exe.config

➤ Collator.exe.config

➤ Wlrun.exe.config

 b Open each configuration file. Under the <configuration> element, add 
the following:

If the </runtime> element already exists, you must replace it with the 
above.

 2 Restart the Performance Center Load Testing Service.

 a Select Start > Run, and type services.msc. The Services window opens.

 b In the services list, right-click Performance Center Load Testing and 
select Start.

<runtime>
<generatePublisherEvidence enabled="false"/>
</runtime>
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Connection to Controller failed when starting a run and 
the online run screen did not load

A connection to a Controller must be made during run initialization in 
order to start the test. The initialization screen shows that the connection 
failed and as a result the online run screen did not open.

Troubleshooting

➤ Check the Performance Center Server names and make sure they are 
recognized by the host.

➤ If the Performance Center Server and host are in separate domains, use 
fully qualified names.

➤ When using machine names, make sure the Performance Center Server 
and host belong to the same domain.

To verify that the Performance Center server is recognized by the host, 
perform the following steps on each host:

 1 Open the Host machine.

 2 Open the Hosts file from C:\windows\system32\drivers\etc\hosts.

 3 Add Performance Center Server machine name and IP to this file.

Uninstall of host failed or has frozen

This error may present itself in various ways:

➤ Uninstall of the Performance Center host did not complete successfully.

➤ Uninstall of the Performance Center host is taking a long time and seems 
to have frozen.

➤ When trying to uninstall the Performance Center host again, the 
Performance Center host is not found in Add/Remove Programs.



Chapter 10 • Troubleshooting Installation

259

Troubleshooting

 1 Try to reboot the machine and uninstall again (unless the Performance 
Center host no longer appears in Add/Remove Programs).

 2 Open a command prompt and run: 

<Host installation path>\bin\HP.PC.PCS.Configurator.exe 
/CFG:..\dat\setup\lts\xml\Configurator.xml /G:Uninstall

 3 Delete the host installation folder. The default path for the host 
installation folder on a Windows 2008 64-bit machine is:  

C:\Program Files (x86)\HP\Performance Center Host

 4 Delete HP Performance Center Host from Start menu > Programs.

Patch Installation Fails

Installing a patch on the Performance Center Server or host from Lab 
Management fails and the following message is displayed:

“Patch installation on host/server <host/server name> failed. Reason: Failed 
installing Patch. Abnormal termination. The installation process is not 
found”

Troubleshooting

In order to install the patch from Lab Management, you must make sure 
that the Remote Procedure Call (RPC) service is started. You start the service 
as follows:

 1 On the Performance Center Server or host, select Start > Run, and type 
services.msc. The Services window opens.

 2 Right-click the Remote Procedure Call (RPC) service and select Start.
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Installing a patch requires you to stop the 
Performance Center Load Testing Service on the host 
machine

Problem: The HP Performance Center Host Files in Use dialog box appears, 
displaying the following message: 

Troubleshooting

It is recommended that you click Continue and continue with the 
installation. Alternatively, you can perform the procedure below:

 1 Select Start > Run, and type services.msc. The Services window opens.

 2 Stop the Performance Center Load Testing service.

 3 When the service has stopped, click Try Again.

 4 When the installation is complete, manually restart the service.
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Cannot launch ALM: Message that software not installed

When launching ALM, a message such as the following is displayed:

“Microsoft Visual C++ 2005 SP1 ATL Security Update Redistributable is not 
installed. Application will not be able to run. Contact your system 
administrator.”

Troubleshooting

This problems occurs if one of the client prerequisites, .NET Framework 3.5 
SP1 or Microsoft Visual C++ 2005 SP1 ATL Security Update Redistributable, 
is not installed. 

To solve this problem, install the software manually from the following 
locations:

Cannot log in to Performance Center via the client 
machine: Error regarding JavaScript

Login to Performance Center fails, and the following error is displayed:

JavaScript is not installed or is disabled in your browser......

Troubleshooting

This problem is related to running JavaScript in your browser.

To resolve this issue:

 1 In Internet Explorer, select Tools > Internet options >Security.

 2 Select Internet zone.

 3 Click Custom Level.

.NET Framework 3.5 SP1 <Installation_Disk_Root_Directory>\Setup\Common\d
otnet35_sp1\dotnetfx35_sp1.exe 

Microsoft Visual C++ 2005 
SP1 Redistributable Package 
(x86)

<Installation_Disk_Root_Directory>\Setup\<environm
ent>\prerequisites\vc2005_sp1_redist\vcredist_x86.e
xe
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 4 Make sure that Active Scripting is enabled.

 5 Enable the following items under ActiveX controls and Plug-ins:

➤ Automatic prompting for ActiveX controls

➤ Binary and script behaviors

➤ Run ActiveX controls and plugins

➤ Script ActiveX controls marked safe for scripting

When starting a test run, the host is added, but the 
Initializing Run page does not load

When starting a test run, the host is added, but the Initializing Run page 
does not load.

Troubleshooting

The client needs to have access to the machine. For example, if the 
Administrator inserted the machine name without domain, you might need 
to add the IP address and machine name to the host file 
(C:\WINDOWS\system32\drivers\etc\hosts) on the client machine.

Cannot run Performance Center component installation 
from a network drive

Cannot run the setup (Performance Center Server or host) when attempting 
to run it from a network drive.

Troubleshooting

In order to run setup.exe from a network location, you need to add the 
network server location to your Trusted Sites, and then run setup.exe again.
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To add the network server to your Trusted Sites in Internet Explorer:

 1 Open Tools > Internet Options.

 2 Select the Security tab and click Trusted Sites:
 

 3 Click Sites. 

 4 In the Trusted Sites dialog box, add the location of the network server 
where the Performance Center component setup file is located, to the list 
of trusted sites.



Chapter 10 • Troubleshooting Installation

264

Installing Performance Center components does not start 
when selecting them from the DVD menu

When clicking the installation option on the DVD menu nothing happens.

Troubleshooting

 1 Make sure the user running the installation has sufficient permissions to 
launch executable files.

 2 Restart the machine and try again.

Installing one of the Performance Center components 
cannot use default port. Port already in use.

Problem: The installation cannot use a default port because it is already in 
use.

Troubleshooting

If the installation cannot use a default port because it is already in use, 
change the port as per the instructions in the following table:

Component How to change the port

Performance Center 
Server IIS

To change this port, see 
http://support.microsoft.com/kb/149605.

Performance Center host To change port 8731 to a different port: 
1  On each Performance Center host, open 

LTOPSvc.exe.config (located in <Host Installation 
directory>\bin\) and change all four occurrences 
of 8731 to a new port number. Restart the 
Performance Center Load Testing Service.

2  On the Performance Center Server, open 
pcs.config (located in <Performance Center 
Server Installation directory>\dat\). Under 
PCSSettings, change ltopPortNumber to the new 
port number.

http://support.microsoft.com/kb/149605
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MI Listener To change port 443 to a different port, perform the 
following steps on the following machines:

➤ Controller machine (if used as MI Listener)

➤ Load Generator machine

➤ MI Listener

To change port 443:
1  Open <Component installation 

directory>\launch_service\dat\mdrv.dat. and 
locate the [launcher] section.

2  Add OFWPort=<port>, where <port> is the new 
port number.

3  Go to <Component installation 
directory>\launch_service\dat\channel_configu
re.dat and locate the [General] section.

4  Add OFWPort=<port>, where <port> is the new 
port number.

5  Restart the agent.

Note: There is no support for changing port 50500.

LoadRunner/
Performance Center 
Agent

Autolab Agent

To change HTTP tunneling ports 5001 and 5002:
1  Open <LR>\launch_service\dat\mdrv.dat, and 

locate the [launcher] section.

2  Add the following to the ExtCmdLine= key:

➤ For port 5001 add : 
-lnch_http_nd_port=<port>

➤ For port 5002 add: 
-lnch_http_dummy_port=<port>

where <port> is the new port number.

To change HTTP tunneling port 5003:
1  Create or open 

<LR>\launch_service\dat\merc_agent.cfg

2  Locate the [Attributes] section, and add the 
following: NMMRouterPort=<port>, where 
<port> is the new port number.

Note: There is no support for changing ports 54345 
and 54245.

Component How to change the port
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Cannot connect to the hosts using IUSR_METRO user 
with the MIOrchid#1 password 

Cannot log in to any of the hosts using the IUSR_METRO account, with the 
default MIOrchid#1 password.

Troubleshooting

The default password for IUSR_METRO has changed. The new password is 
(case sensitive): P3rfoRm@1nce

SiteScope (Topology) In Performance Center, change the port of the 
Topology entity to the same port as that defined 
during the SiteScope configuration.

SiteScope (Topology) - 
SSL

In Performance Center, change the port of the 
Topology entity to the same port as that defined 
during the SiteScope configuration.

SiteScope (Monitor 
Profiles)

In Performance Center, change the port of the 
Monitor Profile entity to the same port as that 
defined during the SiteScope configuration.

Diagnostics Server In Lab Management, change the port of the 
Diagnostics Server entity to the same port as that 
defined during the Diagnostics Server 
configuration.

Diagnostics Server - SSL In Lab Management, change the port of the 
Diagnostics Server entity to the same port as that 
defined during the Diagnostics Server 
configuration.

Component How to change the port
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Errors in the Migration Tool Report

Problem Description

The migration tool report may contain errors about specific entities or 
projects.

The errors in the migration tool report indicate two types of problems:

➤ The entity is corrupted in the PC 9.51 database and thus could not be 
migrated properly to ALM Platform.

➤ There was a temporary error in the environment while the migration tool 
was running. 

Troubleshooting

The troubleshooting instructions depend on the nature of the problems.

Troubleshooting the migrated database

If the migrated database exists and it's possible to locate the problematic 
entity, open the ALM platform, find the problematic project and entity, and 
manually fix the problem.

Troubleshooting an entity problem that existed in the database before 
migration

 1 Open the PC 9.51 environment.

 2 Open the project with the problematic entity.

 3 Check if the entity has errors in the PC 9.51 environment.

 a Fix the errors in the PC 9.51 environment or delete the entity if it is 
not needed.

 b Check the log files of the migration tool (MigrationTool, 
ProjectMigrationWrapper). The log files may contain additional data 
about the error. For more information about locating the log files, see 
the Migration Tool Logs section of this document.

 c In the log files find the section containing the project with the 
problematic entity, based on the PC 9.51 database project ID (located 
in the Companies table).
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 d Find the problematic entity error.

 4 Fix the problematic entity in the PC 9.51 environment, and then migrate 
the project again.

Troubleshooting an environment problem that existed before migration

The following environment problems can cause migration errors: 

➤ Network problems that caused errors while copying the script files - 
migrate the project again, or manually upload the problematic scripts.

➤ Database problem (insufficient resources, connection problems) - 
migrate the project again.

➤ ALM Platform errors 

➤ not enough memory - restart the ALM Platform and migrate the 
project again.

➤ somebody was working on the environment during the migration and 
caused some operations to fail - migrate the project again.

➤ Insufficient resources on the machine running the migration tool - 
migrate the project again.

➤ Not enough disk space on the ALM Platform repository - free enough 
storage on the ALM Platform repository and migrate the failed projects 
again.

If there is a problem migrating the project again, see the Cannot Migrate a 
Project Again Because it Cannot be Deleted section of this document.

Cannot Connect to Oracle Database on 64-bit Windows OS

Problem Description

When you began running the migration, an error appeared when trying to 
define an Oracle database.

The following error message appears when you define an Oracle source or 
target database: "Failed to connect to the database. Reason: ORA-12154: 
TNS: could not resolve the connect identifier specified"
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Troubleshooting

This is caused by a bug in the Oracle client. The Oracle client cannot resolve 
third party software applications which have "special" characters in their 
installation paths (including parentheses).

For example, the following path is invalid because it contains parentheses: 

C:\Program Files (x86)\HP\ALM Migration

Check that the migration tool installation path does not contain invalid 
characters. If the path contains invalid characters, reinstall the migration 
tool to a directory without any invalid characters.

Cannot Migrate a Project Again Because it Cannot be 
Deleted

Problem Description

You may want to migrate a project again after modifying something in the 
project or environment.

Before migrating a project again, the migration tool deletes the first project 
(migrated for the first time) from the ALM Platform, including its database.

If the database has open sessions it may not be successfully deleted.

Troubleshooting

 1 Close all open sessions to the project's database schema and migrate the 
project again.

 2 If the project still cannot be deleted, delete it from the ALM Site 
Administration and migrate the project again.
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Errors in the Migration Log

Error Message

MigrationLogic.Tasks.Transformers.MonitorProfileTransformer -  Error re-
encoding Password field for {MONITOR_TYPE} Monitor on 
{SERVER_NAME}, Monitor Profile {MONITOR_PROFILE_NAME}. Probably 
incompatible decryption key.

Troubleshooting

The source monitor has a password which cannot be decrypted. The 
encryption key originally used is different from the default key used in the 
Migration application. First recreate the monitor in the same Monitor 
Profile using a correct password and then run the migration again.

Error Message

Failed to dispose ProjectMigrationProxy

Troubleshooting

This error can be ignored.

A Migrated Project is not Linked to a 
PC_PROJECT_TEMPLATE Project After the Migration

Problem Description

The following error message, "Maximum retries exceeded 2. Manual apply 
customization required," indicates that the project needs to be manually 
linked to the PC_PROJECT_TEMPLATE project.

The project may not be linked to the template if it was migrated to a 
different domain.

Note: This troubleshooting procedure can also be used for new projects that 
need to be linked to a PC_PROJECT_TEMPLATE project.
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Troubleshooting

 1 In Site Administration > Site Projects tab, verify that the project appears 
in the Linked Projects list of the PC_PROJECT_TEMPLATE. If necessary, 
add it to the Linked Projects list.

 2 Log in to the PC_PROJECT_TEMPLATE project in ALM.

 3 Select Tools > Customize.

 4 From the left menu pane, select Cross Project Customization.

 5 In the Cross Project Customization table, select your project and click the 
Verify toolbar button.
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 6 Click the Apply Customization toolbar button.

Migration Tool Logs

Problem Description

Cannot find the Migration Tool log files.

Troubleshooting

The migration tool creates log files in two directories:

➤ MigrationTool directory - general migration tool logs.

➤ ProjectMigrationWrapper directory - log related to project and entity 
migration.
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These directories are located in the following location: 
<InstallationDir>\orchidtmp\LTLogger.

➤ If there are other Performance Center components installed in the 
machine, like the Performance Center Server or Performance Center Host, 
the <InstallationDir> directory is the installation folder of the 
performance center component.

➤ If there are no other Performance Center components installed on the 
machine, the directories are located in 
<MigrationToolInstallation>\bin\orchidtmp\LTLogger.

To check the value of  <InstallationDir> in the registry, find the following 
key:

[HKEY_LOCAL_MACHINE\SOFTWARE\Mercury 
Interactive\LoadRunner\CurrentVersion]

If you still cannot find the log files, check that the 
<InstallationDir>\dat\ltlogconf.xml file exists. If this file is missing, no logs 
will be written.

Problem Description

The migration tool writes error message to the log file by default. You can 
change the migration tool log level to view additional messages.

Troubleshooting

 1 Open the <InstallationDir>\dat\ltlogconf.xml file with a text editor.

 2 Scroll to the bottom of the file and find the  <root> section: 

   <root>

      <level value="Error" />

      <appender-ref ref="ROLLING_4CHAINSAW"/>

      <appender-ref ref="ROLLING" />

    </root>

 3 Replace the word Error with one of the following: Debug, Warn, Info, Error.
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 4 Save the file.

Note: 

➤ Switching the log level to Debug may significantly affect the 
performance of the migration tool.

➤ When you modify the log level, it takes effect immediately. You can 
repeatedly modify the log level while the migration tool runs.

➤ Changing the log level may affect other Performance Center 
components installed on the machine.

Migration Tables Not Found

Problem Description

Tables not found: ProjectMigrationState, EntityMappings, 
MigrationConfiguration. These three tables are created in the source (PC 
9.51) database to save the migration processing state.

If they do not exist the first time the migration runs, the log indicates that 
the tables are not found.
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Troubleshooting

These errors can be ignored. These tables are created by the migration 
process, so they will not exist the first time that migration runs. 

Migration Tool Report Data Not Found

Problem Description

Report Data Not Found: Cannot find the report data because the migration 
report wasn't saved at the end of the migration. 

Troubleshooting

The status of the migration of all projects can be found in the 
ProjectMigrationState table.

The report data is saved on the source (PC 9.51) database, in the 
EntityMappings table. This table contains all of the mappings between PC 
9.51 entities and the migrated ALM Platform entities.

Here are some details about entity mappings:

➤ CompanyID = 0 means that this is either a LAB_PROJECT project entity 
(like host, pool, or location), or a Site Administration entity (like user or 
group).

➤ The EntityType field values are defined as:

➤ LoadTest - 1

➤ Reservation - 2

➤ Script - 3

➤ Run - 4

➤ Location - 5

➤ Pool - 6

➤ Host - 7

➤ MonitorProfile - 8

➤ DiagnosticsServer - 9
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➤ DiagnosticsMediator - 10

➤ User - 11

➤ Role - 12

➤ Trending - 13

➤ MIListener - 14

➤ MonitorOfw - 15

➤ Project - 16

➤ TargetIP - 17

Error When Opening Timeslot Module and Saving a 
Performance Test

Problem Description

After running the migration, both of the following occur:

➤ An error message is displayed when opening the Timeslot module, and 
none of the timeslots are displayed.

➤ An unknown failure occurs when saving a performance test in the Online 
screen and the test is not saved. 

Troubleshooting

This troubleshooting is for cases when both (and not one) of the above 
errors occur. 

In the Site Administration LAB_PROJECT project, delete all of the rows from 
the LAB_DEMAND_HOST_ALLOCATION table. 
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